
135த�ொடர்புடைய கணினி பயன்பாடுகளைத் தணிக்கை செய்தல்

•	 DBMS இன் கருத்தை மாணவர்கள் புரிந்து க�ொள்ளுதல்.

•	 அட்டவணை வழிகாட்டியைப் பயன்படுத்தி அட்டவணையை உருவாக்குவது மற்றும் 

வினவலைப் பயன்படுத்தி தரவை மீட்டெடுத்தலுக்கான படிகளைப் பற்றி அறிதல்.

•	 கட்டமைக்கப்பட்ட வினவல் ம�ொழிகள் (SQL) பற்றி அறிந்து க�ொள்ளுதல்.

•	 வழிகாட்டியைப் பயன்படுத்தி படிவங்கள் மற்றும் அறிக்கைகளை பகுப்பாய்வு 

செய்து உருவாக்குதல்.

கற்றலின் நோக்கங்கள் :

த�ொடர்புடைய கணினி பயன்பாடுகளைத் 

தணிக்கை செய்தல் 

	 10.1	� கணினி பயன்பாடுகளின் அறிமுகம்

கல்வி, ஆராய்ச்சி, பயணம் மற்றும் சுற்றுலா, வானிலை முன்னறிவிப்பு, சமூக வலைப்பின்னல், இ-காமர்ஸ் 
ப�ோன்ற அனைத்துத் துறைகளிலும், நம்மைச் சுற்றியுள்ள எல்லா இடங்களிலும் கணினிகள் 
காணப்படுகின்றன. கணினிகள் இப்போது நம் வாழ்வின் தவிர்க்க முடியாத அங்கமாகி விட்டன. கணினி 
அவற்றின் துல்லியம் மற்றும் வேலையைச் செய்து முடிக்கும் வேகம் ஆகியவற்றால் நம் வாழ்வில் 
புரட்சியை ஏற்படுத்தியுள்ளது, இது உண்மையிலேயே குறிப்பிடத்தக்கது. இன்று, கணினி இல்லாமல் 
எந்த நிறுவனமும் செயல்பட முடியாது. உண்மையில், பல்வேறு அமைப்புகள் காகிதமற்றதாகிவிட்டன. 
பல ஆண்டுகளாக கணினிகள் எளிமையான கணக்கீட்டு சாதனமாக இருந்ததிலிருந்து அதிவேக 
கையடக்க கணினியாக பல ஆண்டுகளாக பரிணாம வளர்ச்சியடைந்துள்ளன.

	10.2	 மைக்ரோசாப்ட் ஆபிஸ் (Microsoft Office)

மைக்ரோசாஃப்ட் ஆபிஸ் (அல்லது ஆபிஸ்) என்பது மைக்ரோசாப்ட் உருவாக்கிய சேவை மென்பொருள் 
மற்றும் சேவைகளின் குடும்பமாகும். 1988 ஆம் ஆண்டு ஆகஸ்ட் 1 ஆம் தேதி லாஸ் வேகாஸில் 
பில் கேட்ஸால் முதலில் அறிவிக்கப்பட்டது. ஆபிஸின் முதல் பதிப்பில் மைக்ரோசாஃப்ட் வேர்ட், 
மைக்ரோசாஃப்ட் எக்செல் மற்றும் மைக்ரோசாஃப்ட் பவர்பாயிண்ட் ஆகியவை இருந்தன. மைக்ரோசாஃப்ட் 
ஆஃபீஸ் என்பது திரைமுகப்பு ஆக்கத்திறன் பயன்பாடுகளின் த�ொகுப்பாகும், குறிப்பாக இது அலுவலகம் 
அல்லது வணிக பயன்பாட்டிற்காக வடிவமைக்கப்பட்டுள்ளது. மைக்ரோசாஃப்ட் கார்ப்பரேஷனின் 
தனியுரிம தயாரிப்பான இது 1990 இல் மைக்ரோசாஃப்ட் ஆபிஸால் முதன்முதலில் வெளியிடப்பட்டது. 
Microsoft ஆபிஸ் 35 வெவ்வேறு ம�ொழிகளில் கிடைக்கிறது மற்றும் Windows, Mac மற்றும் 
பெரும்பாலான Linux வகைகளால் ஆதரிக்கப்படுகிறது. இது முக்கியமாக Word, Excel, PowerPoint, 
Access, OneNote, Outlook மற்றும் Publisher பயன்பாடுகளைக் க�ொண்டுள்ளது.

10.2.1  மைக்ரோசாப்ட் வேர்ட் (Microsoft Word):

மைக்ரோசாஃப்ட்  வேர்ட்  ஒரு  உரை  செயலாக்க  பயன்பாடு  ஆகும் .  இது  ஒரு  ஆவணத்தின் 
வடிவமைப்பு மற்றும் உள்ளடக்கத்தின் பாணிகள் ப�ோன்ற பண்புக்கூறுகளை உள்ளமைக்க 

10அலகு
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பயனரை அனுமதிக்கிறது, மேலும் பல்வேறு வழிகளிலும் வடிவங்களிலும் அவற்றின் உள்ளடக்கத்தைச் 
சேர்த்து ஆவணங்களை உருவாக்கிறது.

தனியுரிம மூல உரை செயலாக்க மென்பொருள்

த�ொகுப்பு நிறுவனம்

மைக்ரோசாப்ட் வேர்டு (Microsoft Word) மைக்ரோசாப்ட் கார்ப்பரேஷன்

WPS வார்த்தை கிங்சாஃப்ட்

WordPro ல�ோட்டஸ் கார்ப்பரேஷன்

திறந்த மூல உரை செயலாக்க மென்பொருள்

த�ொகுப்பு நிறுவனம்

ஓபன் ஆபிஸ் ரைட்டர் அப்பாச்சி

லிப்ரே ஆபிஸ் ரைட்டர் தி டாகுமெண்ட் அறக்கட்டளை

அபிவேர்ட் அபிச�ோர்ஸ்

10.2.2  மைக்ரோசாப்ட் எக்செல் (Microsoft Excel):

மைக்ரோசாஃப்ட் எக்செல் (Microsoft Excel) என்பது விரிதாள்களை உருவாக்குவதற்கும் 
திருத்தங்கள் மேற்கொள்வதற்கும் பயன்படுத்தப்படும் ஒரு பயன்பாடாகும். விரிதாள்கள் ப�ொதுவாக 
உரை மற்றும் எண்களைக் க�ொண்ட தரவுத் த�ொகுப்புகளுடன் வேலை செய்வதற்கும், வரைபடங்கள் 
மற்றும் விளக்கப்படங்களை உருவாக்குவதற்கும் பயன்படுத்தப்படுகின்றன.

10.2.3  மைக்ரோசாஃப்ட் பவர்பாயிண்ட் (Microsoft Powerpoint) :
செல்களைப் பயன்படுத்தி நிகழ்த்துதலை உருவாக்க மைக்ரோசாஃப்ட் பவர்பாயிண்ட் ப�ொதுவாகப் 
பயன்படுத்தப்படுகிறது. எளிமையான, புல்லட்-பாயின்ட் நிகழ்த்துதலை உருவாக்கப் பயன்படுத்தப்பட்டாலும், 
உங்கள் நிகழ்த்துதலில் பல்வேறு வகையான ஊடகங்களை அனுமதிக்கக்கூடிய பல அம்சங்கள் 
இதில் உள்ளன. நிகழ்த்துதலுக்கான எங்கள் வழிகாட்டி, பவர் பாயிண்டை எவ்வாறு திறம்பட 
பயன்படுத்துவது என்பதை உங்களுக்கு எடுத்துரைக்கிறது.

	 சுவர�ொட்டிகளை உருவாக்க இது ஒரு சிறந்த கருவியாகும், ஏனெனில் ஒரு செல்லிஅளவை 
காகித  அளவுக்கு  ஏற்றவாறு  மாற்றலாம் ,  பின்னர்  பட  மென்பொருளைப்  பயன்படுத்தாமல் 
சுவர�ொட்டிகளை உருவாக்க பட விருப்பங்கள் பயன்படுத்தப்படுகின்றன. MS ஆபிஸைப் பயன்படுத்தி 
கீழே உள்ள சில ச�ோதனைகளைச் செய்வோம்.

	10.3	� கணினியின் செயல்பாட்டிற்கான பல்வேறு கருவிகள் மற்றும் 

துணைக்கருவிகளின் ஏற்பாடு செய்தல் :

ந�ோக்கம் :

வெவ்வேறு வெளிப்புற உள்ளீடு மற்றும் வெளியீட்டு சாதனங்களை கணினியுடன் இணைக்கும் 
மற்றும் துண்டிக்கும் செயல்முறையைப் புரிந்து க�ொள்ளுதல்.
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செயல்பாடுகள்:

1.	 பாகங்களை அடையாளம் காணுதல்
2.	 மைய செயலகத்தில் (CPU) இல் உள்ள த�ொடர்பிகளை ( ports) அடையாளம் காணுதல்
3.	 சாதனங்களை இணைத்தல்

பாதுகாப்பு நடவடிக்கைகள்:

1.	 உங்கள் கணினியை மேசையில் வைப்பதற்கு முன், அது ஒரு மின் செருகி (socket) மற்றும் 
வலையமைப்பு / த�ொலைபேசி ப�ொருத்தி (Jack) ஜாக் அருகே அமைக்கப்பட்டுள்ளதா என்பதை 
உறுதிப்படுத்திக் க�ொள்ளுங்கள்.

2.	 விசைப்பலகை அணுகக்கூடியதாக இருக்க வேண்டும், CPU நன்கு காற்றோட்டமான 
இடத்தில் இருக்க வேண்டும், கணினிதிரை முழுவதும் காட்சி தெரியும்படி இருக்க வேண்டும் 
மற்றும் நீங்கள் எந்த கையை பயன்படுத்த திட்டமிட்டுள்ளீர்கள் என்பதைப் ப�ொறுத்து சுட்டி 
அமைக்கப்பட வேண்டும். 

3.	 மின்வழங்கி அமைப்பு அல்லது சிஆர்டி திரையை ஒருப�ோதும் திறக்க வேண்டாம்.

தேவையான கருவிகள் மற்றும் உபகரணங்கள்:

செயல்பாட்டு தலைப்பு வ.

எண்

சாதனம் / கூறுகளின் 

பெயர்

வரம்பு / மதிப்பு அளவு

பாகங்களை அடையாளம் 

காணுதல்

1 மைய செயலகம் (CPU) I-5 Dual Core 1

2 விசைப்பலகை 108 விசைகள் 1

3 திரையகம் 14" LED 1

4 சுட்டி ஒளியியல் (optical) 1

5 அச்சுப்பொறி லேசர்/இங்க்ஜெட் 1

CPU இல் உள்ள ப�ோர்ட்களை 

அடையாளம் காணுதல்

மைய செயலகம் (CPU) I-5 Dual Core 1

சாதனங்களை இணைத்தல் மைய செயலகம் (CPU) I-5 Dual Core 1

விசைப்பலகை 108 விசைகள் 1

திரையகம் 14" LED 1

சுட்டி ஒளியியல் (optical) 1

அச்சுப்பொறி லேசர்/இங்க்ஜெட் 1

4.	 பழுது பார்க்கும் முன் கணினியை அனைத்து மற்றும் உபகரணங்களை தனியே துண்டிக்க 
வேண்டும்.

5.	 கணினி பெட்டிக்குள் கூர்மையான பகுதிகள் ஏதும் இருப்பின் பசைப்பட்டை க�ொண்டு மூட வேண்டும்
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செயல்முறை :

பிரிவு 1. பாகங்களை அடையாளம் காணுதல் :

அ) 	� CPU: மைய செயலகம் (CPU), செயலி என்றும் அழைக்கப்படுகிறது, இது மதர்போர்டில் 
உள்ள கணினி பெட்டியின் உள்ளே அமைந்துள்ளது. இது கணினியின் மூளை என்றும் 
அழைக்கப்படுகிறது  அதன்  வேலை  கட்டளைகளைச்  செயல்படுத்துவதாகும் .  விசைப் 
பலகையிலுள்ள ப�ொத்தனை அழுத்தும்போத�ோ அல்லது சுட்டியை அழுத்தும் ப�ோத�ோ 
அல்லது  பயன்பாட்டு  மென்பொருளை  ஆரம்பிக்கும்  ப�ோதெல்லாம்  CPU -  விற்கு 
வழிமுறையை  அனுப்புகிறீர்கள் .

	 	

	 மைய செயலகம் (CPU)	 திரையகம்

ஆ)	திரையகம் (Monitor or Screen): இது உங்கள் கணினியில் நீங்கள் செய்யும் வேலையைக் 
காணக்கூடிய டிவி வகைத் திரையாகும்.

இ)	 விசைப்பலகை (Key board): கணினியுடன் த�ொடர்புக�ொள்வதற்கான முக்கிய வழிகளில் ஒன்று 
விசைப்பலகை  பல வகையான விசைப்பலகைகள் உள்ளன. ஆனால் பெரும்பாலானவை 
மிகவும் ஒத்தவை மற்றும் அடிப்படையில் ஒரே மாதிரியான செயல்களை செய்கின்றன.

	 	
	 விசைப்பலகை	 சுட்டி

ஈ)	 சுட்டி (Mouse): கணினிகளுடன் த�ொடர்புக�ொள்வதற்கான மற்றொரு முக்கியமான கருவி சுட்டி 
ஆகும். ப�ொதுவாக சுட்டிக்காட்டும் சாதனம் என்று அழைக்கப்படுகிறது. திரையில் உள்ள 
ப�ொருட்களை சுட்டிக்காட்டவும், அவற்றின் மீது கிளிக் செய்யவும், நகர்த்தவும் இது உங்களை 
அனுமதிக்கிறது.
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பிரிவு 2. CPU இல் உள்ள த�ொடர்பிகளை (ports) அடையாளம் காணுதல் :

CPU இல் உள்ள த�ொடர்பிகளை அடையாளம் காணுதல்

படி 1: Power Connector, SMPS கூலிங் ஃபேன், CPU கூலிங் ஃபேன், Switch மற்றும் Screw 
ஆகியவற்றைக் கண்டறியவும்.

படி 2: CPU இல் PS/2 த�ொடர்பி, USB த�ொடர்பி, பேரலல் த�ொடர்பி, VGA த�ொடர்பி, ஈதர்நெட் 
த�ொடர்பி மற்றும் ஆடிய�ோ ஜாக்குகளை அடையாளம் காணவும்.

படி 3: CPU இல் உள்ள விரிவாக்க இடங்கள் (Expansion slots) மற்றும் விரிவாக்க அட்டைகளை 
(Expansion Cards) அடையாளம் காணவும்.

பிரிவு 3. சாதனங்களை இணைத்தல்:

டெஸ்க்டாப் கணினியை அமைத்தல்

	 	

	 டெஸ்க்டாப் கணினி	 CPU – வின் குளிர்விக்கும் விசிறி

படி 1 : பெட்டியிலிருந்து திரையகம்மற்றும் கணினி பெட்டியை வெளியில் வைக்கவும். மேலும், வேறு 
பாதுகாப்பு பட்டை மற்றும் பிளாஸ்டிக் கவரினை முன் கூட்டியே எடுத்து விடவும். திரையகம்மற்றும் 
கணினி பெட்டியை ஒரு மேசை அல்லது பணியிடத்தில் வைக்கவும். கணினியை நல்லகாற்றோட்டம் 
உள்ள பகுதியில் வைக்கவேண்டும். இது கணினி அதிக வெப்பமடைவதை தடுக்க உதவும்
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படி 2: பல வகையான திரையகம் வடங்கள் (Cable) உள்ளன. CPU த�ொடர்பியைப் ப�ொறுத்து 
திரையக வடத்தை தேர்ந்தெடுக்கவும். திரையக வடத்தை சரியாக ப�ொறுத்த வேண்டும், திரையக 
வடத்தை தேர்ந்தெடுப்பதில் சிக்கல்கள் ஏற்பட்டால் அறிவுறுத்தல் கையேட்டை (Instruction 
Manual)   படிக்கவும்.

	 	

	 திரையக வடம்	 VGA வடம்

படி 3:  திரையக  வடம்  த�ொடர்பியின்  ஒரு  முனையை  கணினி  பெட்டியின்  பின்  புறத்திலும் ,  
மறுமுனையை திரையகத்துடனும் இணைக்கவும்.  படம்10.3.8 – ல் காட்டியுள்ளது ப�ோல் உள்ள 
VGA வகை வடத்தை பயன்படுத்தினால் அதன் இருபுறமுள்ள திருகுகளை இறுக்கமாக திருக 
வேண்டும். பல கணினி கேபிள்கள் ஒரு குறிப்பிட்ட வழியில் மட்டுமே ப�ொருந்தும். கேபிள் 
ப�ொருந்தவில்லை என்றால், அதை கட்டாயப்படுத்தக் கூடாது. ஏனெனில் இது இணைப்பிகளை 
சேதப்படுத்தலாம். பிளக் ப�ோர்ட்டுடன் ஒருங்கமைவதை உறுதி செய்து பின் அதை இணைக்கவும்

பல கணினி கேபிள்கள் ஒரு குறிப்பிட்ட வழியில் மட்டுமே ப�ொருந்தும். கேபிள் ப�ொருந்தவில்லை 
என்றால், அதை கட்டாயப்படுத்தக் கூடாது. ஏனெனில் இது இணைப்பிகளை சேதப்படுத்தலாம். 
பிளக் ப�ோர்ட்டுடன் சீரமைக்கப்படுவதை உறுதிசெய்து, அதை இணைக்கவும்.

படி 4: விசைப்பலகையை பெட்டியிருந்து வெளியே எடுத்து அது USB வகை (செவ்வக) இணைப்பியைப் 
பயன்படுத்துபட்டிருகிறதா அல்லது PS/2 (வட்ட) இணைப்பியைப் பயன்படுத்துபட்டிருகிறதா 
என்பதைத் தீர்மானித்து, அதை ப�ொருத்தமான த�ொடர்பியில் இணைக்கவும்.  USB வகை இணைப்பி 
பயன்பட்டியிருந்தால் ஏதேனும் ஒரு USB ப�ொருத்தியில் ப�ொருத்த வேண்டும். PS/2 வகை இணைப்பி 
பயன்படுத்தபட்டிருத்தால் ஊதா நிறத்திலுள்ள PS/2 ப�ொருத்தியில் இணைக்க வேண்டும்..

	 	

	 USB வடம்	 PS/2 இணைப்பி� வண்ண குறியீட்டுகள் த�ொடர்பிகள்

படி 5 : சுட்டியை எடுத்துஅது USB அல்லது PS/2 இணைப்பியைப் பயன்படுத்துகிறதா என்பதைத் 
தீர்மானித்து, ப�ொருத்தமான த�ொடர்பியில் இணைக்கவும். USB வகை இணைப்பு பயன்படுத்தப்பட்டிருந்தால் 
ஏதேனும் ஒரு USB  வகை ப�ொ  ருத்தியில் ப�ொ ருத்த வே ண்டும்.  PS /2  வகை  இணைப்பி 
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பயன்படுத்தப்பட்டிருந்தால் பச்சை நிறத்திலுள்ள PS/2 ப�ொருத்தியில் இணைக்க வேண்டும். 
விசைப்பலகையில் யூ.எஸ்.பி. ப�ோர்ட் இருந்தால், சுட்டியை நேரடியாக கணினியுடன் இணைப்பதற்குப் 
பதிலாக விசைப்பலகையுடன் இணைக்கலாம். வயர்லெஸ் சுட்டி அல்லது கீப�ோர்டு இருந்தால் 
கணினியுடன் ப்ளூடூத் டாங்கிளை (USB adaptor) இணைக்க வேண்டியிருக்கும். இருப்பினும், பல 
கணினிகளில் உள்ளமைக்கப்பட்ட புளூடூத் உள்ளது. எனவே அடாப்டர் தேவைப்படாமல் ப�ோகலாம்..

விசைப்பலகையில் யூ.எஸ்.பி ப�ோர்ட் இருந்தால், சுட்டியை நேரடியாக கணினியுடன் இணைப்பதற்குப் 
பதிலாக விசைப்பலகையுடன் இணைக்கலாம். வயர்லெஸ் மவுஸ் அல்லது கீப�ோர்டு இருந்தால், 
கணினியுடன் ப்ளூடூத் டாங்கிளை (USB அடாப்டர்) இணைக்க வேண்டியிருக்கும். இருப்பினும், பல 
கணினிகளில் உள்ளமைக்கப்பட்ட புளூடூத் உள்ளது, எனவே அடாப்டர் தேவைப்படாமல் ப�ோகலாம்

படி 6: உங்களிடம் வெளிப்புற ஒலிப்பெருக்கி அல்லது ஹெட்ஃப�ோன்கள் இருந்தால், அவற்றை 
உங்கள் கணினியின் ஆடிய�ோ த�ொடர்பியுடன் இணைக்கலாம் (கணினி பெட்டியின் முன் அல்லது 
பின்புறம்).

சில கணினிகளில் வண்ண குறியீடுகளுடன் கூடிய ப�ொருத்திகள் இருக்கும்.  ஸ்பீக்கர்கள், 
ஹெட்ஃப�ோன்களை பச்சை (Green) நிற ப�ொருத்தியிலும், மைக்ரோஃப�ோனை இளஞ்சிவப்பு (Pink) 
நிற ப�ொருத்திலும் இணைக்க வேண்டும். நீல நிற ப�ொருத்தியானது லைன் இன் ( Line in) ற்க்கு 
க�ொடுக்கப்பட்டுள்ளது, வேறு ஏதேனும் சாதனங்களை இணைப்பதற்கு பயன்படுகிறது. சில ஸ்பீக்கர்கள், 
ஹெட்ஃப�ோன்கள் மற்றும் மைக்ரோஃப�ோன்களில் வழக்கமான ஆடிய�ோ பிளக்கிற்குப் பதிலாக USB 
இணைப்பிகள் உள்ளன. இவை எந்த USB ப�ோர்ட்டுடனும் இணைக்கலாம் . கூடுதலாக, பல 
கணினிகளில் ஸ்பீக்கர்கள் அல்லது மைக்ரோஃப�ோன்கள் மானிட்டரில் கட்டமைக்கப்பட்டுள்ளன

படி 7: மின் செருகி த�ொடர்பியில் மின்வடத்தை செருகவும்.முதல் பவர் சப்ளை கேபிளை கம்ப்யூட்டர் 
கேஸின் பின்புறத்தில் செருகவும், பின்னர் சர்ஜ் ப்ரொடெக்டரில் செருகவும். பின்னர், மற்ற 
கேபிளைப் பயன்படுத்தி, (UPS) உடன்இணைக்கவும்.சிலUPS ஆனது மின் தடை ஏற்பட்டால் 
தற்காலிக மின்சாரத்தை வழங்குகிறதுUPS ஆனது சா்ஜ் ப்ரொடெக்டராவும் பயன்படுத்தலாம்.

	 	

	 மின் செருகி வடம்	 மின்னெழுச்சிக் காப்பான்

படி 8: இறுதியாக, மின் செருக்கி வடத்தை சுவற்றிலுள்ள மின் வழங்கியில் இணைக்கவும் மேலும் 
சர்ஜ் ப்ரொடெக்டரில் மின் ப�ொத்தான் இருந்தால் அதையும் ஆன் செய்ய வேண்டும்.  சர்ஜ் 
ப்ரொடெக்டர் இல்லாமல் இருக்கும் பட்சத்தில் நேரடியாக சுவற்றிலுள்ள மின் வழங்கியில் 
இணைக்க  வேண்டும் .  சர்ஜ்  ப்ரொடெக்டரை  பயன்படுத்தாமல்  இருப்பத்தை  பரிந்துரைக்க 
வேண்டாம். ஏனெனில் மின்சாரம் உங்கள் சேதப்படுத்தும்.
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படி 9: உங்களிடம் அச்சுப்பொறி,  வருடி,  வலை ஒளிப்படக்கருவி அல்லது பிற சாதனங்கள் 
இருந்தால், அவற்றை ப�ொருத்தமான த�ொடர்பியுடன் இணைக்கலாம். பல சாதனங்கள் செருகுதல் 
மற்றும் உபய�ோகித்தல் முறை சார்ந்தது. அதாவது மின் சாதனகளுக்கான மென்பொருளை 
அங்கரித்து கணினியுடன் இணைத்தவுடன்  உபய�ோகிப்பதற்கு தயாராகி விடும்.

அச்சுப்பொறி

பிற சாதனங்களில் நீங்கள் அவற்றைப் பயன்படுத்தத் த�ொடங்கும் முன் நிறுவப்பட வேண்டிய 
மென்பொருட்கள் அடிப்படையாகவே இருக்கலாம். தேவைப்பட்டால் அதை நிறுவுவதற்கு சாதனத்துடன் 
சான்று க�ொடுக்கப்பட்ட வழிமுறைகளைப் பயன்படுத்தவும். ப�ொதுவாக, சாதனங்கள் விருப்பமானவை, 
மேலும் நீங்கள் எந்த நேரத்திலும் புதியவற்றைச் சேர்க்கலாம்; உங்கள் கணினியின் ஆரம்ப அமைப்பின் 
ப�ோது அனைத்து சாதனங்களையும் நீங்கள் சேர்க்க வேண்டுமென்பது அவசியமில்லை.

செலவு தாள் :

வ. 

எண்

உபகரணங்களின் 

பெயர்/ தேவையான 

கூறுகள்

வரம்பு / 

விவரக்குறிப்புகள்
அளவு

செலவு 

(த�ோராயமாக)

அருகிலுள்ள 

கடையில் 

மதிப்பு

1 CPU
i5, Dual Core மதர் 

ப�ோர்டு, 500 GB, 4 GB
1 17000

2 விசைப்பலகை 108 விசைகள் 1 1500

3 திரையகம் 14" LED 1 7000

4 சுட்டி ஒளியியல் 1 400

5 அச்சுப்பொறி இங்க் ஜெட் 1 3000

மொத்தம்

கூலி மற்றும் நிர்வாக செலவு : ப�ொருள் செலவில் 25%

தயாரிப்பை உருவாக்க / சேவை செய்வதற்கான ம�ொத்த செலவு

சந்தையில் விற்பனை விலை

இலாபம்

முடிவுரை:

கணினிக்கான பல்வேறு வெளிப்புற உள்ளீடு மற்றும் வெளியீட்டு சாதனங்களை இணைத்தல் 
மற்றும் துண்டித்தல் வெற்றிகரமாக செய்து முடிக்கப்பட்டுள்ளது.
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எளிய மதிப்பீடு:

1.	 க�ொடுக்கப்பட்ட வரைபடத்தின்படி பாகங்களை இணைக்கவும்

2.	 கணினியை ஒருங்கிணைப்பு (assembly) செய்யும் ப�ோது மேற்கொள்ள வேண்டிய பாதுகாப்பு 
முன்னெச்சரிக்கைகள் என்ன?

•	 சேவையைச் செய்வதற்கு முன் மின்சக்தியை அனைத்து, உபகரணங்களைத் துண்டிக்கவும்.

•	 கணினி பெட்டியின் உள்ளே உள்ள கூர்மையான விளிம்புகளை பசைப்பட்டையாகவே மூடவும்.

•	 மின்சாதனம் அல்லது CRT மானிட்டரை ஒருப�ோதும் திறக்க வேண்டாம்.

•	 வெப்பம் அல்லது அதிக மின்னழுத்தத்தைப் பயன்படுத்தும் அச்சுப்பொறிகளிலுள்ள பகுதிகளைத் 
த�ொடாதீர்கள்.

•	 உங்கள் முதுகில் காயம் ஏற்படாமல் இருக்க, உங்கள் முழங்கால்களை வளைத்து கனமான 
ப�ொருட்களை தூக்க வேண்டும்.

காண�ொலி பரிந்துரைகள்:

வ. 

எண்
தலைப்பு/ந�ோக்கம் இணைப்பு

1
மேசைக் கணினியை 

அமைத்தல்

https://youtu.be/

KdQeU5QTfYE
GCFLeanaFree.org

2
வீட்டில் மேசைக் கணினியை 

எவ்வாறு அமைப்பது

https://youtu.be/

avaOf-kdb7w

பால்மெட்டோ 

த�ொழில்நுட்பக் குழு

3

கணினி அடிப்படைகள் - 

கணினியை அமைத்தல் - 

மேசைக் கணினிகளை எவ்வாறு 

அமைப்பது மற்றும் கணினியை 

எவ்வாறு செருகுவது.

https://youtu.be/

SM0qsvQBEPg

பேராசிரியர் ஆடம் 

ம�ோர்கன்
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மாணவர் 

செயல்பாடு

மாணவர்கள் மூன்று கணினிகளை அமைக்குமாறு கேட்டுக் 

க�ொள்ளப்படுகிறார்கள்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

விருந்தினர் விரிவுரைக்கு ஒரு கணினி துறை த�ொழில்நுட்ப 

வல்லுநரை அழைக்கவும். விருந்தினர் விரிவுரைக்கு ஒரு IT 

ப�ொறியாளரை அழைக்கவும்.

த�ொழில்சார்ந்த / கள 

ஆய்வு பரிந்துரைகள்

கள ஆய்விற்கு ஒரு கணினி மையத்தைப் பார்வையிடுதல் த�ொழில் 

சார்ந்த ஆய்விற்காக ஒரு மென்பொருள் நிறுவனத்தைப் பார்வையிடுதல்.

1. வார்த்தை செயலாக்கம்:

வார்த்தை செயலாக்கம் என்பது ஒரு கணினியைப் பயன்படுத்தி ஆவணங்களை உருவாக்க, 
திருத்த, சேமிக்க மற்றும் அச்சிடுவதைக் குறிக்கிறது.

	 ச�ொல் செயலாக்கத்தைச் செய்ய, சிறப்பு மென்பொருள் (வேர்ட் செயலி) தேவை.

	 எ.கா: MS Word, Open Office Writer மற்றும் Google Drive ஆவணம்.

2. அறிமுகம்

மைக்ரோசாப்ட் வேர்ட் (எம்எஸ் வேர்ட்) என்பது மைக்ரோசாப்ட் உருவாக்கிய பிரபலமான 
வணிகச் ச�ொல் செயலி ஆகும். த�ொகுப்பில் பரவலாகப் பயன்படுத்தப்படும் நிரல்களில் இதுவும் 
ஒன்றாகும்.

	 இது  விண்டோஸ்  மற்றும்  ஆப்பிள்  ஆப்ரேட்டிங்  சிஸ்டம்  (OS) ஆகிய  இரண்டிற்கும் 
கிடைக்கிறது.

	 மைக்ரோசாஃப்ட் வேர்ட் மைக்ரோசாஃப்ட் ஆஃபீஸ் உற்பத்தித்திறன் த�ொகுப்பில் உள்ளது 
மேலும் இது ஒரு முழுமையான பயன்பாடாகவும் கிடைக்கிறது.

	 மைக்ரோசாஃப்ட் வேர்ட் முதன்முதலில் 1983 இல் வெளியிடப்பட்டது மற்றும் அதன் 
பின்னர்  பல்வேறு  திருத்தங்களைக்  கண்டது .  இது  விண்டோஸ்  மற்றும்  மேக்  கணினிகள் 
இரண்டிற்கும் இணக்கமானது.

	 பல பயன்பாடுகள் இதற்கு ப�ோட்டியைக் க�ொடுத்தாலும், இன்றுவரை எதுவும் அதைத் 
த�ோற்கடிக்கவில்லை.

3. MS WORD இன் அம்சங்கள்:

i.	 ஏற்கனவே உள்ள ஆவணங்களைத் திருத்துதல் மற்றும் வடிவமைத்தல், மாற்றியமைத்தல்ச் 
செய்ய இது உதவுகிறது.

ii.	 படங்கள் மற்றும் பலவற்றை உள்ளடக்கிய வரைகலை ஆவணங்களை உருவாக்கவும் இது 
உதவுகிறது.

iii.	 மில்லியன் கணக்கான அலுவலகப் பணியாளர்கள், மாணவர்கள் மற்றும் வீட்டுப் பயனர்கள் 
இந்த மென்பொருள் நிரலைப் பயன்படுத்தி ஆவணங்களை உருவாக்குகின்றனர், படிக்கின்றனர் 
மற்றும் திருத்துகின்றனர்.
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iv.	 MS-Word Word Processing அமைப்புகளை மட்டும் ஆதரிக்கவில்லை மேலும் DTP 
அமைப்புகளையும் ஆதரிக்கிறது.

4. மைக்ரோசாப்ட் ஆபிஸின் பயன்பாடுகள்:

MS Of f ice  என்பது  ஒரு  சக்திவாய்ந்த  சேவையாகும் ,  மேலும்  இது  உலகளாவிய  வணிக 
சமூகத்தின்  செயல்திறனையும்  உற்பத்தித்திறனையும்  மேம்படுத்த  உதவுகிறது .

	 MS Office ஆனது Window OS, Mac OS, Android ios ப�ோன்ற பல்வேறு இயங்குதளங்களில் 
பயன்படுத்தப்படலாம்.

	 MS Office ஆனது வணிகங்கள் உற்பத்தித்திறன் மற்றும் இருப்பிடத்தைப் ப�ொருட்படுத்தாமல் 
திறம்பட த�ொடர்புக�ொள்வதற்கு உதவும் கருவிகளை வழங்குகிறது

	10.4	� பல்வேறு விருப்பத்தேர்வுகளுடன் கூடிய ஒரு MS வேர்ட் ஆவணத்தை 

உருவாக்கவும்.

ந�ோக்கம் :

MS வேர்ட் கருவிகள் மற்றும் கட்டளைகளைப் பயன்படுத்தி MS வேர்ட் ஆவணத்தை உருவாக்குதல்.

MS வேர்ட் ஐப் பயன்படுத்தி செயல்பாடுகள்:

1.	 ஒரு ஆவணத்தை உருவாக்குதல்
2.	 பயனர் சாளரத்தின் பகுதிகள்
3.	 செருகும் புள்ளி மற்றும் சுட்டியின் செருகும் புள்ளி
4.	 உரை பதிப்பித்தல்
5.	 செயல்தவிர் மற்றும் மீண்டும் செய் (undo & Redo)
6.	 உரையை நகர்த்துவது மற்றும் நகலெடுப்பது
7.	 நகல் எடுத்தல் மற்றும் ஒட்டுதல்
8.	 உரையைத் தேர்ந்தெடுப்பது
9.	 உரையின் செங்குத்துத் த�ொகுதியைத் தேர்ந்தெடுப்பது
10.	 உரையைகண்டுபிடித்தல் மற்றும் மாற்றுதல்(Find & Replace)
11.	 Synonyms மற்றும் Thesaurus பயன்படுத்துதல்
12.	 க�ோப்பை சேமித்து மீண்டும் திறத்தல்

தேவையான கருவிகள் மற்றும் உபகரணங்கள்:

வ. எண் கருவிகள்/ உபகரணங்களின் பெயர் வரம்பு / மதிப்பு வரம்பு / மதிப்பு

1 மேசைக்கணினி அல்லது மடிக்கணினி 15 செயலி / 4GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1

Chapter_10.indd   145 4/28/2022   12:13:45 PM



146 த�ொடர்புடைய கணினி பயன்பாடுகளைத் தணிக்கை செய்தல்

குறுக்குவழி விசைகள்:

வ.எண் செயல் குறுக்கு வழி விசை

1 ஒரு ஆவணத்தைத் திறக்க Ctrl + O

2 புதிய ஆவணத்தை உருவாக்க Ctrl + N

3 ஆவணத்தை சேமிக்க Ctrl + S

4 ஆவணத்தை மூடுவதற்கு Ctrl + W

5 தேர்ந்தெடுக்கப்பட்ட உள்ளடக்கத்தை 

தற்காலிக சேமிப்பு பலகையிலிருந்து 

வெட்டுவதற்கு

Ctrl + X

வ.எண் செயல் குறுக்கு வழி விசை

6 தேர்ந்தெடுக்கப்பட்ட உள்ளடக்கத்தை தற்காலிக 

சேமிப்பு பலகைக்கு நகலெடுக்க

Ctrl + C

7 தற்காலிக சேமிப்பு பலகையிலுள்ள 

உள்ளடக்கங்களை ஒட்டுவதற்கு

Ctrl + V

8 அனைத்து ஆவண உள்ளடக்கத்தையும் 

தேர்ந்தெடுக்க

Ctrl + A

9 உரைக்கு தடிமனான வடிவமைப்பைப் 

பயன்படுத்த

Ctrl + B

10 உரைக்கு சாய்வு வடிவமைப்பைப் பயன்படுத்த Ctrl + I

11 உரைக்கு அடிக்கோடு வடிவமைப்பைப் 

பயன்படுத்த

Ctrl + U

12 எழுத்துரு அளவை 1 புள்ளி அளவுக்கு குறைக்க Ctrl + வலது அடைப்புக்குறி 

([)

13 எழுத்துரு அளவை 1 புள்ளி அளவுக்கு அதிகரிக்க Ctrl + வலது அடைப்புக்குறி 

(])

14 உரையை மையப்படுத்த Ctrl+E

15 உரையை இடது பக்கம் சீரமைக்க Ctrl+L

16 உரையை வலது பக்கம் சீரமைக்க Ctrl+R

17 கட்டளையை ரத்துசெய்ய. Esc
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வ.எண் செயல் குறுக்கு வழி விசை

18 முந்தைய செயலை தவிர்க்க Ctrl+Z

19 முடிந்தால், முந்தைய செயலை மீண்டும் 

செய்யவும்.

Ctrl+Y

20 உருப்பெருக்கத்தைச் சரிசெய்ய Alt+W, Q, பிறகு நீங்கள் 

விரும்பும் மதிப்பிற்குச் 

செல்ல பெரிதாக்கு 

உரையாடல் பெட்டியில் 

உள்ள Tab விசையைப் 

பயன்படுத்தவும்.

21 ஆவண சாளரத்தை பிரிக்க Ctrl+Alt+S

22 ஆவண சாளரப் பிரிவை அகற்ற Alt+Shift+C அல்லது 

Ctrl+Alt+S

செயல்முறை:

பிரிவு 1. ஒரு ஆவணத்தை உருவாக்குதல்

படி 1:  File >New>Blank document தேர்வைப்  பயன்படுத்தி  புதிய  உரை  ஆவணத்தை 
உருவாக்கவும் .

ஒரு புதிய ஆவணத்தை உருவாக்குதல்
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படி2 : File > Save என்பதைக் கிளிக் செய்து க�ோப்பைச் சேமிக்கவும் . க�ோப்பிற்கு பெயரைக் 
க�ொடுங்கள் (எடுத்துக்காட்டாக: Report). க�ோப்பை வேறு வடிவத்தில் சேமிக்க File>save 
as>Save as type> என்பதைக் கிளிக் செய்து க�ோப்பு வடிவத்தைத் தேர்ந்தெடுக்கவும்.

வகையாக சேமித்தல்

படி 3: க�ோப்பை மற்றொரு பெயர் மற்றும் இருப்பிடத்தின் மூலம் சேமிக்கவும். க�ோப்பை வேறு 
பெயரில்  சேமிக்க ,  f i le>save as >Location> என்பதைக்  கிளிக்  செய்து  இருப்பிடத்தைத் 
தேர்ந்தெடுக்கவும். பயன்பாட்டாளர் ஆவண்த்திற்க்கு பெயர் க�ொடுத்து சேமித்தால் அது “க�ோப்பு“ 
என்றழைக்கப்படும். பயன்பாட்டாளர் வேறு ஒரு க�ோப்பை வேறு ஒரு பெரில் வேறு ஒரு இடத்தில் 
சேகரிக்க “save as“- ஐ தேர்ந்தெடுக்க வேண்டும்.  இப்பொழுது பயன்பாட்டாளர் இரண்டு 
க�ோப்புகளை பெறுவர், 1. முந்தையை ஒன்று மற்றும் 2.  புதிய பெயரில் ஒன்று

க�ோப்பை சேமித்தல்

முதலில் ப�ொதுவான இடத்தை கிளிக் செயவும் பிறகு க�ோப்பின் பெயரை தட்டச்சி என்று சேமிக்கவும்

வேறு இடத்தில் சேமிப்பதற்கு "Browse" 

என்பதை 'கிளிக்' செய்து "Save as" 

என்பதை  'கிளிக்' செய்யவும்

துணைக�ோப்பில் சேமிக்க துணைக�ோப்பை 

தேர்ந்தெடுக்கவும்
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படி 4: ஆவணத்தை மூடுதல்

க�ோப்பை மூடுவதற்கு, File>Close என்பதைக் கிளிக் செய்யவும் அல்லது Alt+F4 விசையை 
அழுத்தவும். பல க�ோப்புகளை திறந்து வைத்திருத்தால் வேலை செய்வதற்கு இடர்பாடாக இருக்கும். 
எனவே, க�ோப்பை மூடுவதற்கு,  File>Close என்பதைக் கிளிக் செய்யவும்.

படி 5: ஆவணத்தைத் திறத்தல்

file>open என்பதைக் கிளிக் செய்யவும் அல்லது (Ctrl+O) விசையை அழுத்தவும்.

ஆவணத்தைத் திறத்தல்

பிரிவு 2. பயனர் சாளரத்தின் பகுதிகள்

தலைப்புப்  பட்டி :  ரைட்டர்  சாளரத்தின்  மேல்  தலைப்புப்  பட்டி  அமைந்துள்ளது .  தற்போது 
திறக்கப்பட்டுள்ள ஆவணத்தின் தலைப்பை இது காட்டுகிறது.  ஆவணத்தின் பெயர் வட்டில் 
சேமிக்கப்பட்ட ஆவணத்தின் க�ோப்பு பெயரைக் குறிக்கிறது. ஒரு புதிய ஆவணத்தை திறக்கும் 
ப�ோது , இது ஆவணத்தின் தலைப்பை Untitled X எனக் காட்டுகிறது, அங்கு 'X' என்பது ஆவண 
எண் Untitled 1, Untitled 2, Untitled 3... ப�ோன்றவை. 

மெனு பார்: இது தலைப்புப் பட்டியின் கீழே த�ோன்றும். இது க�ோப்பு, திருத்து, பார்வை, செருகு, 
வடிவமைப்பு, அட்டவணைகள், கருவிகள், சாளரம் மற்றும் உதவி ப�ோன்ற மெனு உருப்படிகளைக் 
காட்டுகிறது. மெனு உருப்படியைத் தேர்ந்தெடுக்கும்போது, அதன் துணைமெனு மெனு உருப்படிக்குக் 
கீழே திறக்கும். தேவைக்கேற்ப துணைமெனுவில் உள்ள எந்தப் ப�ொருளையும் நாம் தேர்ந்தெடுக்கலாம். 
க�ோப்பு மெனுவைத் தேர்ந்தெடுப்பது. துணைமெனுவின் பெயருக்குப் பிறகு ‘...’ என்ற மூன்று 
புள்ளிகளைக் காட்டும் துணைமெனு உருப்படி, அதைக் கிளிக் செய்தால், உரையாடல் பெட்டி 
திறக்கும். துணைமெனுவின் பெயருக்குப் பிறகு வலது பக்க அம்புக்குறிகளைக் காட்டும் துணைமெனு 
உருப்படியானது ‘ ’ என்பது, அதைக் கிளிக் செய்தால், மற்றொரு துணைமெனு திறக்கும்.

கருவிப்பட்டிகள்: கருவிப்பட்டி மெனு பட்டியின் கீழே த�ோன்றும். இயல்பாக, நிலையான கருவிப்பட்டி 
மற்றும் வடிவமைப்பு கருவிப்பட்டி த�ோன்றும். மற்ற டூல்பார்களை ‘வியூ’ மெனுவைக் கிளிக் செய்து, 
துணைமெனுவின் ‘டூல்பார்களை’ தேர்ந்தெடுப்பதன் மூலம் செயல்படுத்தலாம். அதில் கிளிக் செய்வதன் 

Chapter_10.indd   149 4/28/2022   12:13:46 PM



150 த�ொடர்புடைய கணினி பயன்பாடுகளைத் தணிக்கை செய்தல்

மூலம் பயனர் தேவையான கருவிப்பட்டிகளை தேர்வு செய்யலாம். நிலையான கருவிப்பட்டி: இது 
ஐகான்களின் வடிவத்தில் கட்டளைகளைக் க�ொண்டுள்ளது.

வடிவமைத்தல் கருவிப்பட்டி: இது ஒரு ஆவணத்தை வடிவமைப்பதற்கான பல்வேறு விருப்பங்களைக் 
க�ொண்டுள்ளது .  கட்டளைகளின்  வரைகலை  பிரதிநிதித்துவம்  ஐகான்களின்  வடிவத்தில் 
காட்டப்பட்டுள்ளது.

நிலைப் பட்டி: இது ரைட்டர் சாளரத்தின் இடது கீழ்ப் பகுதியில் அமைந்து, பக்கங்களின் எண்ணிக்கை, 
ச�ொற்கள்,  பயன்படுத்தப்படும் ம�ொழி,  பெரிதாக்குதல் ப�ோன்றவற்றைக் காட்டுகிறது.  இது 
பணியிடத்தின் கீழே அமைந்துள்ளது.

ஸ்க்ரோல் பட்டன் மற்றும் ஸ்க்ரோல் பார்: இது ஆவணத்தை உருட்ட பயன்படுகிறது.

பெரிதாக்கு: ஆவணத்தில் உள்ள உரை மற்றும் படங்களின் அளவை பார்வைக்காக மட்டுமே 
மாற்ற இது உங்களை அனுமதிக்கிறது. இது உடல் ஆவணத்தை பாதிக்காது. ஆவணத்தின் இறுதி 
தரத்தை சரிபார்க்க இது பயன்படுத்தப்படுகிறது. மற்ற கருவிகளின் அர்த்தத்தை அறிய, கருவியின் 
மீது மவுஸ் பாயின்டரை நிலைநிறுத்தி, கருவி உதவிக்குறிப்பைப் பார்க்கவும். 

சாளரங்களின் பகுதி

பிரிவு 3. செருகும் புள்ளி மற்றும் சுட்டியின் செருகும் புள்ளி 

உரை செருகும் புள்ளி : உரை செருகும் புள்ளி என்பது உரை உள்ள பகுதியில் ஒளிரும் செங்குத்து 
க�ோடு. விசைப்பலகையில் உள்ள 4 அம்புக்குறி விசைகளும் (←↑↓→) செருகும் புள்ளி கட்டுப்பாட்டு 
விசைகள் என அழைக்கப்படுகின்றன.
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உரை செருகும் புள்ளி

சுட்டியின் செருகும் புள்ளி :

திரையைச் சுற்றி நகரும் ப�ோது அது சுட்டிக்காட்டி வடிவத்தில் இருக்கும். ஒரு ஆவணத்தில் 

உள்ள உரையின் மீது நகர்த்தும்போது சுட்டியின் சுட்டிக்காட்டி I வடிவத்திற்கு மாறுகிறது. 'I' 

வடிவ செருகும் புள்ளியை உரையின் மேல் நகர்த்தி, தேவையான உரையைக் கிளிக் செய்வதன் 

மூலம், ஆவணத்தைத் திருத்தும் ப�ோது உரை செருகும் புள்ளியைப் பெற உதவுகிறது. இவ்வாறு, 

உரை செருகும் புள்ளியின் இருப்பிடத்தைக் கட்டுப்படுத்த சுட்டி பயன்படுத்தப்படுகிறது.

பிரிவு 4. உரையை திருத்துதல்

1.	 நீங்கள் திருத்த விரும்பும் உரையைத் தேர்ந்தெடுக்கவும்

2.	 Home > Font type > font size என்பதைக் கிளிக் செய்யவும்.

3.	 கருவிகளை பயன்படுத்தி வடிவமைக்க விரும்பும் ஆவணத்தில் எழுத்துரு வகை, பத்தி சீரமைப்பு 

மற்றும உள் தள்ளல் விரும்பம் ஆகியவற்றை மாற்றவும்.

உரை பதிப்பித்தல்

பிரிவு 5. செயல்தவிர் மற்றும் மீண்டும் செய் : (undo and Redo)

படி 1: Home என்பதைக் கிளிக் செய்துகீழே காட்டப்பட்டுள்ளதைப் ப�ோல் undo மற்றும் Redo 

விருப்பத்தைத் தேர்ந்தெடுக்கவும். ஏற்கனவே உருவாக்கப்பட்ட ஆவணத்தை ( சான்றுக்காக : 

report.docx) ஆரம்பித்து த�ொகுக்கலாம். ஆவணத்தில் கடைசியாக தெரியாமல் செய்த பிழையை 

சரி செய்ய “undo” பயன்படுத்தலாம். அதை திரும்ப ‘‘Redo” பெறுவதற்கு பயன்படுத்தலாம்..
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Undo மற்றும் Redo

பிரிவு 6. உரையை ஒரு இடத்திலிருந்து இன்னொரு இடத்திற்கு நகர்த்துதல் மற்றும் 

நகலெடுத்தல்.

படி 1: உரையைத் தேர்ந்தெடுக்கவும்

படி 2: வலது கிளிக் செய்து Cut விருப்பத்தைத் தேர்ந்தெடுக்கவும் அல்லது CTRL+X ஐ அழுத்தவும். 

படி 3: உரையை நகர்த்த வேண்டிய இடத்தில் செருகும் புள்ளியை வைக்கவும்.

படி 4: வலது கிளிக் செய்து paste விருப்பத்தை தேர்ந்தெடுக்கவும் அல்லது CTRL+V அழுத்தவும்.

உரையை நகலெடுத்தல், ஒட்டுதல்

பிரிவு 7. நகலெடுத்து ஒட்டுதல்

படி 1: உரையைத் தேர்ந்தெடுக்கவும்
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படி 2:  வலது கிளிக் செய்து copy விருப்பத்தைத் தேர்ந்தெடுக்கவும் அல்லது CTRL+C ஐ 
அழுத்தவும்.

படி 3: உரையை நகலெடுக்க வேண்டிய இடத்தில் செருகும் புள்ளியை வைக்கவும். வலது கிளிக் 
செய்து paste விருப்பத்தைத் தேர்ந்தெடுக்கவும் அல்லது CTRL+V ஐ அழுத்தவும்.

பிரிவு 8. உரையைத் தேர்ந்தெடுத்தல்

படி 1: உரையைத் தேர்ந்தெடுக்க சுட்டியின் இடது ப�ொத்தானை நீண்ட கிளிக் செய்து சுட்டியை 
நகர்த்தி வேண்டிய உரையைத் தேர்ந்தெடுக்கவும்.

படி 2: அனைத்தையும் தேர்ந்தெடுக்க Ctrl+A ஐ அழுத்தவும்.

படி 3: : உரையை தேர்ந்தெடுத்தல் முறையை நிறுத்துவதற்கு “Esc”ப�ொத்தானை அழுத்தவும்.

பிரிவு 9. உரையின் செங்குத்துத் த�ொகுதியைத் தேர்ந்தெடுத்தல்

படி 1: அனைத்து உரைகளையும் தேர்ந்தெடுக்க CTRL + A ஐ அழுத்தவும்.

படி 2: உரையின் செங்குத்துத் த�ொகுதியைத் தேர்ந்தெடுக்க CTRL + SHIFT + F8ஐ அழுத்தவும், 
பின்னர் அம்புக்குறி விசைகள் அல்லது Alt விசையைப் பயன்படுத்தவும்.

படி 3: தேர்ந்தெடுத்தலை நீக்க ESC விசையை அழுத்தவும்.

உரையின் செங்குத்துத் த�ொகுதியைத் தேர்ந்தெடுத்தல்

பிரிவு 10. உரையைகண்டுபிடித்து மாற்றுதல்

படி 1: உரையை கண்டுபிடிக்க Home கருவிப்பட்டியில் Home>Editing>Find என்ற விருப்பத்தை 
கிளிக் செய்யவும்.

படி 2: மாற்றியமைக்க முகப்பு கருவிப்பட்டியில் Home>Editing> Replace விருப்பத்தைக் கிளிக் 
செய்யவும்

படி 3: Find விருப்பத்தின் கீழ் உரையை எழுதவும் மற்றும் Replace விருப்பத்தில் மாற்றக்கூடிய 
உரையை எழுதவும் பிறகு ok என்பதைக் கிளிக் செய்யவும் அல்லது Enter விசையை அழுத்தவும்.
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கண்டுபிடித்து மாற்றுதல்

பிரிவு 11. Synonyms & Thesaurus ஐப் பயன்படுத்துதல்

படி 1: உரையின் மீது வலது கிளிக் செய்து, synonyms தேர்வை கிளிக் செய்து ப�ொருத்தமான வார்த்தையைத் 
தேர்ந்தெடுக்கவும். ஒரு ச�ொல் செயலி, ச�ொற்களஞ்சியத்தில் ஒத்த ச�ொற்களையும் (ஒரே ப�ொருளைக் 
க�ொண்ட வெவ்வேறு ச�ொற்கள்) மற்றும் எதிர்ச்சொற்களையும் (எதிர் ப�ொருள் க�ொண்ட ச�ொற்கள்) 
பார்க்க உதவுகிறது. ஒத்த ச�ொற்களின் பட்டியலை ஒரு சூழல் மெனுவிலிருந்து அணுகலாம், ஒரு 
வார்த்தையின் மீது வலது கிளிக் செய்து, சூழல் மெனுவில் உள்ள ஒத்த ச�ொற்களை சுட்டிக்காட்டவும். 
மாற்று வார்த்தைகள் மற்றும் ச�ொற்றொடர்களின் துணைமெனு காட்டப்படும். ஆவணத்தில் தனிப்படுத்தப்பட்ட 
ச�ொல் அல்லது ச�ொற்றொடரை மாற்ற துணைமெனுவில் உள்ள ஒரு ச�ொல் அல்லது ச�ொற்றொடரைக் 
கிளிக் செய்யவும். ஒத்த ச�ொற்கள் அகராதியிலிருந்து வேறுபட்டவை. ஒரு அகராதியில் வரையறைகள் 
மற்றும் உச்சரிப்புகள் உள்ளன, அதேசமயம் ச�ொற்களஞ்சியம் ஒத்த அர்த்தங்கள் அல்லது எதிர் 
அர்த்தங்களைக் க�ொண்ட ச�ொற்களைக் க�ொண்டிருக்கும்..

 ஒத்த ச�ொற்கள் மற்றும் ச�ொற்களஞ்சியம்
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பிரிவு 12. க�ோப்பைச் சேமித்து மீண்டும் திறக்கவும்

1.	 Home>File>Save என்பதைக் கிளிக் செய்யவும் அல்லது Ctrl +S விசையை அழுத்தவும்.
2.	 க�ோப்பைச் சேமிக்க வட்டில் உள்ள இடத்தைத் தேர்ந்தெடுக்கவும்
3.	 ஆவணத்திற்கு ப�ொருத்தமான பெயரை உள்ளிடவும்

4.	 Save என்பதைக் கிளிக் செய்யவும் அல்லது Enter விசையை அழுத்தவும்.
5.	 File > open என்பதைக் கிளிக் செய்து மூலம் க�ோப்பை மீண்டும் திறக்கலாம் .
6.	 ஆவணத்தின் பெயரையும் இடத்தையும் தேர்ந்தெடுக்கவும் அல்லது தட்டச்சு செய்து open 

என்பதைக் கிளிக் செய்யவும் அல்லது Enter விசையை அழுத்தவும்.

முடிவுரை :

இவ்வாறு பல்வேறு விருப்பத்தேர்வுகளுடன் கூடிய ஒரு MS வேர்ட் ஆவணம் வெற்றிகரமாக 
உருவாக்கப்பட்டுள்ளது.

காண�ொலி பரிந்துரைகள் :

வ. எண் தலைப்பு/ந�ோக்கம் இணைப்பு

1 புதிய ஆவணத்தை உருவாக்க https://youtu.be/4M5sjPGLZks

2 MS வேர்ட்டில் சாளரத்தின் பகுதிகள் https://youtu.be/COzqY5TBXD8

3 MS வேர்ட்டில் உரை பதிப்பித்தல் https://youtu.be/nHNTK8QQiUE

4 MS வேர்ட்டில் Undo மற்றும் Redo https://youtu.be/pnMrQ6U_vtA

5 MS வேர்ட்டில் உரையை நகர்த்த மற்றும் 

நகலெடுக்க

https://youtu.be/mGbOlT2cdVU

6 MS வேர்ட்டில் நகலெடுத்து ஒட்ட https://youtu.be/sOqaakHHSQY

7 MS வேர்ட்டில் உரையைத் தேர்ந்தெடுக்க https://youtu.be/zNXZD0cS0VM

8 MS வேர்ட்டில் உரையின் செங்குத்துத் 

த�ொகுதியைத் தேர்ந்தெடுத்தல்

https://youtu.be/vIbxrddLLj8

9 MS வேர்ட்டில் Find மற்றும Replace https://youtu.be/8ZSlu4DWJ5k

10 MS வேர்ட்டில் synonyms மற்றும் 

Thesaurus பயன்படுத்தல்

https://youtu.be/hXhpd0kehfg

11 MS வேர்ட்டில் க�ோப்பைச் சேமித்து 

மீண்டும் திறத்தல்

https://youtu.be/0rnx5HoxO5s
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எளிய மதிப்பீடுகள் :

மாணவர் செயல்பாடு 1. � மாணவர்கள் ஒரு நிறுவனத்திற்கான சான்றுச் சீட்டினை 

(Voucher) உருவாக்க வேண்டும்.

2. � ஒரு விழாவிற்கான ஒரு சுவ ர�ொட்டியை (Poster) தயார் 

செய்ய வேண்டும்.

விருந்தினர் விரிவுரை 

பரிந்துரைகள்

1. � விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் நிபுணரை 

அழைக்கவும்.

2. � விருந்தினர் விரிவுரைக்கு கணினி த�ொழில்நுட்ப 

வல்லுநரை அழைக்கவும்.

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் அலுவலக உதவியாளரை 

அழைக்கவும்.

த�ொழில்சார்ந்த / கள 

ஆய்வு பரிந்துரைகள்

1. � பள்ளிக்கு அருகாமையில் உள்ள அலுவலகத்திற்கு கள 

ஆய்வு மேற்கொள்ளுதல்.

2. � கள ஆய்வுக்காக அருகிலுள்ள வங்கிகளைப் 

பார்வையிடவும்.

3.  அருகிலுள்ள தணிக்கை அலுவலகத்தை பார்வையிடவும்.

	 10.5	� MS வேர்ட் ஆவணத்தை வடிவமைப்பதற்கான வழிமுறைகள்

ந�ோக்கம் :

வழிமுறைகளைப் பயன்படுத்தி MS வேர்ட் ஆவணத்தை வடிவமைத்தல்.

செயல்பாடுகள்:

1.	 ஆவணத்தை வடிவமைத்தல்

2.	 உரை வடிவமைத்தல், கைமுறை வடிவமைப்பை அகற்றுதல்

3.	 பத்தியை வடிவமைத்தல் மற்றும் புல்லட்கள் மற்றும் எண்களைப் பயன்படுத்துதல்

4.	 பக்கத்திற்கு நிறம், பார்டர் மற்றும் பின்னணியை வழங்குதல்

5.	 பக்கத்தை வடிவமைத்தல்

தேவையான கருவிகள் மற்றும் உபகரணங்கள்:

வ. எண் கருவிகள் / உபகரணங்களின் பெயர் வரம்பு / மதிப்பு அளவு

1 மேசை கணினி அல்லது மடிக்கணினி 15 செயலி / 4GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1
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செயல்முறை :

பிரிவு 1. ஆவணத்தை வடிவமைத்தல்

படி 1: வேர்ட்டின் இயல்பு நிலை வெற்று ஆவணத்தைத் திறக்க வேர்ட்டைத் திறந்து குறுக்கு 
விசையை Ctrl+N அழுத்தவும். 

படி 2: இந்த வெற்று ஆவணத்தை சேமிக்க Ctrl+S குறுக்கு விசையை அழுத்தவும். 

படி 3: உங்கள் கணினியில் தேர்ந்தெடுக்கப்பட்ட இடத்தில் (எ.கா. Favourties) ஆவணத்தை 'My 
layout.docx' எனச் சேமிக்கவும்.

ஆவணத்தை வடிவமைத்தல்

படி 4: பக்க அமைப்பிற்கு, page layout> Margins> Custom Margins என்பதைக் கிளிக் 
செய்யவும்

படி 5: “Margins tab” - ஐ கிளிக் செய்யவும்.

படி 6: இடது ஓர அகலத்தை 3 செமீ ஆக மாற்றவும்.

படி 7: Orientation கீழ் Portrait பக்கத்தைத் தேர்ந்தெடுக்கவும்

Margin தத்தல்
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படி8: கீழ்விரிப் பெட்டியில் Apply to தேர்வில் whole document தேர்வு உள்ளதா என்பதைச் 
உறுதி செய்த பிறகு ok ப�ொத்தானைக் கிளிக் செய்யவும் அல்லது Enter ஐ அழுத்தவும் .

Orientation தத்தல்

அனைத்து பக்கங்களுக்கும் பக்க விளிம்பு ந�ோக்கு நிலை ப�ொருத்தப்பட்டது.

பக்க அமைப்பைக் குறிப்பிடுதல்

அச்சிடப்படும் இரட்டை பக்க ஆவணங்களின் பக்க ஓரங்கள் மற்றும் எண்களை அமைக்க, படி 
4 இல் பயன்படுத்திய அதே பக்க அமைவு சாளரத்தில் உள்ள Layout தத்தலைத் தேர்ந்தெடுக்கவும்.

படி 9: தலைப்புகள் மற்றும் அடிக்குறிப்புகள் பிரிவில் different odd and even கிளிக் செய்யவும்.

தலைப்பு மற்றும் அடிக்குறிப்பு பிரிவு
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படி 10: Different first page விருப்பத்தை கிளிக் செய்யவும்

படி 11: கீழ் விரிப்பெட்டியில் Apply to தேர்வில் whole document தேர்வு உள்ளதா என்பதைச் 
சரிபார்க்கவும்.

பிரிவு 2. உரை வடிவமைத்தல், கைமுறை வடிவமைப்பை நீக்குதல்

படி 1: நீங்கள் வடிவமைக்க விரும்பும் உரையைத் தேர்ந்தெடுக்கவும்.

படி 2: ஒற்றை வார்த்தையைத் தேர்ந்தெடுக்க, இருமுறை கிளிக் செய்யவும். உரையின் வரியைத் 
தேர்ந்தெடுக்க, அதன் வலதுபுறத்தில் கிளிக் செய்யவும்.

படி 3: எழுத்துரு, எழுத்துரு அளவு, எழுத்துரு நிறம் அல்லது உரையை தடித்த, சாய்வு அல்லது 
அடிக்கோடிட்டு மாற்றுவதற்கான விருப்பத்தைத் தேர்ந்தெடுக்கவும்.

எழுத்துரு சீரமைப்பு

படி 4: நீங்கள் நகலெடுக்க விரும்பும் வடிவமைக்கப்பட்ட உரையைத் தேர்ந்தெடுக்கவும்.

படி 5: Format Painter என்பதைக் கிளிக் செய்து, வடிவமைப்பை நகலெடுக்க விரும்பும் உரையைத் 
தேர்ந்தெடுக்கவும்.

கைமுறை வடிவமைப்பை நீக்குதல்

படி 1: வேர்டில் வடிவமைப்பை நீக்க விரும்பும் உரையைத் தேர்ந்தெடுக்கவும். உங்கள் சுட்டியைப் 
பயன்படுத்தி ஆவணத்தின் உள்ளே எங்கு வேண்டுமானாலும் உரையின் ஒரு பகுதியை மட்டும் 
தேர்ந்தெடுக்கலாம் அல்லது ஆவணத்தில் உள்ள எல்லா உரையையும் Ctrl + A விசையை அழுத்தி 
தேர்ந்தெடுக்கவும்.

படி 2: Styles பட்டியை விரிவாக்க, styles பெட்டியின் கீழ் வலது மூலையில் உள்ள கீழ் விரி 
அம்புக்குறியைத் தேர்ந்தெடுக்கவும்.
படி 3: Clear Formatting – யைத் தேர்ந்தெடுக்கவும். தேர்ந்தெடுக்கப்பட்ட உரையில் மேற்கொண்ட 
அனைத்து வடிவமைப்பும் அகற்றப்படும்.

ப�ொதுவான உரை வடிவமைப்பு

பெரிய சிறிய எழுத்துகளாக உரை எழுத்தை மாற்ற :

படி 1: நீங்கள் மாற்ற விரும்பும் உரையைத் தேர்ந்தெடுக்கவும்.
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படி 2: Home தத்தலில் உள்ள Font குழுவில் Change Case மாற்றம் கட்டளையைக் கிளிக் 
செய்யவும்.

படி 3: பட்டியலில் இருந்து Case விருப்பங்களில் ஒன்றைத் தேர்ந்தெடுக்கவும்.

எழுத்தின் வடிவமைப்பை மாற்றுதல்

தடிமனான, சாய்வு மற்றும் அடிக்கோடு கட்டளைகளைப் பயன்படுத்துதல்:

படி 1: நீங்கள் மாற்ற விரும்பும் உரையைத் தேர்ந்தெடுக்கவும்.

படி 2: Home தத்தலில் உள்ள Font குழுவில் தடிமனான, சாய்வு , அல்லது அடிக்கோடிடுதல் 
கட்டளையைக் கிளிக் செய்யவும் அல்லது முறையே ப�ோல்டு (Ctrl + B), சாய்வு (Ctrl + I) 
மற்றும் (Ctrl + U) விசைகளை அழுத்தவும்.

எழுத்துரு அளவை வடிவமைத்தல் :

படி 1: நீங்கள் மாற்ற விரும்பும் உரையைத் தேர்ந்தெடுக்கவும்.

படி 2: Home தத்தலில் உள்ள Font size பெட்டிக்கு அடுத்துள்ள கீழ்விரி அம்புக்குறியை இடது 
கிளிக் செய்யவும் . Font size கீழ்விரி பட்டி த�ோன்றும்.

படி 3: உங்கள் செருகும்புள்ளியை பல்வேறு Font அளவுகளின் நகர்த்தவும். Font அளவின் 
நேரடி முன்னோட்டம் ஆவணத்தில் த�ோன்றும்.

Font size பெட்டி
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எழுத்துரு நிறத்தை வடிவமைத்தல் :

படி 1: நீங்கள் மாற்ற விரும்பும் உரையைத் தேர்ந்தெடுக்கவும்.

படி 1: Home தத்தலில் உள்ள Font color பெட்டிக்கு அடுத்துள்ள கீழ்விரி அம்புக்குறியை

இடது கிளிக் செய்யவும். Font color பட்டி த�ோன்றும்.

Font color பெட்டி

படி 3:  உங்கள் செருகும் புள்ளியை பல்வேறு எழுத்துரு வண்ணங்களின் மீது நகர்த்தவும். 
வண்ணத்தின் நேரடி முன்னோட்டம் ஆவணத்தில் த�ோன்றும்

எழுத்துரு பாணியை வடிவமைத்தல் :

படி 1: நீங்கள் மாற்ற விரும்பும் உரையைத் தேர்ந்தெடுக்கவும்.

படி 2: Home தத்தலில் உள்ள Font style பெட்டிக்கு அடுத்துள்ள கீழ்விரி அம்புக்குறியை இடது 
கிளிக் செய்யவும். Font sytle கீழ்விரி பட்டி த�ோன்றும்.

படி 3:  உங்கள்  செருகும்  புள்ளியை  பல்வேறு  எழுத்துரு  வடிவங்களின்  மீது  நகர்த்தவும் . 
எழுத்துருவின் நேரடி முன்னோட்டம் ஆவணத்தில் த�ோன்றும்.

எழுத்துரு பாணி பெட்டி
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உரைக்கு Superscript அல்லது Subscript வடிவமைப்பைப் பயன்படுத்துதல் :

படி 1: நீங்கள் Superscript அல்லது Subscript வடிவமைக்க விரும்பும் உரையைத் தேர்ந்தெடுக்கவும்

படி 2: Home தத்தலைக் கிளிக் செய்து, Font பிரிவின் கீழ் வரிசையில் காணப்படும் Superscript 
அல்லது Subscript பட்டனைக் கிளிக் செய்யவும்.

உரைக்கு Superscript அல்லது Superscript வடிவமைப்பு

பிரிவு 3. பத்தியை வடிவமைத்தல் & Bullets and Numbering பயன்படுத்துதல்

பத்தி Style

படி 1: ஒரு பத்தியின் முதல் எழுத்தில் செருகும் புள்ளியை வைத்து Home > Styles என்பதை 
கிளிக் செய்து உங்கள் பாணியை Style கேலரியிருந்து தேர்ந்தெடுக்கவும். 

Style த�ொகுப்புகள்

படி 1: Design தத்தலை கிளிக் செய்யவும்

படி 2: வடிவமைப்பு கேலரியை ஆவணப்படுத்து
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Style பலகத்தைத் திறக்க
படி 1: Home தத்தலைக் கிளிக் செய்யவும் 

படி 2: Styles உரையாடல் பெட்டி துவக்கியைத் தேர்ந்தெடுக்கவும்

படி 3: நீங்கள் Style செய்ய விரும்பும் உரையைத் தேர்ந்தெடுக்கவும்

கேலரியை வடிவமைத்தல்

ஒரு பத்தியை வடிவமைக்க, படத்தின் கீழே உள்ள படிகளைப் பின்பற்றவும்

பத்திகளை உள்தள்ளல்

படி 1: நீங்கள் உள்தள்ள விரும்பும் உரையைத் தேர்ந்தெடுக்கவும்

படி 2: முழு பத்தியையும் ஒரு நேரத்தில் உள்தள்ளலாம்.
படி 3: உரை செருகும்புள்ளியை பத்தியில் எங்கு வேண்டுமானாலும் வைத்து, Increase Indent 
கருவியைத் தேர்ந்தெடுத்து கிளிக் செய்யவும். உள்தள்ளலை அகற்றும் Decrese Indent கருவியும் 
உள்ளது.
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பத்தி இசைவு

படி 1: உங்கள் ஆவணத்தைத் தட்டச்சு செய்யத் த�ொடங்கும் முன் உரையைத் தேர்ந்தெடுத்து 
பத்தி இசைவை அமைக்கவும்.
படி 2: பின்னர் "Home" தத்தலைக் கிளிக் செய்யவும்.
படி 3: பின்னர் இடது இசைவு (Ctrl + L), மைய இசைவு (Ctrl + E), வலது இசைவு சீரமைக்கவும் 
(Ctrl + R), அல்லது நேர்த்தி இசைவு (Ctrl + J) ப�ொத்தானைக் கிளிக் செய்வதன் மூலம், 
விரும்பிய பத்தி இசைவை Paragraph ப�ொத்தான் குழு மூலம் அமைக்கலாம்.

Bullet பட்டியலை உருவாக்குதல் :

படி 1: Home தத்தலுக்குச் செல்லவும்

படி 2: Paragraph த�ொகுதியின் முதல் விருப்பத் தேர்வான Bullet-ன் கீழ்விரி அம்புக்குறியைக் 
கிளிக் செய்யவும்.

படி 3: “Bullet” கட்டளையின் கீழ், புல்லட் செய்யப்பட்ட பட்டியலிருந்து விரும்பும் ஒன்றைத் 
தேர்ந்தெடுக்கவும்.

படி 4: இப்போது Bullet அதன் பட்டியலைத் த�ொடங்க உங்கள் வேர்ட் ஆவணத்தில் செருகப்பட்டிருக்கும்.

படி 5: அடுத்த புல்லட் பாயிண்டைத் த�ொடங்க Enter விசையை அழுத்தவும். Bullet பட்டியலை 
உருவாக்க, இதைப் ப�ோலவே செய்யவும்.

படி 6: Bullet பட்டியல் இல்லாமல் ஒரு ச�ொல், வாக்கியம் அல்லது பத்தியுடன் புதிய பகுதியைத் 
த�ொடங்க, Enter விசையை 2 முறை அழுத்தவும்.

Bulletin Library

Numbering பட்டியலை உருவாக்குதல்

படி 1: Home தத்தலுக்குச் செல்லவும்

படி 2: Numbering கீழ்விரி அம்புக்குறியைக் கிளிக் செய்யவும், இது Paragraph த�ொகுதியின் 
இரண்டாவது விருப்பமாகும். 
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படி 3:  Numbering கட்டளையின்  கீழ் ,  எண்ணிடப்பட்ட  பட்டியலைத்  த�ொடங்க  விரும்பும் 
தேர்வுகளில் ஒன்றைத் தேர்ந்தெடுக்கவும்.

படி 4: எண்ணைச் செருகிய பிறகு, நீங்கள் விரும்பும் ச�ொல் / வாக்கியத்தைத் தட்டச்சு செய்யத் 
த�ொடங்குங்கள்.

படி 5: அடுத்த வரிசை எண்ணைத் த�ொடங்க Enter விசையை அழுத்தவும். எண் பட்டியலை 
உருவாக்க இதைப் ப�ோலவே செய்யுங்கள்.

படி 6: எண்ணிடப்பட்ட பட்டியல் இல்லாமல் ஒரு ச�ொல், வாக்கியம் அல்லது பத்தியுடன் புதிய 
உரையைத் த�ொடங்க, Enter விசையை 2 முறை அழுத்தவும்.

படி 7: புதிய பிரிவின் எண் பட்டியல் இல்லாமல் வாக்கியம் அல்லது பத்தியை உருவாக்குவதற்கு 
“Enter” பட்டனை 2 முறை அழுத்தவும்.

எண் பட்டியல்

பிரிவு 4. நிறம், எல்லை மற்றும் பின்னணியை வழங்குதல்

பக்கத்தின் நிறத்தை வழங்குதல்

படி 1: Design தத்தலில் Page color ப�ொத்தானைக் கிளிக் செய்யவும்.

படி 2: ஒரு வண்ணத்தைத் தேர்ந்தெடுக்கவும்.
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நிறத்தை வழங்குதல்

பக்க எல்லைகளைச் சேர்த்தல்

படி 1: Design > Borders and shading > Page border என்பதைக் கிளிக் செய்யவும்.

படி 2: Style பட்டியலிலிருந்து Border Style - யைத் தேர்ந்தெடுக்கவும்.

படி 3: Border color - யைத் தேர்ந்தெடுக்கவும்.

படி 4: Border width - யைத் தேர்ந்தெடுக்கவும்.

பக்க எல்லைகளைச் சேர்க்கவும்

படி 5: Preview வின் மேல், கீழ் மற்றும் /அல்லது பக்கங்களைக் கிளிக் செய்வதன் மூலம் 
பக்கத்தின் எந்தெந்த ஓரங்களில் Border இருக்கும் என்பதைத் தேர்வுசெய்யவும்.

படி 6: ஆவணத்தின் எந்தப் பகுதியில் Border இருக்கும் என்பதைத் தேர்ந்தெடுக்கவும்.
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படி 7: Whole document அல்லது just this section அல்லது just the first page in this 
section அல்லது every page in the section but the first page ப�ோன்ற தேர்வுகளில் ஏதேனும் 
ஒன்றை தேர்வு செய்து ok ப�ொத்தனைக் கிளிக் செய்யவும் அல்லது Enter விசையை அழுத்தவும்.

படி 8: Enter விசையை அழுத்தவும்.

பிரிவு 5. பக்க வடிவமைப்பு

பக்க வடிவை மாற்றுதல்:

படி 1:  Layout – ஐ தேர்ந்தெடுக்கவும்

படி 2:  Orientation  கட்டளையை தேர்ந்தெடுக்கவும்.

படி 3:  கீழ் ந�ோக்கி மெனு புலப்படும். அதை கிளிக் செய்யவும்.

பக்க வடிவை மாற்றுதல்

பக்க அளவு

படி 1: Layout > Size என்பதைக் கிளிக் செய்யவும் 

படி 2: கீழ்விரி பட்டியல் த�ோன்றும். தற்போதைய பக்க அளவு முன்னிலைப்படுத்தப்பட்டிருக்கும். 
விரும்பிய முன் வரையறுக்கப்பட்ட பக்க அளவைக் கிளிக் செய்யவும்.

பக்க அளவு
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தேவையான பக்க அளவைப் பயன்படுத்துதல்:

படி 1: Page setup உரையாடல் பெட்டியைக் கிளிக் செய்யவும்.

படி 2: கீழ்விரிப்பட்டியிலிருந்து Layout > Size > More Paper sizes என்பதைக் கிளிக் செய்யவும் .

படி 3: Page setup உரையாடல் பெட்டி த�ோன்றும்.

படி 4: Width மற்றும் Height மதிப்புகளைச் சரிசெய்து, ok ப�ொத்தானை கிளிக் செய்யவும் 
அல்லது Enter விசையை அழுத்தவும்.

படி 5: பக்கத்தின் அளவுகள் இப்போது மாறி காணப்படும்.

Page Setup உரையாடல் பெட்டி

பக்க ஓரங்கள்

படி 1: layout > Margin என்பதை தேர்வு செய்யவும்.

படி 2: கீழ்விரிபட்டியல் த�ோன்றும். அதில் விரும்பும் முன் வரையறுக்கப்பட்ட ஓர் அளவைக் 
கிளிக் செய்யவும்.

பக்க ஓரங்கள்
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வேர்டில் ஒரு Page Break ஐ செருகுதல்

படி 1: விரும்பும் இடத்தில் ஒரு பக்கத்தை முடிக்கவும், அடுத்த பக்கத்தை த�ொடங்கவும் செருகும் 
புள்ளியை அந்த இடத்தில் வைக்கவும்.

படி 2: Insert > Page Break என்பதை தேர்ந்தெடுக்கவும்.

Page Break

தலைப்பு அல்லது அடிக்குறிப்பில் பக்க எண்களைச் சேர்த்தல் :

படி 1: தலைப்பு அல்லது அடிக்குறிப்பில் பக்க எண்கள் எங்கு வேண்டும�ோ அங்கு கிளிக் செய்யவும்.

படி 2: Insert > Page Numbering என்பதை தேர்ந்தெடுக்கவும்.

படி 3: பக்க எண்ணை தேர்ந்தெடுக்கவும் 

படி 4 :  பாணியைத் (Style) தேர்ந்தெடுக்கவும்.

பக்கத்திற்கு Border ஐ சேர்த்தல்

படி 1: Design > Page border ஐ தேர்ந்தெடுக்கவும்.

படி 2: Border எப்படி இருக்க வேண்டும் என்பதை தேர்வு செய்யவும்.

பக்க எல்லை

படி 3: பக்கத்தின் எல்லைக்கும், விளிம்பிற்கும் இடையே உள்ள தூரத்தை சரிசெய்ய options 
தேர்வைத் தேர்ந்தெடுக்கவும். தேவையான மாற்றங்களைச் செய்து ok என்பதைக் கிளிக் செய்யவும்.
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ஒரு ஆவணத்தில் குறியீடுகள், படங்கள், வடிவங்கள் மற்றும் சிறப்பு எழுத்துக்களைச் செருகுதல்:

படி 1: நீங்கள் குறியீட்டைச் செருக விரும்பும் இடத்தில் உங்கள் செருகும் புள்ளியை வைக்கவும்.

படி 2: Insert > Symbol பயன்படுத்தி குறியீட்டை தேர்ந்தெடுக்கவும். More தேர்வை பயன்படுத்தி 
மேலும் பல குறியீடுகளை தேர்ந்தெடுக்கலாம்.

படி 3: தேவையான குறியீடுகளை தேர்ந்தெடுக்கவும்.

படி 4: கீழ் ந�ோக்கிய அல்லது மேல் ந�ோக்கிய குறியீட்டை அழுத்துவதன் மூலம் மேலும் அதிகமான 
குறியீடுகளை பெறலாம். குறியீட்டின் மீது கிளிக் செய்வதன் மூலம் ஆவணத்தில் இணைக்கலாம்.

சமன்பாடு மற்றும் குறியீட்டைச்செருகுதல்

முடிவுரை :

இவ்வாறு, மேற்குறிப்பிட்ட வழிமுறைகளைப் பயன்படுத்தி MS வேர்ட் ஆவணத்தை வடிவமைத்தல் 
வெற்றிகரமாக முடிந்தது.

காண�ொலி பரிந்துரைகள் :

வ. எண் தலைப்பு / ந�ோக்கம் இணைப்பு

1 ஆவணத்தை வடிவமைத்தல் https://www.youtube.com/

watch?v=F6Vhzl4XxvU

2 உரை வடிவமைத்தல், கைமுறை வடிவமைப்பை 

நீக்குதல்.

https://www.youtube.com/

watch?v=SiVjclEjw9E

3 பத்திகளை வடிவமைத்தல் மற்றும் 

த�ோட்டாக்களைப் பயன்படுத்துதல், எண்ணிடுதல்.

https://www.youtube.com/

watch?v=yV4i29Xo0iM

4 பத்திகளுக்கு நிறம், எல்லை மற்றும் 

பின்னணியை வழங்குதல்.

https://www.youtube.com/

watch?v =ZJyvWpZOTKY

5 பக்கத்தை வடிவமைத்தல். https://www.youtube.com/

watch?v=Ci1P40GsDy8
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எளிய மதிப்பீடுகள் :

மாணவர் செயல்பாடு 1. � மாணவர்கள் ஒரு நிறுவனத்திற்கான சான்றுச்சீட்டினை 

உருவாக்க வேண்டும்.

2. � பள்ளியில் நடக்கும் நிகழ்ச்சிக்கு சுவர�ொட்டி ப�ோஸ்டர் தயார் 

செய்ய வேண்டும்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1. � விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் த�ொழில்நுட்ப 

வல்லுநரை அழைக்கவும்.

2. � விருந்தினர் விரிவுரைக்கு கணினி த�ொழில்நுட்ப 

வல்லுநரை அழைக்கவும்.

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் அலுவலக உதவியாளரை 

அழைக்கவும்.

த�ொழில் சார்ந்த / கள 

ஆய்வு பரிந்துரைகள்

1. � பள்ளிக்கு அருகாமையிலுள்ள அலுவலகத்திற்கு கள ஆய்வு 

மேற்கொள்ளுதல்.

2.  கள ஆய்வுக்கு அருகிலுள்ள வங்கிகளைப் பார்வையிடவும்.

3.  அருகிலுள்ள தணிக்கை அலுவலகத்தை பார்வையிடவும்.

	10.6 	� MS Word ஆவணத்தில் அட்டவணைகள் மற்றும் அதன் பல்வேறு 

பயன்பாடுகளை உருவாக்குவதற்கான வழிமுறைகள் :

ந�ோக்கம் :

MS வேர்ட் ஆவணத்தில் அட்டவணை மற்றும் அதன் பல்வேறு பயன்பாடுகளை உருவாக்குவது 
பற்றி புரிந்து க�ொள்ளுதல்.

செயல்பாடுகள் :

1.	 அட்டவணையை உருவாக்கி பயன்படுத்தல்
2.	 அட்டவணையில் வரிசைகள் மற்றும் நெடுவரிசைகளைச் செருகுதல் மற்றும் நீக்குதல்.
3.	 ஒரு அட்டவணையைப் பிரித்தல் மற்றும் ஒன்றிணைத்தல்
4.	 ஒரு அட்டவணையை நீக்குதல், நகலெடுத்தல் மற்றும் நகர்த்துதல்

தேவையான கருவிகள் மற்றும் உபகரணங்கள்:

வ. எண் கருவிகள் / உபகரணங்களின் பெயர் வரம்பு / மதிப்பு அளவு

1 கணினி அல்லது மடிக்கணினி i5 செயலி / 4GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1

செயல்முறை:

பிரிவு 1. அட்டவணையை உருவாக்கி பயன்படுத்துதல் :

படி 1 : விரும்பும் இடத்தில் அட்டவணை த�ோன்ற செருகும் புள்ளியை அந்த இடத்தில் வைக்கவும்.
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படி 2 : Table பட்டியை கிளிக் செய்யவும் . படி 2 : “Table” - யை கிளிக் செய்யவும்

படி 3 : நீங்கள் விரும்பும் நெடுவரிசைகள் மற்றும் வரிசைகளின் எண்ணிக்கையைத் தேர்ந்தெடுக்கவும்.

படி 4 :  தேவையான அமைப்பை தேர்வு செய்தால் பெட்டி த�ோன்றும். 

அட்டவணையைச்செருகுதல்

படி 5: உரையை உள்ளிட, செருகும் புள்ளியை ஏதேனும் ஒரு சிற்றரையில் வைத்து, தட்டச்சு 
செய்யத் த�ொடங்கவும்.

அட்டவணையில் உரையை உள்ளிடவும்

குறிப்பு : கலங்களுக்கு இடையில் செல்ல, உங்கள் விசைப்பலகையில் உள்ள தாவல் விசை அல்லது 
அம்புக்குறி விசைகளைப் பயன்படுத்தவும். செருகும் புள்ளி கடைசி கலத்தில் இருந்தால், Tab 
விசையை அழுத்தினால் தானாகவே புதிய வரிசை உருவாகும்.

பிரிவு 2. ஒரு அட்டவணையில் வரிசைகள்/நெடுவரிசைகளைச் செருகுதல் மற்றும் நீக்குதல்

வரிசை அல்லது நெடுவரிசையைச் சேர்க்கத்தல்:

படி 1: நீங்கள் சேர்க்க விரும்பும் வரிசை அல்லது நெடுவரிசையில் செருகும் புள்ளியை (Cursor) 
வைக்கவும்.
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படி 2: வலது கிளிக் செய்து, Insert ஐ தேர்ந்தெடுக்கவும் வரிசை அல்லது நெடுவரிசை தேர்வு 
செய்யவும் அட்டவணையில் அது சேர்க்கப்படும்.

அட்டவணையில் புதிய நெடுவரிசை மற்றும் வரிசையைச் சேர்க்க

குறிப்பு: பல்வேறு வரிசை மற்றும் நெடுவரிசை விருப்பங்களைக் காண, நீங்கள் அட்டவணையில் 
வலது கிளிக் செய்து, செருகு மீது வட்டமிடலாம்.

வரிசை அல்லது நெடுவரிசையை நீக்குதல்:

படி 1: நீங்கள் நீக்க விரும்பும் வரிசை அல்லது நெடுவரிசையில் செருகும் புள்ளியை வைக்கவும்.

படி 2: வலது கிளிக் செய்து, பட்டியிலிருந்து Delete cells என்பதைத் தேர்ந்தெடுக்கவும்.

படி 3: ஒரு உரையாடல் பெட்டி த�ோன்றும். Delete entire row அல்லது Delete entire column 
என்பதைத் தேர்வுசெய்து, ok ப�ொத்தானைக் கிளிக் செய்யவும் .

அட்டவணையில் ஒரு வரிசை அல்லது நெடுவரிசையை நீக்க

பிரிவு 3. ஒரு அட்டவணையைப் பிரித்தல்

படி 1: ஒரு சிற்றரையில் கிளிக் செய்யவும் அல்லது நீங்கள் பிரிக்க விரும்பும் பல சிற்றரைகளைத் 
தேர்ந்தெடுக்கவும்.
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படி 2: Layout > Split cell அல்லது split table என்பதைக் கிளிக் செய்யவும்.

படி 3: சிற்றரைகளாக அல்லது அட்டவணையாக பிரிக்க விரும்பும் நெடுவரிசைகள் அல்லது 
வரிசைகளின் எண்ணிக்கையை உள்ளிடவும் .

அட்டவணை பிரித்தல்

அட்டவணையை இணைத்தல் :

படி 1: நீங்கள் ஒன்றிணைக்க விரும்பும் சிற்றரைகளைத் தேர்ந்தெடுக்கவும்.

படி 2: Layout>Merge Cells என்பதைக் கிளிக் செய்யவும் அல்லது வலது கிளிக் செய்து, Merge 
Cells என்பதைத் தேர்ந்தெடுக்கவும் .

கலங்களை ஒன்றிணைத்தல்

பிரிவு 4. அட்டவணைகளை நீக்குதல், நகலெடுத்தல் மற்றும் நகர்த்துதல் அட்டவணையை 

நீக்குதல்:

படி 1: நீங்கள் நீக்க விரும்பும் அட்டவணை செல், வரிசை அல்லது நெடுவரிசையைத் தேர்ந்தெடுக்கவும்.

படி 2: Layout > Delete ஐ கிளிக் செய்து விருப்பத்தைத் தேர்வுசெய்யவும் அல்லது வலது கிளிக் 
செய்யவும்.
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படி 3: Delete Cells >ஐ தேர்வு செய்து உங்கள் விருப்பத்தைத் தேர்ந்தெடுக்கவும்.

அட்டவணையை நீக்குதல்

அட்டவணை நகலெடுத்தல் :

படி 1 : அட்டவணையைத் தேர்ந்தெடுக்கவும்.

நகல் அட்டவணை

படி 2 : பின்வருவனவற்றில் ஒன்றைச் செய்யவும்:

1.	 அட்டவணையை நகலெடுக்க, CTRL+C ஐ அழுத்தவும் அல்லது வலது கிளிக் செய்து copy 
என்பதைத் தேர்ந்தெடுக்கவும் .

2.	 அட்டவணையை வெட்ட, CTRL+X ஐ அழுத்தவும் அல்லது வலது கிளிக் செய்து cut என்பதைத் 
தேர்ந்தெடுக்கவும்.

படி 3:  புதிய அட்டவணையைச் சேர்க்க விரும்பும் இடத்தில் செருகும் புள்ளியை (Cursor) 
வைக்கவும்.

படி 4: புதிய இடத்தில் அட்டவணையை ஒட்ட CTRL+V ஐ அழுத்தவும்.
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ஒரு அட்டவணையை நகர்த்துதல்:

படி 1: செருகும் புள்ளியை (Cursor) நான்கு தலைகள் க�ொண்ட அம்புக்குறியாக மாறும் வரை 
அட்டவணையின் மீது வைத்து பின்பு கிளிக் செய்யவும்.

படி 2: அட்டவணையை புதிய இடத்திற்கு நகர்த்தவும்.

முடிவுரை :

இவ்வாறு MS Word மென்பொருள் கருவிகளைப் பயன்படுத்தி அட்டவணைகளை உருவாக்குவது 
வெற்றிகரமாக முடிந்தது.

காண�ொளி பரிந்துரைகள் :

வ. எண் தலைப்பு / ந�ோக்கம் இணைப்பு

1 அட்டவணையை உருவாக்கி 

பயன்படுத்துதல்

https://www.youtube.com/

watch?v=XNBrCEgzddw

2 அட்டவணையில் வரிசைகள் மற்றும் 

நெடுவரிசைகளைச் செருகுதல் மற்றும் 

நீக்குதல்

https://www.youtube.com/

watch?v=Ctey7JNeoGg

https://www.youtube.com/

watch?v=LS7WtlXsM5Q

3 ஒரு அட்டவணையைப் பிரித்தல் மற்றும் 

ஒன்றிணைத்தல்

https://www.youtube.com/

watch?v=mWY03aAZ4vM

எளிய மதிப்பீடுகள்:

மாணவர் 

செயல்பாடு

1. � மாணவர்கள் வகுப்பு அட்டவணை மற்றும் ஒரு மாத காலெண்டரை 

உருவாக்க வேண்டும்.

2. � மாணவர்கள் பாடத்திற்கான உள்ளடக்க அட்டவணையை தயார் 

செய்ய வேண்டும்

3. � மாணவர்கள் தினசரி செலவுக்கு ஒரு அட்டவணையை தயார் 

செய்ய வேண்டும்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1. � விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் த�ொழில்நுட்ப வல்லுநரை 

அழைக்கவும்.

2. � விருந்தினர் விரிவுரைக்கு கணினி த�ொழில்நுட்ப வல்லுநரை 

அழைக்கவும்.

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் அலுவலக உதவியாளரை 

அழைக்கவும்.

த�ொழில் சார்ந்த 

/ கள ஆய்வு 

பரிந்துரைகள்

1. � களம் பள்ளிக்கு அருகில் உள்ள அலுவலகத்திற்கு கள ஆய்வு 

மேற்கொள்ளுதல்

2.  களப் ஆய்வுக்காக அருகிலுள்ள வங்கிகளைப் பார்வையிடவும்.

3.  அருகிலுள்ள தணிக்கை அலுவலகத்தை பார்வையிடவும்.
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	10.7	� ஆவணத்தை முடித்த பிறகு அச்சிடுவதற்கான வழிமுறைகள்

ந�ோக்கம்:

MS Word மூலம் கடிதம் அல்லது ஆவணத்தை அச்சிடுதல்

செயல்பாடுகள்

1.	 அச்சிடுவதற்கு முன்பான ஆவணத்தை பார்வையிடல்.
2.	 MS வேர்ட் -ல் அச்சிடுதல் மற்றும் பிற தேர்வுகளை பதிப்பித்தல்.
3.	 MS word இல் ஆவணத்தை அச்சிடுதல்
4.	 கடிதங்கள் மற்றும் ஆவணங்களை Mail merge ஐ பயன்படுத்தி MS வேர்ட்டில் இணைத்தல்

பாதுகாப்பு முன்னெச்சரிக்கை :

1.	 அதிர்வு மற்றும் அதிர்ச்சிகள் இல்லாத மேசை ப�ோன்ற தட்டையான, நிலையான மேற்பரப்பில் 
உங்கள் பிரிண்டரை வைக்கவும்.

2.	 நன்கு காற்றோட்டமான அறையில் பிரிண்டரைப் பயன்படுத்தவும்.
3.	 அச்சுப்பொறியின் காற்றோட்டத் துளை அடைக்கப்பட்ட இடத்தில் அச்சுப்பொறியை வைக்க 

வேண்டாம்.

தேவையான கருவிகள் மற்றும் உபகரணங்கள் தேவை

வ. எண் கருவிகள் / உபகரணங்களின் பெயர் வரம்பு / மதிப்பு அளவு

1 கணினி அல்லது மடிக்கணினி 15 செயலி / 4 GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1

செயல்முறை:

பிரிவு 1. அச்சிடுவதற்கு முன்பாக ஆவணத்தை பார்வையிடல்

படி 1: அச்சிட வேண்டிய MS WORD ஆவணத்தை திறக்கவும்.

படி 2: File > Print என்பதைக் கிளிக் செய்யவும் அல்லது CTRL + P ஐ அழுத்தவும்.

ஆவணத்தை அச்சிடும் முன் பார்வையிடல்
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பிரிவு 2. MS வேர்ட் –ல் அச்சிடுதல் மற்றும பிற தேர்வுகளை பதிப்பித்தல்.

படி 1: அச்சிட வேண்டிய MS Word ஆவணத்தைத் திறக்கவும்.

படி 2: File > print என்பதைக் கிளிக் செய்யவும் அல்லது CTRL + P ஐ அழுத்தவும்.

படி 3: Printer option ஐ பயன்படுத்தி உங்கள் கணினி அல்லது மடிக்கணினியுடன் தற்போது 
இணைக்கப்பட்டுள்ள அச்சுப்பொறியை தேர்ந்தெடுக்கவும்.

படி 4: நகல்களின் எண்ணிக்கையை அதிகரிக்க, copies தேர்வின் மேல் மற்றும் கீழ் அம்புக்குறியைக் 
கிளிக் செய்யவும்.
படி 5: அனைத்து பக்கங்களையும் அச்சிட print all pages விருப்பத்தை கிளிக் செய்யவும், அல்லது 
print current page only அல்லது Custom print விருப்பங்களை தேர்வு செய்யவும்.
படி 6: Portrait அல்லது Landscape அச்சிடும் விருப்பத்தை கிளிக் செய்யவும்

படி 7: அச்சிட வேண்டிய காகிதத்தின் அளவைத் தேர்ந்தெடுக்கவும் 
படி 8: பக்கத்தில் அச்சிட வேண்டிய பகுதியின் ஓரங்களை தேர்வு செய்ய Normal Margin 
என்பதை கிளிக் செய்யவும்.
படி 9: ஒரு தாளுக்கு எத்தனை பக்கங்கள் என்பதை தேர்வு செய்ய 1 page per sheet என்பதை 
கிளிக் செய்யவும்.

அச்சிடும் முன் விருப்பத்தைத் திருத்துதல்

பிரிவு 3. ஆவணத்தை MS Word இல் அச்சிடுதல்

படி 1: File > Print > ok என்பதைக் கிளிக் செய்யவும் அல்லது CTRL + P என்பதைக் கிளிக் 
செய்யவும்.

Chapter_10.indd   178 4/28/2022   12:13:53 PM



179த�ொடர்புடைய கணினி பயன்பாடுகளைத் தணிக்கை செய்தல்

ஆவணத்தை அச்சிடுதல்

பிரிவு 4. MS Word - ல் மெயில் மெர்ஜைப் பயன்படுத்தி கடிதங்கள் மற்றும் ஆவணங்களை 

அச்சிடுதல்

படி 1-3: Mailing>start mail merge>step-by-step mail merge என்பதைக் கிளிக் செய்யவும்.

Mailmerge ஐ திறத்தல்

படி 4: ஆவண வகையைத் தேர்ந்தெடுக்கவும்.

படி 5: Next starting document என்பதைக் கிளிக் செய்யவும் .

ஆவணத்தைத் த�ொடங்குதல்
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படி 6: தற்போதைய ஆவணத்தைப் பயன்படுத்தவும் அல்லது ஏற்கனவே உள்ள ஆவணத்திலிருந்து 
த�ொடங்கவும் என்பதைத் தேர்ந்தெடுக்கவும் 

பெறுநரைத் தேர்ந்தெடுக்கவும்

படி 7 : Next > select recipients > type a new list அல்லது existing list தேர்ந்தெடுக்கவும். 

ஏற்கனவே உள்ள க�ோப்பை தேர்வு செய்தல்
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ஏற்கனவே உள்ள பட்டியலைத் தேர்ந்தெடுக்கவும்

படி 8: Browse>existing file கிளிக் செய்யவும். உங்களிடம் ஏற்கனவே முகவரிப் பட்டியல் 
இல்லையென்றால், Type a new list ப�ொத்தானைக் கிளிக் செய்து create என்பதைக் கிளிக் 
செய்யலாம் .

படி 9: Next என்பதைக் கிளிக் செய்யவும். உங்கள் கடிதத்தில் பெறுநரின் தகவலைச் சேர்க்க, 
பணிப் பலகத்தில் இருந்து முகவரித் த�ொகுதி, வாழ்த்து வரி, மின்னணு அஞ்சல் ப�ோன்ற பல 
உருப்படிகளைத் தேர்ந்தெடுக்கவும் .

கடிதம் எழுதுதல்
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பெறுநரின் தகவலைச் சேர்த்தல்

படி 10:  Next>preview your letters என்பதைக் கிளிக் செய்து அனைத்து பெறுநர்களின் 
கடிதங்களையும் பார்வையிடலாம்.

கடிதத்தை முன் பார்வையிடல்
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படி 11: Next>Finish & Merge என்பதைக் கிளிக் செய்யவும்.

Merge முடிவுருதல்

படி 12: Print>all>ok ப�ொத்தானைக் கிளிக் செய்யவும். 

Merge to printer உரையாடல் பெட்டி
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ஆவணத்தை அச்சிடுதல்

முடிவுரை:

ஒரு ஆவணம் வெற்றிகரமாக அச்சிடப்பட்டது.

காண�ொளி பரிந்துரைகள்

வ. எண் தலைப்பு / ந�ோக்கம் இணைப்பு

1 MS word இல் ஆவணத்தை அச்சிடுவதற்கு 

முன் பார்வையிடல்

https://youtu.be/OxudZfGR7lk

2 MS word இல் ஆவணத்தை அச்சிடுதல் 

மற்றும் பிற தேர்வுகளை கட்டுப்படுத்துதல்.

https://youtu.be/8PvKeny-_Fo

3 MS word – ல் Mail merge ஐ பயன்படுத்தி 

கடிதத்தையும் ஆவணத்தையும் அச்சிடுதல்.

https://youtu.be/-27Vj71-4xw

எளிய மதிப்பீடுகள்

மாணவர் 

செயல்பாடு

1. �வெ வ்வேறு அம்சங்களை க�ொண்ட பல்வேறு அச்சுப் ப�ொறிகளின் 

விலைப்பட்டியலைக் க�ொண்டு விலை விவரக்குறிப்புகளை 

தயாரிக்கவும்.

2. � பிரிண்டர் வேலை செய்யும் விதத்தை விளக்கப் படத்துடன் 

விளக்கவும்.

3.  ஆவணத்தின் மாதிரி பக்கங்களை அச்சிடவும்.
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விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1. � விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் த�ொழில்நுட்ப வல்லுநரை 

அழைக்கவும்.

2. � விருந்தினர் விரிவுரைக்கு கணினி த�ொழில்நுட்ப வல்லுநரை 

அழைக்கவும்.

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் அலுவலக உதவியாளரை 

அழைக்கவும்.

த�ொழில்சார்ந்த 

/ கள ஆய்வு 

பரிந்துரைகள்

1. � பள்ளிக்கு அருகில் உள்ள அலுவலகத்திற்கு கள ஆய்வு மேற் 

க�ொள்ளுதல்.

2. � கள ஆய்வுக்காக அருகிலுள்ள வங்கிகளைப் பார்வையிடலாம்.

3. � அருகிலுள்ள தணிக்கை அலுவலகத்திற்கு சென்று  

பார்வையிடலாம்.

	10.8	� MS Word ஆவணத்தில் ப�ொருத்தமான Template மற்றும் படத்தைத் 

தேர்ந்தெடுப்பதற்கான பயன்பாட்டு விருப்பங்கள்.

ந�ோக்கம்:

MS Word ஆவணத்தில் ப�ொருத்தமான Template மற்றும் படத்தைத் தேர்ந்தெடுப்பதில் ஒரு 
பயன்பாட்டு விருப்பங்களைப் பயன்படுத்துதல்.

செயல்பாடுகள்:

1.	 ஒரு ஆவணத்தில் பாணிகளைப் பயன்படுத்துதல்
2.	 ஆவணத்தில் படங்களைச் செருகுதல் மற்றும் பயன்படுத்துதல்
3.	 ஆவணத்தில் Template களை உருவாக்கி பயன்படுத்துதல்
4.	 ஒரு ஆவணத்திற்கான உள்ளடக்க அட்டவணையை உருவாக்குதல்

தேவையான கருவிகள் மற்றும் உபகரணங்கள்

வ. எண் கருவிகள்/உபகரணங்களின் பெயர் வரம்பு/மதிப்பு அளவு

1 கணினி அல்லது மடிக்கணினி 15 செயலி / 4 GB Ram 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1

பாதுகாப்பு நடவடிக்கைகள் :

1.	 உங்கள் ஆவணத்தை சீரான இடைவெளியில் சேமிக்கவும்.
2.	 உங்கள் word ஆவணத்தை மூடுவதற்கு முன், ஆவணத்தையும் அதன் க�ோப்பு இருப்பிடத்தையும் 

சேமிக்க வேண்டும் என்பதை நினைவில் க�ொள்ளவும்.
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செயல்முறை :

பிரிவு 1. ஆவணத்தில் பாணிகளை உருவாக்கி பயன்படுத்துதல் :

படி 1: MS Office Word ஆவணத்தைத் திறக்கவும்.

படி 2: எழுத்துருக்களை மாற்றியமைக்கும் விருப்பங்களுக்கு Home>Font என்பதைக் கிளிக் 
செய்யவும்.

படி 3: பத்தி வடிவமைப்பிற்கு Home>paragraph என்பதைக் கிளிக் செய்யவும்.

படி 4: தலைப்பு பாணிகளுக்கு Home > Styles என்பதைக் கிளிக் செய்யவும் .

ஆவணத்தில் பாணிகளை உருவாக்கி பயன்படுத்துதல்

பிரிவு 2. ஆவணத்தில் படங்களைச் செருகுதல் மற்றும் பயன்படுத்துதல்

படி 1: Insert > pictures என்பதைக் கிளிக் செய்து, அதிலிருந்து படங்களைத் தேர்ந்தெடுக்கவும்.

ஆவணத்தில் படங்களைச் செருகுதல் மற்றும் பயன்படுத்துதல்
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படி 2: படத்தைத் தேர்ந்தெடுக்கவும் அல்லது கிளிக் செய்யவும், மேல் வலது மூலையில் உள்ள 
Format ஐ தேர்வு செய்து, தேர்ந்தெடுக்க வேண்டிய பயன்முறையைத் தேர்ந்தெடுக்கவும்.

ஆவணத்தில் உள்ள படங்களை வடிவமைத்தல் மற்றும் அளவை மாற்றுதல்

படி 3: அந்த இடத்தில் உள்ள படங்களின் அளவை உள்ளிட்டு Enter ஐ அழுத்தவும்.

பிரிவு 3. Template உருவாக்கி பயன்படுத்துதல்

படி 1: ஒரு word ஆவணத்தில் Template க�ோப்பைத் தயாரிக்கவும்.

படி 2: Home>Save as கிளிக் செய்து க�ோப்பு பெயரை உள்ளிடவும், Word Template(.dotx) 
என க�ோப்பு வகையைத் தேர்ந்தெடுத்து Enter ஐ அழுத்தவும் அல்லது save என்பதைக் கிளிக் 
செய்யவும் .

படி 3: புதிய ஆவணக் க�ோப்பை மூடவும் அல்லது திறக்கவும்.

படி 4:  Fi le>Open>Personal என்பதைக்  கிளிக்  செய்து  உங்கள்  Template க�ோப்பைத் 
தேர்ந்தெடுக்கவும்.

பிரிவு 4. உள்ளடக்க அட்டவணையை உருவாக்கவும்

படி 1: Word ஆவணத்தைத் திறக்கவும்.

படி 2: உள்ளடக்க அட்டவணையில் நீங்கள் விரும்பும் தலைப்பைத் தேர்ந்தெடுக்கவும்.

படி 3: எண்ணை உள்ளிட்டு பாணிகளைத் தேர்ந்தெடுக்கவும்.

படி 4: முழு ஆவணத்திற்கும் படி 2 & 3 ஐப் பின்பற்றவும். References > Table of contents ஐ 
கிளிக் செய்து, தானியங்கு முறையில் உள்ளடக்க வகையைத் தேர்ந்தெடுக்கவும்.
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அட்டவணை உள்ளடக்கத்தை உருவாக்குதல்

முடிவுரை :

பல்வேறு விருப்பங்களைப் பயன்படுத்தி ஒரு ஆவணத்தில் பல்வேறு பாணிகளைப் பயன்படுத்துதல், 
படங்களில் உள்ள விருப்பங்களைச் செருகுதல் மற்றும் திருத்துதல், Template உருவாக்குதல் 
மற்றும்  பயன்படுத்துதல்  மற்றும்  உள்ளடக்க  அட்டவணையை  உருவாக்குதல்  ஆகியவை 
வெற்றிகரமாக முடிக்கப்படுகின்றன.

எளிய மதிப்பீடுகள்:

1.	 ஆவணத்தை சேமிக்க எந்த கட்டளை பயன்படுத்தப்படுகிறது?
2.	 Template ஐ எப்படி உருவாக்குவாய் அல்லது மாற்றுவாய்?
3.	 ஒரு ஆவணத்தில் ஒரு படத்தின் அளவை எவ்வாறு மாற்றுவாய்?

காண�ொளி பரிந்துரைகள் :

வ. எண் தலைப்பு/ந�ோக்கம் இணைப்பு

1 ஆவணத்தில் புதிய பாணிகளை 

உருவாக்கி புதுப்பித்தல்.

https://youtu.be/Gk5M32aqsjUhttps://

youtu.be/Gk5M32aqsjU

2 ஆவணத்தில் படங்களைச் செருகிதல் 

மற்றும் மாற்றுதல்.

https://youtu.be/Lgd2QR0ltic

3 ஆவணத்தில் Template களை 

உருவாக்கி பயன்படுத்துதல்.

https://youtu.be/qs2HzP9Q9eg

4 ஒரு ஆவணத்திற்கான உள்ளடக்க 

அட்டவணையை உருவாக்கி 

உருவாக்குதல் .

https://youtu.be/0cN-JX6HP7c
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மாணவர் 

செயல்பாடு

1. � மாணவரின் அடையாள அட்டைக்கான Template உருவாக்கவும் .

2. � பக்க எண்ணுடன் பத்திக்கும் உள்ளடக்கத்தின் தலைப்பை 

உருவாக்கவும்.

3.  உங்கள் கணினியில் புதிய பாணியை உருவாக்கி புதுப்பிக்கவும்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1. � விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் த�ொழில்நுட்ப வல்லுநரை 

அழைக்கவும்.

2.  விருந்தினர் விரிவுரைக்கு கணினி பாட நிபுணரை அழைக்கவும் .

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் அலுவலக உதவியாளரை 

அழைக்கவும்.

த�ொழில் 

சார்ந்த / கள 

பரிந்துரைகள்

1. � பள்ளிக்கு அருகிலுள்ள அலுவலகத்திற்கு ஒரு கள ஆய்வு மேற் 

க�ொள்ளவும்.

2. � கள ஆய்வுக்காக அருகிலுள்ள இ-சேவா மையத்திற்குச் செல்லவும்.

3.  அருகிலுள்ள கணினி மையத்திற்கு கள ஆய்வு மேற்கொள்ளவும்.

	10.9	� MS Word ஐப் பயன்படுத்தி வகுப்பறைக்குத் தேவையான ப�ொருட்களின் 

க�ொள்முதல் பட்டியலை உருவாக்குதல்

ந�ோக்கம் :

தேவையான க�ொள்முதல் பட்டியலை உருவாக்கும் முறையை கற்றல்.

செயல்பாடுகள்

1.	 Word ஆவணத்தை உருவாக்குதல்

2.	 அட்டவணைகளைச் செருகி மற்றும் க�ொள்முதல் பட்டியலின் தரவை உள்ளிடுதல்

3.	 ஆவணத்தை அச்சிடுதல்

தேவையான கருவிகள் மற்றும் உபகரணங்கள்:

வ. எண் கருவிகள்/உபகரணங்களின் பெயர் வரம்பு / மதிப்பு அளவு

1 கணினி அல்லது மடிக்கணினி 15 செயலி / 4GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1

3 அச்சுப்பொறி Epson L3250 1

செயல்முறை :

பிரிவு 1. ஒரு Word ஆவணத்தை உருவாக்குதல்:

படி 1: File பட்டியை பயன்படுத்தி புதிய ஆவணத்தை உருவாக்கவும்.

படி 2: New விருப்பத்தை கிளிக் செய்து ஆவண வடிவமாக சேமிக்கவும்.

படி 3: ஆவணத்தின் பெயரை மாற்றவும்.
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புதிய Word ஆவணத்தை உருவாக்கவும்

பிரிவு 2. அட்டவணைகளைச் செருகி மற்றும் க�ொள்முதல் பட்டியலின் தரவை உள்ளிடுதல்:

படி 1: Insert தத்தலைத் தேர்ந்தெடுக்கவும்.

படி 2: அட்டவணை தேர்வை பயன்படுத்தி அட்டவணைகளைச் செருகவும்.

படி 3: உங்கள் வகுப்பறைக்கான க�ொள்முதல் பட்டியலில் தரவை உள்ளிடவும்.

அட்டவணைகளைச் செருகி மற்றும் க�ொள்முதல் பட்டியலின் தரவை உள்ளிடவும்

பிரிவு 3. ஆவணத்தை அச்சிடுதல் :

படி 1: அச்சிட வேண்டிய MS Word ஆவணத்தைத் திறக்கவும்

படி 2: File > print ஐ கிளிக் செய்யவும் அல்லது CTRL + P ஐக் கிளிக் செய்யவும்

படி 3: ஆவணத்தை அச்சிட print ஐ கிளிக் செய்யவும்.
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ஆவணத்தை அச்சிடுதல்

முடிவுரை:

இதனால் மாணவர்கள் தெளிவாக க�ொள்முதல் பட்டியலை உருவாக்க முடியும்.

காண�ொளி பரிந்துரைகள்:

வ. எண் தலைப்பு / ந�ோக்கம் இணைப்பு

1 MS word ஐப் பயன்படுத்தி வகுப்பறைக்குத் 

தேவையான ப�ொருட்களின் க�ொள்முதல் 

பட்டியலை உருவாக்குதல்

https://youtu.be/lyx8Anp9d4-

2 அட்டவணைகளைச் செருகி மற்றும் 

க�ொள்முதல் பட்டியலின் தரவை உள்ளிடவும்

https://youtu.be/zKkWZgIaRrQ

3 ஆவணத்தை அச்சிடுதல் https://youtu.be/cweN_MQlTQE

எளிய மதிப்பீடுகள்:

மாணவர் 

செயல்பாடு

1. � மாணவர்கள் வகுப்பறைப் ப�ொருட்களுக்கான சரிபார்ப்புப் 

பட்டியலைத் தயாரிக்க வேண்டும்.

2. � வகுப்பில் உள்ள மாணவர்களின் பட்டியலை மாணவர்கள் 

தயார் செய்ய வேண்டும்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1. � விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் த�ொழில்நுட்ப வல்லுநரை 

அழைக்கவும் .

2. � விருந்தினர் விரிவுரைக்கு கணினி த�ொழில்நுட்ப வல்லுநரை 

அழைக்கவும்.

3. � MS ஆபிஸ் தளத்தில் மேடையில் பணிபுரியும் அலுவலக 

உதவியாளரை அழைக்கவும்.

த�ொழில் சார்ந்த 

/ கள ஆய்வு 

பரிந்துரைகள்

1. � பள்ளிக்கு அருகில் உள்ள அலுவலகத்திற்கு, கள ஆய்வு 

மேற்கொள்ளுதல்.

2.  களப்பயணங்களுக்கு அருகிலுள்ள கடைகளுக்குச் செல்லவும் .
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எக்செல் அடிப்படைகள் :

1. அறிமுகம் :

MS-EXCEL என்பது மைக்ரோசாஃப்ட் அலுவலக த�ொகுப்பு மென்பொருளின் ஒரு பகுதியாகும். 
இது பல வரிசைகள் மற்றும் நெடுவரிசைகளைக் க�ொண்ட ஒரு மின்னணு விரிதாள் ஆகும், இது 
தரவை ஒழுங்கமைக்கவும், வரைபடமாக தரவுகளை பிரதிநிதித்துவப்படுத்தவும் மற்றும் வெவ்வேறு 
கணக்கீடுகளை செய்யவும் பயன்படுகிறது.

	 இது 1048576 வரிசைகள் மற்றும் 16383 நெடுவரிசைகளைக் க�ொண்டுள்ளது. ஒரு 
வரிசையும் ஒரு நெடுவரிசையும் சேர்ந்து ஒரு கலத்தை உருவாக்குகின்றன. ஒவ்வொரு கலத்திற்கும் 
நெடுவரிசையின் பெயர் மற்றும் வரிசை எண்ணால் வரையறுக்கப்பட்ட முகவரி உள்ளது.

	 எ.கா: A1, B2 - வரிசை எண், நெடுவரிசை பெயர், இயல்பாக, ஒரு பணிப்புத்தகம் 3 
விரிதாள்களைக் க�ொண்டுள்ளது (தாள் 1, தாள் 2 & 3))

2. MS Excel இன் அம்சங்கள் :

1.	 பெரிய அளவிலான தரவைச் சேமிப்பது மற்றும் பகுப்பாய்வு செய்வது எளிது.
2.	 தரவுகளை எளிதாக மீட்டெடுக்கலாம்.
3.	 கணித வாய்ப்பாடுகளின் பயன்பாடு
4.	 பணிப்புத்தகத்தில் சேமிக்கப்பட்ட தரவுகளின் நேர்த்தியான மற்றும் தெளிவான தெரிவுநிலை
5.	 விரித்தாள் எக்செல் பிரிக்கவும், கையாளவும், கடவுச்சொல் பாதுகாப்பு அம்சங்களைப் 

பயன்படுத்தி விரித்தாள் தயாரிப்புக்கு உதவவும் பயன்படுகிறது.

	10.10	� ஒரு எக்செல் க�ோப்பை உருவாக்கி அதன் பல்வேறு விருப்பங்களைப் 

பயன்படுத்துதல் :

ந�ோக்கம் :

எக்செல் க�ோப்பை உருவாக்கி மற்றும் அதன் பல்வேறு விருப்பங்களைப் பயன்படுத்தி MS Excel  
ஆவணத்தை உருவாக்குதல்.

செயல்பாடுகள் / பயிற்சிகள் :

1.	 வரிசை எண் மற்றும் நெடுவரிசைகளின் தலைப்பு நுண்ணறை முகவரியைக் கண்டறிதல்.
2.	 வரிசை பரப்பு, நெடுவரிசை பரப்பு, நுண்ணறைகளின் பரப்பு ஆகியவற்றைக் கண்டறியதல்.
3.	 ஒரு நுண்ணறையில் உரை, எண் தரவுகளை உள்ளிடுவதை விளக்குதல்
4.	 கணித செயற்குறிகளை பயன்படுத்தி வாய்பாடுகளை உருவாக்குதல்.
5.	 தரவுகளில் கணக்கீடுகளைச் செய்ய அடிப்படை செயற்கூறுகளைப் பயன்படுத்துதல்.

தேவையான கருவிகள் மற்றும் உபகரணங்கள்:

வ. எண் கருவிகள் / உபகரணங்களின் பெயர் வரம்பு / மதிப்பு அளவு

1 கணினி அல்லது மடிக்கணினி 15 செயலி / 4GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1
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குறுக்கு வழிசாவிகள் :

வ.எண் செயல்கள் குறு வழி சாவி சேர்மானம்

1 ஒரு அட்டவணைத் தாளைமூடுதல் Ctrl + W

2 அட்டவணைத் தாளை திறத்தல் Ctrl + O

3 Home தத்தலுக்குச் செல்லுதல் Alt + H

4 அட்டவணைத் தாளைச் சேமித்தல் Ctrl + S

5 நகல் எடுத்தல் Ctrl + C

6 நகல் எடுத்ததை ஒட்டுதல் Ctrl + V

7 சமீபத்திய செயலைச் தவிர்த்தல் Ctrl + Z

8 நுண்ணறை உள்ளடக்கங்களை நீக்குதல் Delete

9 நிரப்பு நிறத்தைத் தேர்ந்தெடுத்தல் Alt + H, H

10 தேர்வை வெட்டுதல் Ctrl + X

11 Insert தத்தலுக்குச் செல்லுதல் Alt + N

12 தடிமனான வடிவமைப்பைப் 

பயன்படுத்துதல்

Ctrl + B

13 நுண்ணறை உள்ளடக்கங்களை 

மையமாக சீரமைத்தல்

Alt + H, A, C

14 Page Layout தத்தலுக்குச் செல்லுதல். Alt + P

15 Data தத்தலுக்குச் செல்லுதல். Alt + A

16 View தத்தலுக்குச் செல்லுதல். Alt + W

17 சூழல் மெனுவைத் திறத்தல் Shift + F10 அல்லது Windows சாவி

18 எல்லைகளைச் சேர்த்தல் Alt + H, B

19 நெடுவரிசையை நீக்குதல் Alt + H, D, C

20 வாய்ப்பாடு தத்தலுக்குச் செல்லுதல். Alt + M

21 தேர்ந்தெடுக்கப்பட்ட வரிசைகளை 

மறைத்தல்

Ctrl + 9

22 தேர்ந்தெடுக்கப்பட்ட நெடுவரிசைகளை 

மறைத்தல்.

Ctrl + 0 

செயல்முறை :

பிரிவு 1.வரிசை எண் மற்றும் நெடுவரிசை தலைப்பு, நுண்ணறை முகவரி ஆகியவற்றைக் கண்டறிதல்.               
MS எக்செல் MS எக்செல் அட்டவணை வரிசை எண் மற்றும் நெடுவரிசை தலைப்பு, நுண்ணறை 
முகவரி ஆகியவற்றைக் கண்டறியவும் .

 MS எக்செல் பல தாள்களை க�ொண்டுள்ளது. ஒவ்வொரு தாளும் தனிதனியான பல வரிசைகளையும், 
நெடுவரிசைகளையும் க�ொண்டது. இயல்பாக தாளில் தாள் 1, தாள் 2 மற்றும் தாள் 3 என காட்டப்படும். 
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வரிசைகள் மற்றும் நெடுவரிசைகள் : 

வரிசைகள் 1, 2, 3, 4, ... மற்றும் நெடுவரிசைகள் A, B, C, D, ...., Z, AA, AB, AC, ...., AZ, 
BA முதல் BZ, CA,... என வரிசைபடுத்தப்பட்டுள்ளன. .,

நுண்ணறை மற்றும் நுண்ணறை முகவரி : 

வரிசை மற்றும் நெடுவரிசை இணையும் இடத்தில் உள்ள பெட்டி நுண்ணறை என்று அழைக்கப்படுகிறது. 
ஒரு நுண்ணறை முகவரி அதன் நெடுவரிசை (தலைப்பு) மற்றும் வரிசை எண்ணால் குறிக்கப்படுகிறது. 
உதாரணமாக, D4, E9, Z89.

செயற்படு நுண்ணறை : 

செருகும் புள்ளியை ஒரு நுண்ணறையில் நிலைநிறுத்தும்போது, அது தேர்ந்தெடுக்கப்பட்டு, 
பயனரிடமிருந்து  தரவை  எடுக்கத்  தயாராக  இருக்கும் .  இந்த  தேர்ந்தெடுக்கப்பட்ட  மற்றும் 
செயல்படுத்தப்பட்ட நுண்ணறை செயற்படு நுண்ணறை என்று அழைக்கப்படுகிறது. தடிமனான 
க�ோடுகளை இது எப்போதும் சிறப்பம்சமாக க�ொண்டு இருக்கும். செயற்படு நுண்ணறையின் 
முகவரி பெயர் பெட்டியில் காட்டப்படும்.

பிரிவு 2. வரிசை பரப்பு, நெடுவரிசை பரப்பு, வரிசை & நெடுவரிசை பரப்பு ஆகியவற்றை 

அடையாளம் காணுதல்.

சாவி அல்லது சாவி சேர்மானம் பயன்பாடுகள்

அம்புக்குறி சாவிகள் (←↑→↓) ஒரு நுண்ணறையை அம்புக்குறி திசையில் 

நகர்த்தும்

Ctrl + அம்புக்குறி சாவிகள் ஒரு குறிப்பிட்ட திரையில் தரவு பரப்பின் இறுதிக்கு 

நுண்ணறையை நகர்த்தும்

Home செயற்படு நுண்ணறை உள்ள வரிசையின் முதல் 

நுண்ணறைக்கு (நெடுவரிசை A) செல்லும்.

Ctrl + Home A1 நுண்ணறைக்கு செல்லும்

Ctrl + End தரவு பரப்பின் கீழ் வலது இறுதி நுண்ணறைக்கு 

செல்லும்

Page Up அட்டவணை தாளை ஒரு திரை மேலே நகர்த்தும்

Page Down  அட்டவணை தாளை ஒரு திரை கீழே நகர்த்தும்

நெடுவரிசை வரம்பு என்பது நெடுவரிசை முழுவதும் பரவியிருக்கும் கலங்களின் எண்ணிக்கை. 
செல் முகவரி ஒற்றை நெடுவரிசை கடிதம் மற்றும் ஒரு வரிசையில் பல வரிசை எண்களால் 
குறிக்கப்படுகிறது. இந்த எடுத்துக்காட்டில் C நெடுவரிசை எழுத்து 2 முதல் 7 வரை மாறுபடும் 
வரிசைகளுடன் நிலையானது. கலங்களின் வரம்பு C2 இல் த�ொடங்கி C7 இல் முடிவடைகிறது. 
இந்த கலங்களின் வரம்பு C2, C3, C4, C5, C6 மற்றும் C7 ஆகிய செல்களைக் க�ொண்டுள்ளது. 
கலங்களின் வரம்பு C2 இல் த�ொடங்கி C7 இல் முடிவடைகிறது மற்றும் இது C2:C7 ஆல் 
குறிப்பிடப்படுகிறது. வரிசை வரம்பு என்பது வரிசை முழுவதும் பரவியிருக்கும் கலங்களின் 
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எண்ணிக்கை. செல் முகவரியானது B முதல் D வரையிலான நெடுவரிசைகள் வரை மாறுபடும் 
நெடுவரிசைகளுடன் ஒற்றை வரிசை எண்ணால் குறிப்பிடப்படுகிறது. கலங்களின் வரம்பு B3 இல் 
த�ொடங்கி D3 இல் முடிவடைகிறது. இந்த கலங்களின் வரம்பு B3, C3, D3 எனப்படும் செல்களைக் 
க�ொண்டுள்ளது, மேலும் இது B3:D3 ஆல் குறிக்கப்படுகிறது வரிசை மற்றும் நெடுவரிசை வரம்பு 
என்பது வரிசை மற்றும் நெடுவரிசைகளில் பரவியிருக்கும் கலங்களின் எண்ணிக்கையாகும். 
இந்த வரம்பு வரிசைகளின் எண்ணிக்கை மற்றும் நெடுவரிசைகளின் எண்ணிக்கையுடன் கூடிய 
அணி. இந்த எடுத்துக்காட்டில், வரம்பு செல் B2 இல் த�ொடங்கி செல் C7 இல் முடிவடைகிறது. 
இந்த செல்கள் வரம்பில் B2 முதல் B7 வரையிலான செல்கள் மற்றும் C2 முதல் C7 வரையிலான 
செல்கள் உள்ளன. வரம்பு B2:C7 ஆல் குறிக்கப்படுகிறது.

குறிப்பு: ஒரு பணித்தாளில் ஒன்றுக்கும் மேற்பட்ட 'செல்களின் வரம்பைத்'தேர்ந்தெடுக்க கட்டுப்பாட்டு 
விசை பயன்படுத்தப்படுகிறது. கட்டுப்பாட்டு விசை விசைப்பலகையில் 'Ctrl' எனக் குறிக்கப்பட்டுள்ளது.

பிரிவு 3. ஒரு நுண்ணறையில் உரை, எண் தரவுகளை உள்ளிடுவதை விளக்குதல்.

உள்ளிடப்படும் தரவானது லேபிலாகவ�ோ, மதிப்புகளாகவ�ோ அல்லது வாய்பாடுகளாகவ�ோ 
இருக்கலாம்.

(1)	 லேபிள்: லேபிள் என்பது விசைப்பலகையைப் பயன்படுத்தி உள்ளிடப்படும் எந்த உரையும் 
ஆகும். இது எழுத்துக்கள், எண்கள் மற்றும் சிறப்பு குறியீடுகளுடன் இணைக்கப்படலாம்.

	 New sheet > select cell > Enter the label கிளிக் செய்யவும். 
(2)	 மதிப்புகள்: எண்களை மட்டுமே க�ொண்ட எண் தரவு மதிப்புகள் எனப்படும். க�ொடாநிலையாக 

மதிப்புகள் வலது இசைவில் இருக்கும். முழு எண், தசம ப�ோன்ற பல்வேறு வகையான 
மதிப்புகள் உள்ளன.

	 New sheet > select cell > Enter the value கிளிக் செய்யவும்.
(3)	  வாய்ப்பாடுகள்: '=' சம குறியுடன் த�ொடங்கும் எந்த கணக்கீடு வாய்பாடாக கருதப்படுகிறது. 

கணக்கீட்டில் '=' த�ொடர்ந்து வரும் மதிப்புகள், நுண்ணறை முகவரிகள், செயற்கூறுகள் 
ஆகியவை வாய்ப்பாடுகள் எனப்படும். '= அட்டவணைத்தாளில் ஒரு நுண்ணறையில் 
வாய்ப்பாட்டை உள்ளிடும்போது, அதன் மதிப்பு நுண்ணறையில் காட்டப்படும் மற்றும் 
வாய்பாட்டு, வாய்பாட்டுப் பட்டியில் காட்டப்படும்.

(4)	 New sheet > select cell > set the formula கிளிக் செய்யவும்.

பிரிவு 4. கணித செயற்குறிகளைப் பயன்படுத்தி வாய்ப்பாடுகளை உருவாக்குதல்.

MS Excel மென்பொருள் சூத்திரங்களைப் பயன்படுத்தி எண்ணியல் தரவைக் கணக்கிடுவதற்கு 
மிகவும் சக்திவாய்ந்த அம்சங்களைக் க�ொண்டுள்ளது. கணக்கீட்டிற்கு நாம் கால்குலேட்டரைப் 
ப யன்ப   டு த் து வ த ா ல் ,  எ க்செ   ல்  த ா ள்  சே  ர ்க்க  ,  க ழி த ்த ல் ,  வ கு த ்த ல் ,  பெ  ரு க்க   ம ற் று ம்  
பலவற்றைச் செய்யலாம். MS Office ஆனது, கூட்டல்(+), கழித்தல்(-), பெருக்கல் (*), எண்கணிதச் 
ச ெ யல்பாட்     டி ற்கா   ன  ஒ ரு  பி ரி வு  ( / )  ப �ோன   ்ற  சூ த் தி ர ங ்க ளு க் கு  நி ல ை ய ா ன  
ஆப்ரேட்டர்களைப் பயன்படுத்துகிறது. குறிப்பு: அடைப்புக்குறிகளைப் பயன்படுத்தி மதிப்பீட்டின் 
வரிசையை  மாற்றலாம் .  (அடைப்புக்குறிக்குள்  உள்ள  வெளிப்பாடுகள்  முதலில்  மதிப்பீடு 
செய்யப்படுகின்றன)
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குறியீடுகள் செயல்பாடுகள்

+ கூட்டல்

- கழித்தல்

× பெருக்கல்

÷ வகுத்தல்

^ அடுக்கு

செயற்குறி வாய்ப்பாடு மதிப்பு

கூட்டல் (+)  7 +23 30

கழித்தல் (-) 3 - 0 - 3

பெருக்கல் (×)  6 × 9 54

வகுத்தல் (÷) 7 ÷ 77 11

பிரிவு 5. தரவுகளில் கணக்கீடுகளைச் செய்ய அடிப்படை செயற்கூறுகளைப் பயன்படுத்துதல்.

படி 1: பெருக்கல்

MS Excel மென்பொருள் சூத்திரங்களைப் பயன்படுத்தி எண்ணியல் தரவைக் நாம் கணக்கிடுவதற்கு 
மிகவும் சக்திவாய்ந்த அம்சங்கள் உள்ளன. கணக்கீட்டிற்கு நாம் கால்குலேட்டரைப் பயன்படுத்துவதால், 
எக்செல்  தாள்  சேர்க்க ,  கழித்தல் ,  வகுத்தல் ,  பெருக்க  மற்றும்  பலவற்றைச்  செய்யலாம் . 
LibreOfficeCalc ஆனது, கூட்டல்(+), கழித்தல்(-), பெருக்கல் (*), எண்கணிதச் செயல்பாட்டிற்கான 
ஒரு பிரிவு (/) ப�ோன்ற சூத்திரங்களுக்கு நிலையான ஆப்ரேட்டர்களைப் பயன்படுத்துகிறது. 
குறிப்பு: அடைப்புக்குறிகளைப் பயன்படுத்தி மதிப்பீட்டின் வரிசையை மாற்றலாம். (அடைப்புக்குறிக்குள் 
உள்ள வெளிப்பாடுகள் முதலில் மதிப்பீடு செய்யப்படுகின்றன)

தரவுகளில் கணக்கீடுகளைச் செய்வதற்கான அடிப்படை செயல்பாடுகள்

படி 2 : ஸ்டேஷனரி பில்லின் எடுத்துக்காட்டில், பில் த�ொகையைப் பெற அனைத்து ப�ொருட்களின் 
ம�ொத்த செலவைக் கணக்கிட, ஒவ்வொரு ப�ொருளின் அளவையும் சேர்க்க வேண்டும். சூத்திரத்தைப் 
பயன்படுத்தி ஒவ்வொரு கலத்தையும் சேர்க்கலாம். செல் D8 இல் கர்சரை வைத்து, ‘= D2 + 
D3 + D4 + D5 + D6 + D6 + D7’ ஃபார்முலாவை உள்ளிட்டு, செல் D8 இல் ம�ொத்தத்தைப் 
பெறவும். ஆனால் நூற்றுக்கணக்கான உருப்படிகள் இருந்தால், மேலும் பிழை ஏற்பட வாய்ப்புகள் 
இருந்தால் இது நடைமுறையில் சாத்தியமாகாது. ஒரு பெரிய அளவிலான தரவு இருக்கும்போது, 
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செல் முகவரிகளை மட்டுமே பயன்படுத்தி சூத்திரத்தை எழுதுவது கடினமான மற்றும் சிக்கலான 
பணியாக மாறும். இத்தகைய சூழ்நிலைகளில், Ms Office Calc ஆனது பில்ட் இன் செயல்பாடுகளை 
வழங்குகிறது .  SUM என்பது  கலங்களின்  வரம்பின்  கூட்டுத்தொகையைப்  பெறுவதற்கான 
செயல்பாடாகும். எனவே அனைத்து ப�ொருட்களின் ம�ொத்த விலையைப் பெற, D8 கலத்தில் 
உள்ள ‘Sum(D2:D7)’ செயல்பாட்டைப் பயன்படுத்தலாம். செயல்பாட்டில் நாம் செல் வரம்பை 
மட்டுமே சேர்க்க வேண்டும் (த�ொடக்க மற்றும் கடைசி செல் முகவரி).

எக்செல் தாளில் உள்ள எழுதுப�ொருளின் விலைப் பட்டியல்

 பின்வரும் முறைகளில், நுண்ணறை தரவை கூட்டுத் த�ொகை கணக்கிட எது மிகவும் ப�ொருத்தமானது 
என்று சிந்தியுங்கள்.

முறை 1: = SUM (D2:D7)
முறை 2: = D2 + D3 + D4 + D5 + D6 + D7
அட்டவணைத் தாளின் பயன்பாடுகள் வெவ்வேறு துறைகளின் தேவைகளைப் பூர்த்தி செய்ய 
வெவ்வேறு செயற்கூறுளைக் க�ொண்டுள்ளன.

அட்டவணைத் தாளின் பயன்பாடுகள் வெவ்வேறு துறைகளின் தேவைகளைப் பூர்த்தி 

செய்ய வெவ்வேறு செயற்கூறுளைக் க�ொண்டுள்ளன.

செயற்கூறு த�ொடரியல் பயன்பாடு

SUM = SUM (எண் 1, 

எண் 2….)

நுண்ணறைகளின் பரப்பில் உள்ள மதிப்புகளைக் 

கூட்டுகிறது.

AVERAGE = AVERAGE 

(எண் 1, எண் 2, ....)

நுண்ணறைகளின் பரப்பில் உள்ள மதிப்புகளின் 

சராசரியைக் கண்டறிய பயன்படுகிறது.

MAX = MAX (எண் 1, 

எண் 2, ......)

நுண்ணறைகளின் பரப்பில் உள்ள மிகப்பெரிய 

மதிப்பைக் கண்டறிய பயன்படுகிறது..

MIN = MIN (எண் 1, 

எண் 2, ......)

நுண்ணறைகளின் பரப்பில் உள்ள சிறிய மதிப்பைக் 

கண்டறிய பயன்படுகிறது.

COUNT = COUNT (எண் 1, 

எண் 2, .....)

நுண்ணறைகளின் பரப்பில் உள்ள நுண்ணறைகளின் 

எண்ணிக்கையைக் கணக்கிடுகிறது.
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படி 4: வாய்ப்பாட்டைப் பயன்படுத்தி 5 மாணவர்களுக்கான மாணவர்களின் மதிப்பெண் பட்டியலைக் 
கணக்கிடவும். மேலே உள்ள அனைத்து 5 செயற்க் கூறுகளையும் அதில்பயன்படுத்தவும்.

முடிவுரை:

இவ்வாறு தெளிவாக MS எக்செல் தாளை உருவாக்கி தரவை உள்ளிடுதல் மற்றும் பதிப்பித்தல் 
ஆகியவை வெற்றிகரமாக செய்து முடிக்கப்பட்டது.

காண�ொளி பரிந்துரைகள் :

வ. எண் தலைப்பு / ந�ோக்கம் இணைப்பு

1 MS எக்செல் தாளை உருவாக்குதல். https://youtu.be/NzwQ_

BbD2G4

2 MS எக்செல் தாளில் உரையை உள்ளிட்டு 

திருத்துதல்.

https://youtu.be/bK1YP_

y0SWE

3 MS எக்செல் க�ோப்பை உருவாக்கி அதன் 

பல்வேறு விருப்பங்களைப் பயன்படுத்துதல்.

https://youtu.be/NzwQ_

BbD2G4

எளிய மதிப்பீடுகள்:

மாணவர் 

செயல்பாடு

1. � மாணவர்கள் கணக்கீட்டிற்கான வாய்ப்பாடுகளைப் பயன்படுத்தி 

வணிக விலைபட்டியல்களைத் தயாரிக்க வேண்டும்.

2. � மாணவர்கள் செலவினங்களுக்கான மாத பட்ஜெட்டைத் 

தயாரிக்க வேண்டும்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1. � உங்கள் மதிப்பீட்டு மதிப்பெண்களின் தரவை உருவாக்கவும்.

2. �தரவை  உருவாக்கி உங்கள் வகுப்புத் தேர்வு முடிவின் 

சராசரியைக் கணக்கிடுங்கள்.

3. � புதிய பாணியை உருவாக்கி அதை உங்கள் கணினியில் 

புதுப்பிக்கவும்.

த�ொழில் சார்ந்த 

கள ஆய்வு 

பரிந்துரைகள்

1. � விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் த�ொழில் நுட்ப வல்லுநரை 

அழைக்கவும்.

2. � விருந்தினர் விரிவுரைக்கு கணக்கு தணிக்கையாளரை 

அழைக்கவும்.

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் அலுவலக உதவியாளரை 

அழைக்கவும்.
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	 10.11	� MS எக்செல் ஆவணத்தை வடிவமைப்பதற்கான வழிமுறைகள்

ந�ோக்கம் :

MS எக்செல் தாளில் உள்ள தரவுகளின் வடிவமைப்பைப் புரிந்து க�ொள்ளுதல்.

செயல்பாடுகள் :

1.	 கருவிப்பட்டியை வடிவமைத்தல்
2.	 தசம இலக்கத்துடன் நுண்ணறைகளின் பரப்பை வடிவமைத்தல்.
3.	 நுண்ணறைகளின் பரப்பை லேபிள்களாக வடிவமைத்தல்.
4.	 ஒரு நுண்ணறைகளின் பரப்பை ‘Scientific க்காக’ வடிவமைத்தல்.
5.	 நேரத்தைக் காண்பிக்க நுண்ணறைகளின் பரப்பை வடிவமைத்தல்.
6.	 நுண்ணறை தரவு பரப்பை சீரமைக்கவும்.
7.	 Fill கைப்பிடியைப் பயன்படுத்தி எண் த�ொடரை உருவாக்குதல்
8.	 Fill கைப்பிடியைப் பயன்படுத்தி வாய்ப்பாட்டை இழுத்து வாய்ப்பாட்டை நகலெடுக்கவும்.

தேவையான கருவிகள் மற்றும் உபகரணங்கள் :

வ. எண் கருவிகள் / உபகரணங்களின் பெயர் வரம்பு / மதிப்பு அளவு

1 கணினி அல்லது மடிக்கணினி 15 செயலி / 4GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1

செயல்முறை:

பிரிவு 1. கருவிப்பட்டியை வடிவமைத்தல் :

படி 1: எழுத்துரு விருப்பத்தை (Times New Roman) கிளிக் செய்வதன் மூலம் எழுத்துருவை 
மாற்றவும்.

படி 2: எழுத்துரு அளவு விருப்பத்தை (12 எழுத்துரு அளவு) கிளிக் செய்வதன் மூலம் எழுத்துருவின் 
அளவை மாற்றவும்.

படி 3: எழுத்துரு நிறத்தை (கருப்பு) மாற்றவும்.

படி 4: தடிமனான, சாய்வு அல்லது அடிக்கோடிடுதல் விருப்பத்தை (தேவைப்பட்டால்) கிளிக் 
செய்வதன் மூலம் தடிமனான, சாய்வு அல்லது அடிக்கோடிடவும் சீரமைப்பை மாற்றுவதற்கு 
சீரமைப்பு விருப்பத்தை ( இடது, வலது, நடு, மற்றும் ஓர ஒழுங்கு) தேர்ந்தெடுக்கவும். எல்லையை 
மாற்றி அமைப்பதற்கு எல்லை விருப்பத்தை தேர்வு செய்யவும். உரையை முன்னிலைப் படுத்துவதற்கு 
நிரப்பி ( முன்னிலை படுத்துதல் ) விருப்பத்தை தேர்வு செய்யவும்.
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பிரிவு 2. தசம இலகத்துடன் நுண்ணுறை பரப்பை வடிவமைத்தல் :

படி 1: தசம இடங்களின் எண்ணிக்கையைக் கட்டுப்படுத்த நுண்ணுறைகளைத் தேர்ந்தெடுக்கவும்.

படி 2: தேர்ந்தெடுக்கப்பட்ட  நுண்ணறைகளில்  வலது  கிளிக்  செய்து ,  திரையில்  த�ோன்றும் 
பட்டியிலிருந்து Format cells → from the right என்பதைத் தேர்ந்தெடுக்கவும்.

தசம இலகத்துடன் நுண்ணுறைகளின் பரப்பை வடிவமைக்கவும்

படி 3: Format Cells உரையாடல் பெட்டியில், Number தத்தலுக்குச் சென்று, வகைப் பெட்டியில் 
உள்ள number - ஐ முன்னிலைப்படுத்தி கிளிக் செய்து, பின்னர் தசம இடங்கள் பெட்டியில் 
எண்ணைத் தட்டச்சு செய்யவும்.

எடுத்துக்காட்டாக,  தேர்ந்தெடுக்கப்பட்ட நுண்ணுறைகளுக்கு 2 தசம இலக்கம் மட்டும் வர 
வேண்டுமாயின், Decimal places பெட்டியில் 2ஐ உள்ளிடவும்.

Format Cells – ன் வெவ்வேறு வகைகள்
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படி 4:  Format Cells உரையாடல் பெட்டியில் ok என்பதைக் கிளிக் செய்யவும். இப்போது 
நுண்ணுறைகளில் தேர்ந்தெடுக்கப்பட்ட தசமங்கள் இரண்டு தசம இடங்களுக்கு மாற்றப்பட்டுள்ளன.

Format Cells மூலம் மாற்றுதல்

பிரிவு 3. நுண்ணறைகளின் பரப்பை லேபிள்களுக்கு வடிவமைத்தல் :

•	 Format Cells உரையாடல்' பெட்டியைத் திறக்கவும்
•	 Number தத்தலைக் கிளிக் செய்யவும்
•	 உரையைத் தேர்ந்தெடுக்கவும்
•	 'ok' என்பதைக் கிளிக் செய்யவும்
•	 எண்களை உள்ளிடவும்

பிரிவு 4. நுண்ணறைகளின் பரப்பை ‘Scientific’ க்காக வடிவமைத்தல்.

படி 1: Scientific வடிவம் (ஸ்டாண்டர்ட் அல்லது ஸ்டாண்டர்ட் இன்டெக்ஸ் படிவம் என்றும் 
குறிப்பிடப்படுகிறது) என்பது மிகப் பெரிய அல்லது மிகச் சிறிய எண்களைக் காட்டுவதற்கான 
ஒரு வழியாகும்.

	 எடுத்துக்காட்டாக, 0.0000000043 என்று எழுதுவதற்குப் பதிலாக, 4.3 x 10-9 என்று 
எழுதலாம் மேலும் 0.0000000043 உள்ள நுண்ணறையில் எக்செல் Scientific குறியீட்டு 
வடிவமைப்பைப் பயன்படுத்தினால், அந்த எண் 4.2E-09 ஆகக் காட்டப்படும்.

படி 2: நுண்ணறைகளைத் தேர்ந்தெடுத்து வலது கிளிக் செய்யவும்.

படி 3: திரையில் வலது கிளிக் செய்து Format Cells த் தேர்ந்தெடுக்கவும்.

படி 4: Format Cells உரையாடல் பெட்டியில் Scientific தத்தல் சென்று தசம இலங்களைத் 
தேர்ந்தெடுக்கவும்.
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நுண்ணுறைகளின் பரப்பை ‘Scientific க்காக’ வடிவமைத்தல்

2 க�ொடாநிலையாக தசம இலக்கங்களுடன் எக்செல் Scientific குறியீட்டு வடிவமைப்பை 
விரைவாகப் பயன்படுத்த, விசைப்பலகையில் Ctrl + Shift + ^ ஐ அழுத்தவும்.

பிரிவு 5. நேரத்தைக் காண்பிக்க நுண்ணறையின் பரப்பை வடிவமைத்தல் :

படி 1: தேதி அல்லது நேரத்தைக் க�ொண்ட நுண்ணுறையைக் கிளிக் செய்து, CTRL + SHIFT 
+ # அல்லது CTRL + SHIF T + @ஐ கிளிக் செய்யவும்.

படி 2: நீங்கள் தேதி அல்லது நேரத்தைப் பயன்படுத்திய பிறகு, நுண்ணுறை ##### காட்டினால், 
நெடுவரிசையின் அகலத்தை விரிவுபடுத்தவும் அல்லது நெடுவரிசையின் வலது எல்லையை இருமுறை 
கிளிக் செய்யவும். எல்லையை  விரிவு படுத்துவதன் மூலம் தேவையான அளவை பெறலாம்.

படி 3: தேதி மற்றும் நேரத்தை திரும்ப க�ொண்டு வருவதற்கு வகை பட்டியலில் ப�ொதுவில் சென்று 
திருப்பி எடுக்கும் விருப்பத்தை தேர்ந்தெடுக்கவும். January 2010, ப�ோன்ற குறிப்பிட்ட தேதி 
அல்லது நேர வடிவமைப்பை உள்ளிட, வகை பட்டியலில் உள்ள Text தேர்ந்தெடுப்பதன் மூலம் 
அதை உரையாக வடிவமைக்கலாம்.

படி 4: உங்கள் பணித்தாளில் தற்போதைய தேதியை விரைவாக உள்ளிட, ஏதேனும் காலியான 
நுண்ணுறையைத் தேர்ந்தெடுத்து, பின்னர் CTRL+; அழுத்தவும்; (அரைப்புள்ளி), பின்னர் ENTER 
ஐ அழுத்தவும் நடப்பு தேதியை உள்ளீடு செய்வதற்கு தேதியை புதுப்பிக்க ஒவ்வொரு முறையும் 
வேலை தாளை மீண்டும் கணக்கிட சூத்திரம் = TODAY () என்பதை காலியான நுண்ணறையில் 
தட்டச்சு செய்து ” Enter” – ஐ கிளிக் செய்யவும். 

படி 5: Home தத்தலின் Number குழுவில், Numberக்கு அடுத்துள்ள Launcher உரையாடல் 
பெட்டியை துவக்கியைக் கிளிக் செய்யவும்.
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Number குழு

படி 6: Format Cells உரையாடல் பெட்டியைத் திறக்க CTRL + 1ஐ அழுத்தவும்.

வகை பட்டியல், தேதி அல்லது நேரத்தை கிளிக் செய்யவும்

படி 7: நீங்கள் பயன்படுத்த விரும்பும் தேதி அல்லது நேர வடிவமைப்பைக் கிளிக் செய்யவும்.

குறிப்பு : கட்டுப்பாட்டு  பேனலை பயன்படுத்தி குறிப்பிட்ட பிராந்திய தேதி மற்றும் நேரத்தை 
மாற்றுவதற்கு தேதி மற்றும் நேரம் ஆகியவற்றின் வடிவத்தின் ஆரம்பத்தில் நட்சத்திர குறியீடு 
இட வேண்டும்.  நட்சத்திர குறியீடு இல்லாமல் கட்டுப்பாட்டு  பேனலில் தேதி மற்றும் நேர 
வடிவத்தை மாற்ற இயலாது.

படி 8: Locale (Location) பெட்டியில் நீங்கள் விரும்பும் ம�ொழி அமைப்பைக் கிளிக் செய்யவும். 

 

ம�ொழி அமைப்பு மற்றும் Local (Location) பெட்டி

படி 9: ஒர்க் ஷீட்டில் உள்ள வடிவமைப்பு கலத்தை தேர்வு செய்து கணினி திரையில் த�ோன்றும் 
மாதிரி பெட்டகத்திலுள்ள எண் மாதிரியை தேர்ந்தெடுக்க வேண்டும்.
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வடிவமைப்பு கலத்தில் மாதிரி பெட்டி

பயனர் விரும்பும் தேதி அல்லது நேர வடிவமைப்பை உருவாக்குதல்:

படி 1: Number க்கு அடுத்துள்ள Launcher உரையாடல் பெட்டியை கிளிக் செய்யவும். 

Format Cells உரையாடல் பெட்டியைத் திறக்க CTRL+1ஐ அழுத்தவும்.

படி 2: தேதி அல்லது நேரத்தைக் கிளிக் செய்து, நீங்கள் உருவாக்க விரும்பும் வடிவமைப்பிற்கு 
மிக நெருக்கமான எண் வடிவமைப்பைத் தேர்வு செய்யவும்.

படி 3: Category Box”  - ல்  “Custom” – ஐ கிளிக் செய்யவும். படி 2 – ல் தேர்ந்தெடுத்த தேதி 
அல்லது நேர வடிவத்துடன் ப�ொருந்த கூடிய வடிவமைப்புக் குறியீட்டை பார்க்க வேண்டும். 
கட்டமைக்கப்பட்ட தேதி மற்றும் நேர வடிவ அமைப்பை மாற்றவ�ோ அல்லது நீக்கவ�ோ முடியாது. 
எனவே, அதை மேல் எழுதுவதை பற்றி கவலை பட வேண்டாம்..

காண்பிக்க இந்தக் குறியீட்டைப் பயன்படுத்தவும்

12-1 என மாதங்கள் m

12-01 என மாதங்கள் mm

ஜனவரி-டிசம்பர் ப�ோன்ற மாதங்கள் mmm

ஜனவரி-டிசம்பர் ப�ோன்ற மாதங்கள் mmmm

மாதத்தின் முதல் எழுத்தாக மாதங்கள் mmmmm

நாட்கள் 31–1 D

நாட்கள் 31–01 DD

சூரியன்-சனி ப�ோன்ற நாள் ddd

ஞாயிறு-சனி என நாள் dddd

ஆண்டுகள் 99–00 yy

9999–1900 என ஆண்டுகள் yyyy

"h" அல்லது  "hh" குறியீட்டிற்குப்  பிறகு  அல்லது  "ss" குறியீட்டிற்கு  உடனடியாக  "m" ஐப் 
பயன்படுத்தினால், Excel மாதத்திற்குப் பதிலாக நிமிடங்களைக் காண்பிக்கும். 
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Hours, Minutes மற்றும் Seconds :

காண்பிக்க இந்தக் குறியீட்டைப் பயன்படுத்தவும்

23-0 என மணிநேரம் h

23-00 என மணிநேரம் hh

நிமிடங்கள் 59–0 m

நிமிடங்கள் 59–00 mm

வினாடிகள் 59–0 s

வினாடிகள் 59–00 ss

மணி 4 AM h AM/PM

நேரம் மாலை 4:36 மணி h:mm AM/PM

நேரம் 4:36:03 P h:mm:ss A/P

மணிநேரங்களில் கழிந்த நேரம்; உதாரணமாக, 

25.02

[h]:mm

நிமிடங்களில் கழிந்த நேரம்; உதாரணமாக, 

63:46

[mm]:ss

ந�ொடிகளில் கழிந்த நேரம் [ss]

ஒரு ந�ொடியின் பின்னங்கள் h:mm:ss.00

AM மற்றும் PM: வடிவத்தில் AM அல்லது PM இருந்தால், மணிநேரம் 12 மணிநேர கடிகாரத்தை 
அடிப்படையாகக் க�ொண்டது, அங்கு "AM" அல்லது "A" என்பது நள்ளிரவு முதல் நண்பகல் 
வரையிலான நேரத்தையும், "PM" அல்லது "P" என்பது நண்பகல் முதல் நேரத்தையும் குறிக்கிறது. 
நள்ளிரவு வரை.  இல்லையெனில்,  மணிநேரம் 24 மணிநேர கடிகாரத்தை அடிப்படையாகக் 
க�ொண்டது. "m" அல்லது "mm" குறியீடு "h" அல்லது "hh" குறியீட்டிற்குப் பிறகு அல்லது "ss" 
குறியீட்டிற்கு உடனடியாகத் த�ோன்ற வேண்டும்; இல்லையெனில், எக்செல் நிமிடங்களுக்குப் 
பதிலாக மாதத்தைக் காட்டுகிறது.

தனிப்பயன் எண் வடிவங்களை நீங்கள் இதற்கு முன் செய்யவில்லை என்றால், அதை உருவாக்குவது 
தந்திரமானதாக இருக்கும். தனிப்பயன் எண் வடிவங்களை எவ்வாறு உருவாக்குவது என்பது 
பற்றிய கூடுதல் தகவலுக்கு, தனிப்பயன் எண் வடிவமைப்பை உருவாக்குதல் அல்லது நீக்குதல் 
என்பதைப் பார்க்கவும்.

பிரிவு 6. நுண்ணறை தரவு பரப்பை சீரமைத்தல் :

ஒரு நுண்ணறையில் உள்ள உரையின் திசையை மாற்றவும் :

படி 1: நுண்ணறை, வரிசை, நெடுவரிசை அல்லது பரப்பைத் தேர்ந்தெடுக்கவும்.
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படி 2: Home > Orientation  என்பதைத் தேர்ந்தெடுத்து, ஒரு விருப்பத்தைத் தேர்ந்தெடுக்கவும்.

நுண்ணறை தரவு பரப்பை சீரமைத்தல்

உரையை துல்லியமான க�ோணத்தில்
சுழற்றுதல் :

படி 1: நுண்ணறை, வரிசை, நெடுவரிசை அல்லது பரப்பைத் தேர்ந்தெடுக்கவும்.

படி 2: Home > Orientation  > Format Cell Alignment என்பதைத் தேர்ந்தெடுக்கவும்.

ஒரு நெடுவரிசை அல்லது வரிசையை சீரமைத்தல் :

படி 1: நீங்கள் சீரமைக்க விரும்பும் நுண்ணறைகளைத் தேர்ந்தெடுக்கவும்.

படி 2: Home தத்தலில், Alignment குழுவில், கிடைமட்ட சீரமைப்பு விருப்பத்தைத் தேர்ந்தெடுக்கவும்:

படி 3:  வலது பக்கத்திலுள்ள ந�ோக்குநிலையின் கீழ், டிகிரி பெட்டியில், மேல் அல்லது கீழ் 
அம்புக்குறியை பயன்படுத்தி நீங்கள் தேர்ந்தெடுத்த செல் உரையைச் சுழற்ற விரும்பும் டிகிரிகளின் 
சரியான எண்ணிக்கையை அமைக்கவும்.

நேர்மறை எண்கள் அவற்றின் உரையை மேல்நோக்கி சுழற்றுகின்றன. எதிர்மறை எண்கள் 
அவற்றின் உரையை கீழ்நோக்கி சுழற்றுகின்றன

இடது 
சீரமைத்தல்

மைய 
சீரமைத்தல்

வலதுபுறம் 
சீரமைத்தல்

மேல் 
சீரமைத்தல்

நடுத்தர 
சீரமைத்தல்

கீழ் 
சீரமைத்தல்

Alignment குழு

பிரிவு 7. Fill கைப்பிடியைப் பயன்படுத்தி எண் த�ொடர்வரிசையை உருவாக்குதல்:

படி 1: நிரப்ப வேண்டிய பரப்பில் உள்ள முதல் நுண்ணறையைத் தேர்ந்தெடுக்கவும்.

படி 2: த�ொடருக்கான த�ொடக்க மதிப்பை உள்ளிடவும்.
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படி 3: நீங்கள் நிரப்ப விரும்பும் பரப்பில் Fill கைப்பிடியைத்  தேர்ந்தெடுத்து இழுக்கவும்.

படி 4: ஆரம்ப மதிப்புகளை கெண்ட நுண்ணறைகளை தேர்ந்தெடுக்கவும்.

படி  5: நீங்கள் விரும்பும் வரம்மை தேர்ந்தெடுத்து இழுக்க வேண்டும். 

குறிப்பு : விரும்பியதை தேர்ந்தெடுக்கும் ப�ோது (drag)  நுண்ணறைகளின் மதிப்பு காட்டப்படும். 
அதில் ஏதும் மாற்றம் தேவையென்றால் கீழ்நோக்கி இழுத்து வலது பக்கத்தை கிளிக் செய்து 
வடிவத்தை தேர்ந்தெடுக்கவும். அதிகரிக்கும் வரிசையை நிரப்ப கீழே அல்லது வலது பிறமாக 
இழுக்கவும், குறைக்கும் வரிசையை நிரப்ப மேலே அல்லது இடது புறமாக இழுக்கவும்

பிரிவு 8. Fill கைப்பிடியை பயன்படுத்தி வாய்ப்பாட்டை நகலெடுத்தல் :

படி 1: மேல் நுண்ணறையில் வாய்ப்பாட்டை உள்ளிடவும்.

படி 2: நீங்கள் நிரப்ப விரும்பும் பரப்பில் நிரப்பு கைப்பிடியைத்  தேர்ந்தெடுத்து இழுக்கவும்.

படி 3:   சூத்திரத்தை நகல் எடுக்கும் விரும்பும் கலங்களின் மீது . Fill Handle – ஐ நெடுவரிசையின் 
கீழே பிடித்து இழுக்கவும்.

Fill கைப்பிடியைப் பயன்படுத்தி வாய்ப்பாட்டை நகலெடுத்தல்.

இதே முறையில், நீங்கள் சூத்திரத்தை வலப்புறம், இடதுபுறம் அல்லது மேல்நோக்கி அருகில் 
உள்ள செல்களில் இழுக்கலாம்.

சூத்திரத்தில் த�ொடர்புடைய செல் குறிப்புகள் ($ அடையாளம் இல்லாமல்) இருந்தால், அவை 
வரிசைகள் மற்றும் நெடுவரிசைகளின் ஒப்பீட்டு நிலையின் அடிப்படையில் தானாகவே மாறும். 
எனவே,  சூத்திரத்தை நகலெடுத்த பிறகு,  செல் குறிப்புகள் சரியாக சரிசெய்யப்பட்டுள்ளதா 
என்பதைச் சரிபார்த்து, முடிவை உருவாக்கவும். தேவைப்பட்டால், F4 விசையைப் பயன்படுத்தி 
முழுமையான, ஒப்பீட்டு மற்றும் கலப்பு குறிப்புகளுக்கு இடையில் மாறவும்.

மேலே  உள்ள  எடுத்துக்காட்டில் ,  சூத்திரம்  சரியாக  நகலெடுக்கப்பட்டுள்ளதா  என்பதை 
உறுதிப்படுத்த, C நெடுவரிசையில் சில கலத்தைத் தேர்ந்தெடுத்து, C4 எனக் கூறவும், மேலும் 
ஃபார்முலா பட்டியில் உள்ள செல் குறிப்பைப் பார்க்கலாம். கீழே உள்ள ஸ்கிரீன்ஷாட்டில் நீங்கள் 
பார்ப்பது ப�ோல், சூத்திரம் சரியாக உள்ளது - 4 வது வரிசையுடன் த�ொடர்புடையது, அது சரியாக 
இருக்க வேண்டும்:
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குறிப்புகளைப் பயன்படுத்துதல்.

முடிவுரை :

இவ்வாறு MS எக்செல் அட்டவணை தாளில் தரவு வடிவமைப்பை மாணவர்கள் தெளிவாக புரிந்து 
க�ொள்ள முடியும். 

காண�ொளி பரிந்துரைகள் :

வ. எண் தலைப்பு / ந�ோக்கம் இணைப்பு

1 MS எக்செல் - தமிழில் தரவைத் திருத்துதல் & 

வடிவமைத்தல்

https://youtu.be/y7GZnwbf4EE

2 முழுமையான எக்செலை கற்றல் https://youtu.be/

YGG1aXJws4A

3 தமிழில் எக்செல் கற்க ஆரம்பிப்போற்கான 

அடிப்படைகள்

https://youtu.be/3qNOa9JjBZk

4 எண்களுக்கு முன்னால் பூஜ்ஜியத்தை 

எவ்வாறு சேர்ப்பது

https://youtu.be/mijhtkFLKCY

எளிய மதிப்பீடுகள்:

மாணவர் 

செயல்பாடு

1. � மாணவர்கள் கணக்கிடுவதற்கான வாய்ப்பாடுகளைப் 

பயன்படுத்தி மதிப்பெண் பட்டியலைத் தயாரிக்க வேண்டும்.

2. � மாணவர்கள் கிரிக்கெட் ப�ோட்டிக்கான ஸ்கோர் அட்டையை 

தயார் செய்ய வேண்டும்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1.  உங்கள் மதிப்பீட்டு மதிப்பெண்களின் தரவை உருவாக்கவும்.

2. �தரவை  உருவாக்கி, உங்கள் வகுப்பு தேர்வு மதிப்புகளை 

சராசரிப்படுத்தவும்.

3. � ஒரு புதிய பாணியை உருவாக்கி அதை உங்கள் கணினியில் 

புதுப்பிக்கவும்.

த�ொழில் சார்ந்த 

/ கள ஆய்வு 

பரிந்துரைகள்

1. � விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் த�ொழில்நுட்ப வல்லுநரை 

அழைக்கவும்.

2. � விருந்தினர் விரிவுரைக்கு கணக்கு தணிக்கையாளரை 

அழைக்கவும்.

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் அலுவலக உதவியாளரை 

அழைக்கவும்.

	10.12	 பார்வையிடலின் பயன்பாடு

ந�ோக்கம் :

MS எக்செல் அட்டவணைத் தாளில் பார்வையிடுதலைப் புரிந்து க�ொண்டு பயன்படுத்துதல்.

செயல்பாடுகள்

1.	 பார்வையிடல்
2.	 பார்வையிடலின் கருத்துகள்

3.	 நுண்ணறை பார்வையிடலின் வகைகள்
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4.	 ஒப்பீட்டு நுண்ணறைப் பார்வையிடல்

5.	 கலப்பு பார்வையிடல் - தனித்த நெடுவரிசை எழுத்து 
6.	 நுண்ணறைப் பார்வையிடல் எந்த மாற்றமும் இல்லை

தேவையான கருவிகள் மற்றும் உபகரணங்கள்:

வ. எண் கருவிகள் / உபகரணங்களின் பெயர் வரம்பு / மதிப்பு அளவு

1 கணினி அல்லது மடிக்கணினி 15 செயலி / 4 GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1

செயல்முறை:

பிரிவு 1. ஒரு அட்டவணை நுண்ணறைகளை பார்வையிடுவது எவ்வாறு?

படி 1: நீங்கள் வாய்ப்பாட்டை உள்ளிட விரும்பு நுண்ணறையை கிளிக் செய்யவும்.
படி 2: சம குறியை (=) தட்டச்சு செய்யவும்.
படி 3: நுண்ணறையில் அல்லது வாய்ப்பாட்டு பட்டியில், நேரடியாக முகவரியை தட்டச்சு செய்யவும் 
அல்லது நீங்கள் குறிப்பிட விரும்பும் நுண்ணறையைக் கிளிக் செய்யவும்.

படி 4: மீதமுள்ள வாய்ப்பாட்டை தட்டச்சு செய்து, அதை முடிக்க Enter சாவியை அழுத்தவும்.

படி 5: A1 மற்றும் A2 இன் மதிப்புகளைச் C1 ல் கூட்ட, நீங்கள் = குறியை தட்டச்சு செய்து, A1 
ஐக் கிளிக் செய்து, (+) கூட்டல் குறியைத் தட்டச்சு செய்து, A2 ஐக் கிளிக் செய்து Enter ஐ அழுத்தவும்:

ஒரு அட்டவணை பார்வையிடல்

பிரிவு 2. எக்செல் இல் ஒப்பீட்டு நுண்ணறை பார்வையிடல் :

படி 1: நெடுவரிசை A இல் உள்ள எண்களை 5 ஆல் பெருக்க, இந்த வாய்ப்பாட்டை B2 இல் 
உள்ளிடவும்:

= A2 * 5

படி 2: நெடுவரிசை ‘A’ – வை 5 ஆல் பெருக்குவதற்கு B2 : A2*5 என்ற சூத்திரத்தை பயன்படுத்தவும்.

படி 3: வரிசை 2 இலிருந்து வரிசை 3 க்கு நகலெடுக்கும் ப�ோது, வாய்ப்பாடானது இவ்வாறு மாறும்:

= A3 * 5

எக்செல் ஒப்பீட்டு நுண்ணறை பார்வையிடல்
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பிரிவு 3. எக்செல் இல் தனித்த நுண்ணறை பார்வையிடல் :

படி  1 :  தனித்த  நுண்ணறை  என்பது  டாலர்  குறியீட்டை  வரிசை  மற்றும்  நெடுவரிசையில் 
ஒருங்கிணைத்தல் அதாவது $A$1 அல்லது $A$1:$B $10:

படி 2: A நெடுவரிசையில் உள்ள எண்களை B2 இல் உள்ள எண்ணால் பெருக்க, பின்வரும் 
வாய்ப்பாட்டை வரிசை C2 இல் உள்ளிடவும், = A2*$B$2

தனித்த நுண்ணறை பார்வையிடல்

பிரிவு 4. கலப்பு நுண்ணறை பார்வையிடல்

படி 1: ஒரு கலப்பு நுண்ணறை பார்வையிடலில் $A1 அல்லது A$1 ப�ோன்ற ஒரு தனித்த மற்றும் 
ஒப்பீட்டு பார்வையிடல்கள் ஒருங்கிணைந்திருக்கும். 

படி 2: நெடுவரியை A விலுள்ள எண்களை 3 வெவ்வேறு எண்களால் (B2, C2 மற்றும் D2) 
பெருக்க, பின்வரும் வாய்ப்பாட்டை B3, =$A3*B$2 பயன்படுத்தவும் 
படி 3: இதன் விளைவாக அனைத்து கணக்கீடுகளும் ஒற்றை சூத்திரத்துடன் செய்யப்படுகின்றன. 
இது நகலெடுக்கப்படும் ஒவ்வொரு வரிசை மற்றும் நெடுவரிசைக்கும் சரியாக மாறுகிறது

கலப்பு நுண்ணறை பார்வையிடல்

முடிவுரை :

MS எக்செல் அட்டவணைதாளில் உள்ள அனைத்து விதமான நுண்ணறை பார்வையிடல்களையும் 
தெளிவாக பயிற்சி செய்யப்பட்டது

காண�ொளி பரிந்துரைகள் :

வ. எண் தலைப்பு / ந�ோக்கம் இணைப்பு

1 ஒரு அட்டவணை பார்வையிடலை எவ்வாறு 

உருவாக்குவது.

https://www.youtube.com/

watch?v=pHEz6MrdYfo

2 எக்செல் இல் ஒப்பீட்டு நுண்ணறை 

பார்வையிடல்

https://www.youtube.com/

watch?v=s3EiyUSR59c

3 எக்செல் இல் தனித்த நுண்ணறை 

பார்வையிடல்

https://www.youtube.com/

watch?v=pJYCll3Uh30

4 கலப்பு நுண்ணறை பார்வையிடல் https://www.youtube.com/

watch?v=SfV_MT2wWjs
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எளிய மதிப்பீடுகள்:

மாணவர் 

செயல்பாடு

1. � மாணவர்கள் நுண்ணறை பார்வையிடலை பயன்படுத்தி 

ப�ொருள் மற்றும் விலையை தயார் செய்ய வேண்டும்.

2. � மாணவர்கள் அனைத்து நுண்ணறை பார்வையிடலையும் 

பயன்படுத்தி பணியாளர் சம்பள பட்டியலை தயார் செய்ய 

வேண்டும்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1. � விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் த�ொழில்நுட்ப வல்லுநரை 

அழைக்கவும்.

2.  விருந்தினர் விரிவுரைக்கு கணினி பாட நிபுணரை அழைக்கவும்.

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் அலுவலக உதவியாளரை 

அழைக்கவும்.

த�ொழில்துறை/ 

கள வருகை 

பரிந்துரைகள்

1. � மாணவர்கள் பள்ளிக்கு அருகில் உள்ள அலுவலகத்திற்கு சென்று 

களபார்வை மேற்கொள்ளவும்.

2.    மாணவர்கள்களப் பார்வைக்காக அருகிலுள்ள வங்கிகளுக்குச்   

செல்லவும்..

3. � மாணவர்கள்அருகிலுள்ள தணிக்கை அலுவலகத்திற்கு சென்று 

கள ஆய்வு மேற்கொள்ளவும்.

	10.13	� MS எக்செல் இல் ஒரு விளக்கப்படத்தைத் தயாரித்தல் :

ந�ோக்கம் :

MS எக்செல் இல் வெவ்வேறு விளக்கப்படங்களைப் (நெடுவரிசை விளக்கப்படம், வரி விளக்கப்படம், 
வட்ட விளக்கப்படம் மற்றும் பட்டை விளக்கப்படம்) பற்றி அறிந்து க�ொள்ளுதல்.

செயல்பாடுகள்:

1.	 நெடுவரிசை விளக்கப்படம்
2.	 வரி விளக்கப்படம்
3.	 வட்டவிளக்கப்படம்
4.	 பட்டை விளக்கப்படம்

தேவையான கருவிகள் மற்றும் உபகரணங்கள்:

வ. எண் கருவிகள் / உபகரணங்களின் பெயர் வரம்பு / மதிப்பு அளவு

1 கணினி அல்லது மடிக்கணினி 15 செயலி / 4 GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1
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செயல்முறை:

பிரிவு 1. நெடுவரிசை விளக்கப்படம்:

படி 1: புதிய எக்செல் அட்டவணைத் தாளை உருவாக்கி ஆவணத்தைச் சேமிக்கவும்.

படி 2: மாதத்தின் விற்பனை மற்றும் செலவுகளை உள்ளிடவும்.

படி 3: கருவிப்பட்டியில் Insert விருப்பத்தை கிளிக் செய்யவும்.

படி 4: தட்டச்சு செய்த நுண்ணறைகளைத் தேர்ந்தெடுத்து, clustered column chart, விளக்கப்பட 
விருப்பத்தைக் கிளிக் செய்யவும்.

படி 5: இது நெடுவரிசை விளக்கப்படத்தில் மாதத்தின் விற்பனை மற்றும் செலவுகளைக் காட்டுகிறது.

நெடுவரிசை விளக்கப்படம்

பிரிவு 2. வரி விளக்கப்படம்:

படி 1: புதிய எக்செல் அட்டவணைத் தாளை உருவாக்கி ஆவணத்தைச் சேமிக்கவும்

படி 2: ஒரு மாதத்தின் தயாரிப்பு ப�ோக்குகளை ( Trending ) உள்ளிடவும்.

படி 3: கருவிப்பட்டியில் Insert விருப்பத்தை கிளிக் செய்யவும்.

படி 4: தட்டச்சு செய்த நுண்ணறைகளைத் தேர்ந்தெடுத்து line chart விருப்பத்தை கிளிக் செய்யவும்.

படி 5: இது வரி விளக்கப்படத்தில் மாதத்தின் தயாரிப்புப் ப�ோக்குகளைக் காட்டுகிறது

வரி விளக்கப்படம்
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பிரிவு 3. வட்ட விளக்கப்படம்:

படி 1: புதிய எக்செல் அட்டவணைத் தாளை உருவாக்கி ஆவணமாக சேமிக்கவும்

படி 2: மாதங்களின் லாபத்தை உள்ளிடவும்.

படி 3: கருவிப்பட்டியில் உள்ள Insert விருப்பத்தை கிளிக் செய்யவும்.

படி 4:  தட்டச்சு செய்த நுண்ணறைகளைத் தேர்ந்தெடுத்து,  pie chart விருப்பத்தைக் கிளிக் 
செய்யவும்.

படி 5: இது வெவ்வேறு மாதங்களின் லாபத்தை வட்ட விளக்கப்படத்தில் காட்டுகிறது.

படி 6: கருவிப்பட்டியில் layout விருப்பத்தை கிளிக் செய்து, வட்ட விளக்கப்படத்தின் மையத்தில் 
உள்ள தரவைப் பார்க்க data labels-->centre என்பதைக் கிளிக் செய்யவும்.

வட்டவிளக்கப்படம்

பிரிவு 4.பட்டை விளக்கப்படம்:

படி 1: புதிய எக்செல் அட்டவணைத் தாளை உருவாக்கி ஆவணத்தைச் சேமிக்கவும்

படி 2: தயாரிப்பு ப�ொருளின் ஆயுள் (Product life) வாழ்க்கையை நாட்களை உள்ளிடவும்.

படி 3: கருவிப்பட்டியில் உள்ள Insert விருப்பத்தை கிளிக் செய்யவும்.

படி 4: தட்டச்சு செய்த நுண்ணறைகளைத் தேர்ந்தெடுத்து bar chart விருப்பத்தை கிளிக் செய்யவும்.

படி 5: இது தயாரிப்பு, ப�ொருளின் ஆயுள் நாட்களை விளக்கப்படத்தில் காட்டுகிறது.

பட்டை விளக்கப்படம்
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முடிவுரை :

MS எக்செல் மூலம் நெடுவரிசை விளக்கப்படம், வரி விளக்கப்படம், வட்ட விளக்கப்படம் மற்றும் 
பட்டை விளக்கப்படம் ஆகியவைகள் வெற்றிகரமாக உருவாக்கப்பட்டது.

காண�ொளி பரிந்துரைகள் :

வ. எண் தலைப்பு / ந�ோக்கம் இணைப்பு

1 தமிழில் எக்செல் விளக்கப்படம் https://youtu.be/CamobfRkSbI

2 MS Excel – வட்ட, பட்டை, நெடுவரிசை & வரி 

விளக்கப்படம்

https://youtu.be/Z2gzLYaQatQ

3 தமிழில் எச்செல் விளக்கப்பட உருவாக்கம் 

மற்றும் அதன் வகைகள்

https://youtu.be/

W7mscNdMz94

குறுக்காக:
1. விற்பனைத் தகவல்களை பார்க்க எந்தந விளக்கப்படம் பயன்படுத்த வேண்டும். 
2. குறுகிய மற்றும் நீண்ட காலத்திற்கான மாற்றங்களைக் கண்காணிக்க எந்த விளக்கப்படம் 

பயன்படுத்த வேண்டும். 
கீழே 
3. இது ஒரு குறிப்பிட்ட காலப் பகுதியின் தரவு மாற்றங்களை காட்டுகிறது அல்லது உருப்படிகளின் 

ஒப்பீடுகளை விளக்குகிறது. 
4. தரவு வகைகளுக்கு இடையிலான ஒப்பீடுகளை எந்த விளக்கப்படத்தை பயன்படுத்த வேண்டும்..

மாணவர் 

செயல்பாடு

1. � உங்கள் காலாண்டு தேர்வு மதிப்பெண்களை பாட வாரியாக 

பார்க்க வட்ட வரைபடம் வரையவும்.

2. � உங்கள் குடும்பத்தின் ஜனவரி மாத வருமானம் மற்றும் 

செலவுகளைக் காண, நெடுவரிசை விளக்கப்படத்தை வரையவும்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1. � விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் த�ொழில்நுட்ப வல்லுநரை 

அழைக்கவும்.

2.  விருந்தினர் விரிவுரைக்கு கணினி பாட நிபுணரை அழைக்கவும். 

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் அலுவலக உதவியாளரை 

அழைக்கவும்.

த�ொழில் சார்ந்த 

/ கள ஆய்வு 

பரிந்துரைகள்

1. � பள்ளிக்கு அருகில் உள்ள அலுவலகத்திற்கு கள 

மேற்பார்வையிடுதல்

2.  களப் பார்வைக்காக அருகிலுள்ள வங்கிகளுக்குச் செல்லுதல்

3.  அருகிலுள்ள தணிக்கை அலுவலகத்திற்கு கள ஆய்வு செய்தல்
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	10.14	� MS எக்செல் இல் மேம்படுத்தப்பட்ட மின்னணு அட்டவனை தாளை 

உருவாக்குதல் :

ந�ோக்கம் :

குறிப்புகள் (reference), மீத்தொடுப்புகள் (hyperlinks) குறுநிரல் (Macro) பயன்படுத்தி 
அட்டவணை உருவாக்கி MS எக்செல் இல் அட்டவணை தாளை மதிப்பாய்வு செய்து ஒன்றிணைத்தல்.

செயல்பாடுகள் :

•	 தரவுகளை ஒருங்கிணைத்தல்
•	 தரவை உருவாக்குதல்
•	 குறிப்பை உருவாக்கி பல பணித்தாள்களை அமைத்தல்
•	 ‘What if” பகுப்பாய்வை உருவாக்கி பயன்படுத்துதல்.
•	 மீத்தொடுப்புகளை செருகுதல் மற்றும் வெளிப்புற தரவை இணைத்தல்.
•	 குறுநிரலை பதிவு செய்தல்

பாதுகாப்பு நடவடிக்கை :

எக்செல் பயன்படுத்தும் ப�ோது மனதில் க�ொள்ளவேண்டியவை மற்றும் செய்யக் கூடாதவை.

•	 உங்கள் அட்டவணை தாளைத் திட்டமிடுங்கள்
•	 த�ொடர்புடைய தரவை உள்ளிடும் ப�ோது வெற்று வரிசைகள் அல்லது நெடுவரிசைகளை 

உள்ளிட வேண்டாம்.
•	 அடிக்கடி சேமித்து இரண்டு இடங்களில் சேமிக்கவும்.
•	 எண்களை நெடுவரிசை தலைப்புகளாகப் பயன்படுத்த வேண்டாம்.
•	 வாய்ப்பாடுகளில் நுண்ணறை குறிப்புகள் மற்றும பெயரிடப்பட்ட பரப்புகளைப் பயன்படுத்தவும்.
•	 வாய்ப்பாடுகளைக் க�ொண்ட நுண்ணறைகளை கவனமுடன் கையாளவும்
•	 தரவை வரிசைப்படுத்தவும்.

தேவையான கருவிகள் மற்றும் உபகரணங்கள்:

வ. எண் கருவிகள் / உபகரணங்களின் பெயர் வரம்பு / மதிப்பு அளவு

1 கணினி அல்லது மடிக்கணினி 15 செயலி / 4 GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1

3 அச்சுப்பொறி எப்சன் 1

செயல் முறை 

பிரிவு 1. MS எக்செல் இல் ‘What if analysis’ உருவாக்கி பயன்படுத்துதல் :

படி 1 : MS எக்செல் இல் ஒரு புதிய அட்டவணைத் தாளை திறக்கவும்.

படி 2 : பின்வரும் தரவை உள்ளிடவும்.
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வ. எண் A B

1 Price 83

2 Qty. 12

3 Amount 996

Scenario Manager - உரையாடல் பெட்டி

படி 3 : Data tools குழுவில் Data>what if analysis கிளிக் செய்து ‘Scenario manager’ ஐ 
தேர்ந்தெடுக்கவும்.

படி 4 : ‘Scenario Manager’ உரையாடல் பெட்டி த�ோன்றும்.

படி 5 : ‘Add’ ப�ொத்தானை கிளிக் செய்தால் ‘Add Scenario’ உரையாடல் பெட்டி த�ோன்றும்.

Add Scenario - உரையாடல் பெட்டி

படி 6 : ‘Scenario name’ உரைப்பெட்டியில் பெயரை உள்ளிடவும். ‘Changing Cells’ உரையாடல் 
பெட்டியில் மதிப்பு மாற்றப்பட வேண்டிய நுண்ணறை முகவரியை உள்ளிடவும், ok ப�ொத்தானை 
கிளிக் செய்யவும்.

படி 7 :  ‘Scenario values’ உரையாடல் பெட்டி த�ோன்றும். அதில் மதிப்பை உள்ளிட்டு ok 
ப�ொத்தானை கிளிக் செய்யவும்.

படி 8 : இதைப் ப�ோன்று ‘Scenario’ க்களை உருவாக்க படி-5 முதல் படி – 7 வரை மீண்டும் 
செய்யவும்.
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படி 9 : இறுதியாக ‘Summary’ ப�ொத்தனை கிளிக் செய்தால் ‘Scenario summary’ உரையாடல் 
பெட்டி த�ோன்றும்.

படி 10 : ‘Report Type’ ஐ தேர்ந்தெடுத்து ok ப�ொத்தனை கிளிக் செய்யவும்.

படி 11 : புதிய பணித்தாளில் ‘Scenario summary’ த�ோன்றும்.

பிரிவு 2. MS எக்செல் இல் மீத் த�ொடுப்பை செருகுதல் :

படி 1 : MS எக்செல் இல் ஒரு புதிய அட்டவணைத்தாளை திறக்கவும்.

படி 2 : Insert > Hyperlink கிளிக் செய்தால் உரையாடல் பெட்டி த�ோன்றும்.

படி 3 : Link to பகுதியில் இருந்து place in this document விருப்பத்தை தேர்ந்தெடுக்கவும்.

Hyperlink - உரையாடல் பெட்டி

படி 4 : Text to display உரையாடல் பெட்டியில் மீத்தொடுப்பு உரையை உள்ளிடவும்.

படி 5 : ‘Type the cell reference’ உரைப்பெட்டியில் நுண்ணறையின் முகவரியை உள்ளிடவும் 
அல்லது க�ொடுக்கப்பட்ட பட்டியலில் இருந்து விருப்பத்தை தேர்ந்தெடுத்து ok ப�ொத்தானை கிளிக் 
செய்யவும்.

படி 6 :  தட்டச்சு  செய்யப்பட்ட  உரையானது  நீல  நிற  வண்ணத்தில்  அடிக�ோடு  இடப்பட்டு 
மீத்தொடுப்பாக உயர்த்தி காட்டப்பட்டிருக்கும். இதை கிளிக் செய்தால் இதனுடன் இணைக்கப்பட்ட 
தரவு த�ோன்றும்.

படி 7 : ஒரு முறை உபய�ோகித்த பிறகு மீத்தொடுப்பின் நிறமானது மாறிவிடும்.

Get External Data த�ொகுதி
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பிரிவு 3. MS எக்செல் இல் MS – Access தரவை இணைத்தல் :

படி 1 : MS எக்செல் இல் ஒரு புதிய அட்டவணைத்தாளை திறக்கவும்.

படி 2 :	 Data பட்டியல் get external Data த�ொகுதியில் இருந்து From Access என்பதை கிளிக் 
செய்யவும்.

படி 3 :	த�ோன்றும் உரையாடல் பெட்டியிலிருந்து ஏதேனும் ஒரு Access க�ோப்பைத் தேர்வு செய்து 
open ப�ொத்தானை கிளிக் செய்யவும்.

படி 4 : ஏதேனும் ஒரு அட்டவணையைத் தேர்வு செய்து ok ப�ொத்தானை அழுத்தவும். Import 
data உரையாடல் பெட்டியில் select table மற்றும் existing worksheet என்பவைகளை தேர்வு 
செய்து ok ப�ொத்தானை கிளிக் செய்யவும்.

படி 5 : இப்பொழுது தரவுதள பதிவுகள் அட்டவணை தாளில் இணைக்கப்பட்டிருக்கும்.

Import Data – உரையாடல் பெட்டி

பிரிவு 4. குறுநிரலை பதிவு செய்தல் :

படி 1 : MS எக்செல் இல் ஒரு புதிய அட்டவணைத்தாளை திறக்கவும்.

படி 2 : View > Macros > Record Macro என்பதை கிளிக் செய்யவும். உரையாடல் பெட்டி 
த�ோன்றும்.

Record Macro - உரையாடல் பெட்டி

படி 3 : குறு நிரலுக்கு ஒரு பெயரிடவும். MS – எக்செல் இல் பயன்படுத்தப்படாத குறுக்கு வழி 
சாவி சேர்மானங்களை குறு நிரலுக்குப் பயன்படுத்தவும்.
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படி 4 : குறு நிரலுக்கான விளக்கத்தைப் Description பெட்டியில் உள்ளிட்டு ok ப�ொத்தானை 
கிளிக் செய்யவும்.

படி 5 : குறு நிரலுக்கான செயல்களை செய்து (உரை அல்லது எண்களை தட்டச்சு செய்தல் 
அல்லது வடிவமைத்தல் ) முடித்தவுடன் stop recording ஐ கிளிக் செய்யவும்.

படி 6 : View Macro தேர்வில் உருவாக்கப்பட்ட குறுநிரல் த�ோன்றும்.

படி 7 :  இப்பொழுது குறுக்குவழி சாவி சேர்மானம் அல்லது View Macro தேர்வில் Run 
ப�ொத்தானை கிளிக் செய்து நமது குறுநிரல் செயல்களை மீண்டும் மீண்டும் செய்து க�ொள்ளலாம்.

முடிவுரை :

இவ்வாறு மீத்தொடுப்பு மற்றும் குறுநிரல்கள் பயன்படுத்தி what if analysis அட்டவணை 
உருவாக்கி, MS excel இல் அட்டணைத்தாளை மதிப்பாய்வு மற்றும் ஒன்றிணைப்பது சரிபார்க்கப்பட்டது.

காண�ொளி பரிந்துரைகள் :

வ. எண் தலைப்பு வீடிய�ோ இணைப்பு

1 MS எக்செலில் what if analysis https://youtu.be/FxaV4lckino

2 MS Excel - பல பணித்தாள் 

உருவாக்குதல் குறிப்பு, மீத்தொடுப்பு 

அட்டவணைத், பகிர்தல்

https://www.youtube.com/watch?v=-0

I1BpSlE3sz

3 MS Excel - மேக்ரோ ரெக்கார்டரைப் 

பயன்படுத்தி நெடுவரிசைகளை 

வரிசைப்படுத்துதல்

https://www.youtube.com/

watch?v=KobPARZhN2c

எளிய மதிப்பீடுகள்:

1.	 அட்டவணைத்தாள் மென்பொருளில் ஒரு பணித்தாளில் இருந்து வேறு இடத்திற்கு செல்ல 
____________பயன்படுத்தலாம்.

2.	 __________ என்பது ஒரு செயல் அல்லது செயல்களின் த�ொகுப்பாகும், அதை நீங்கள் 
பணித்தாளில் எத்தனை முறை வேண்டுமானாலும் இயக்கலாம்.

3.	 __________ ஒரு நுண்ணறை அல்லது பணித்தாளில் உள்ள நுண்ணறைகளின் பரப்பைக் 
குறிக்கிறது.

4.	 ஏ ற்க  ன வே   உ ள்ள   அ ட ்ட வ ணை  த ்தாள   ை த்  தி றக்க    _ _ _ _ _ _ _ _ _ _  கு று க் கு 
வழிச்சாவிபயன்படுத்தப்படுகிறது.

5.	 ஒரு புதிய அட்டவணைத்தாளை செருக__________ குறுக்கு வழிச்சாவி பயன்படுகிறது.

	 பதில் (1. மீத்தொடுப்பு 2. குறுநிரல் 3. செல் குறிப்பு 4. ctrl + o 5. shift + f11 ) 
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மாணவர் 

செயல்பாடு

1. � What if analysis பயன்படுத்தி வெற்று Balance நெடுவரிசையுடன் 

கணக்கு summary தாளைத் தயாரிக்கவும்.

2.  ஒரு உதாரணத்துடன் குறுநிரல் க�ோப்பை தயார் செய்யவும்

3. � ஒரு மீத்தொடுப்பு தரவு க�ோப்பை உதாரணத்துடன் தயார் 

செய்யவும்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1.  விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் பாட நிபுணரை அழைக்கவும்.

2.  விருந்தினர் விரிவுரைக்கு தணிக்கையாளரை அழைக்கவும்.

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் வணிக ஆய்வாளரை 

அழைக்கவும்.

த�ொழில் சார்ந்த 

/ கள ஆய்வு 

பரிந்துரைகள்

1. � பள்ளிக்கு அருகில் உள்ள தணிக்கை அலுவலகத்திற்கு கள ஆய்வு 

மேற்கொள்ளுதல்

2.  களப் பார்வைக்காக அருகிலுள்ள வங்கிகளைப் பார்வையிடவும்.

3. � அருகிலுள்ள அலுவலகத்தின் நிர்வாக க�ோப்புகளை 

பார்வையிடவும்.

	10.15	� MS எக்செல் இல் இருப்புநிலைக் குறிப்பைத் தயாரிக்கவும்

ந�ோக்கம் :

MS எக்செல் ஐ பயன்படுத்தி இருப்புநிலைக் குறிப்பைத் தயாரித்தல்.

செயல்பாடுகள் :

1.	 எக்செல் க�ோப்பை உருவாக்குதல்
2.	 இருப்புநிலைக் குறிப்பின் தரவுகளை உள்ளிடுதல்
3.	 ஆவணத்தை அச்சிடுதல்

தேவையான கருவிகள் மற்றும் உபகரணங்கள்:

வ. எண் கருவிகள் / உபகரணங்களின் பெயர் வரம்பு / மதிப்பு அளவு

1 கணினி அல்லது மடிக்கணினி 15 செயலி / 4 GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1

3 அச்சுப்பொறி EPSON L3250 1

செயல்முறை:

பிரிவு 1. எக்செல் க�ோப்பை உருவாக்குதல்

படி 1: எக்செல் ஐ திறக்கவும்.
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படி 2: New Blank Workbook கிளிக் செய்யவும்.

படி 3: நெடுவரிசை தலைப்புகளை வரிசை 1 இல் உள்ளிடவும்.

படி 4: தனிப்பட்ட வரிசைகளில் தரவை உள்ளிடவும்.

படி 5: தரவை வடிவமைக்க Page Layout தத்தலைக் கிளிக் செய்யவும்.

படி 6: ஆவணத்தைச் சேமிக்க File > Save as என்பதைக் கிளிக் செய்யவும்.

எக்செல் க�ோப்பை உருவாக்குதல்

பிரிவு 2. இருப்புநிலை குறிப்பின் தரவை உள்ளிடுதல் :

படி 1: இருப்புநிலை குறிப்பின் தேதியைத் தேர்ந்தெடுக்கவும்.

படி 2: அனைத்து ச�ொத்துகளையும் பட்டியலிடவும்.

படி 3: அனைத்து ச�ொத்துகளையும் சேர்க்கவும்.

படி 4: நடப்பு ப�ொறுப்புகளைத் தீர்மானிக்கவும்.

படி 5: நீண்ட கால ப�ொறுப்புகளை கணக்கிடவும்.

படி 6: ப�ொறுப்புகளைச் சேர்க்கவும்.

படி 7: முதலீட்டாளர்களின் பங்குகளை கணக்கிடவும்.

படி 8: ப�ொறுப்புகளையும் மற்றும் முதலீட்டாளர்களின் பங்குகளையும் சேர்க்கவும்.

இருப்புநிலைக் குறிப்பின் தரவுகளை உள்ளிடவும்
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பிரிவு 3. ஆவணத்தை அச்சிடுதல்

படி 1: அச்சிட வேண்டிய MS எக்செல் ஆவணத்தைத் திறக்கவும்

படி 2: எக்செல் க�ோப்பின் இடது மேல் மூலையில் உள்ள File யைக் கிளிக் செய்யவும் அல்லது 
CTRL + P ஐக் கிளிக் செய்யவும்

படி 3: ஆவணத்தை அச்சிட அச்சு குறும்படத்தைக் கிளிக் செய்யவும்

ஆவணத்தை அச்சிடுதல்

முடிவுரை:

இவ்வாறு MS எக்செல் இல் இருப்புநிலைக் குறிப்புக்கான தயாரிப்புகள் மற்றும் இருப்புநிலைக் 
குறிப்பு அச்சு எடுக்கப்பட்டு சரிபார்க்கப்பட்டது.

காண�ொளி பரிந்துரைகள் :

வ. எண் தலைப்பு / ந�ோக்கம் இணைப்பு

1 இருப்பு நிலைக் குறிப்பு தயாரிப்பது எப்படி, 

மற்றும் ஆண்டு இறுதி கணக்குகள்.

https://youtu.be/2JY04NU_qsk

2 Cutecinfo Pvt Ltd நிறுவனத்தின் சம்பள 

பட்டியல் தயாரித்தல்.

https://youtu.be/B--Dkqpcqd8

3 மைக்ரோசாஃப்ட் எக்செல் கணக்குகள் 

உதாரணம், வருவாய், செலவின கணக்கு.

https://youtu.be/HDlTAYedZjs

Chapter_10.indd   222 4/28/2022   12:14:03 PM



223த�ொடர்புடைய கணினி பயன்பாடுகளைத் தணிக்கை செய்தல்

எளிய மதிப்பீடுகள்:

மாணவர் 

செயல்பாடு

1. � மாணவர் ஒரே வர்த்தகரின் இருப்புநிலைக் குறிப்பைத் தயாரிக்க 

வேண்டும்.

2. � மாணவர் ஒரு கூட்டாண்மை நிறுவனத்தின் இருப்புநிலைக் 

குறிப்பைத் தயாரிக்க வேண்டும்.

3. � கூட்டு பங்கு நிறுமத்தின் இருப்புநிலைக் குறிப்பைத் தயாரிக்க 

வேண்டும் .

4. � மாணவர்கள் இலாப ந�ோக்கமற்ற நிறுவனத்தின் இருப்புநிலைக் 

குறிப்பைத் தயாரிக்க வேண்டும்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1. � விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் பாட நிபுணரை அழைக்கவும்.

2. � MS ஆபிஸ் தளத்தில் பணிபுரியும் அலுவலக உதவியாளரை 

அழைக்கவும் .

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் தணிக்கையாளரை அழைக்கவும்.

த�ொழில் சார்ந்த 

/ கள ஆய்வு 

பரிந்துரைகள்

1. � பள்ளிக்கு அருகிலுள்ள அலுவலகத்திற்கு ஒரு கள ஆய்வு 

மேற்கொள்ளுதல் 

2.  களப் ஆய்வுக்கு அருகிலுள்ள வங்கிகளைப் பார்வையிடவும்.

3. � அருகிலுள்ள தணிக்கை அலுவலகத்திற்கு ஒரு கள ஆய்வு 

மேற்கொள்ளவும்.

	10.16	� ஒரு பவர்பாயிண்ட் நிகழ்த்துதல் மற்றும் அதன் பல்வேறு விருப்பங்களை 

உருவாக்குதல் :

ந�ோக்கம் :

பல சில்லுகள், ஸ்லைடு மாஸ்டர், அட்டவணைகள் மற்றும் பவர்பாயிண்ட் கருவிகளைப் பயன்படுத்தி 
உரை மற்றும் படத்தைச் செருகுதல் ஆகியவற்றின் மூலம் ஒரு நிகழ்த்துதலை உருவாக்குதல்.

செயல்பாடுகள் :

1.	 நிகழ்த்துதலை உருவாக்குதல்
2.	 சில்லுகளுடன் வேலை செய்தல்
3.	 நிகழ்த்துதலில் உரையை வடிவமைத்தல்
4.	 நிகழ்த்துதலில் அட்டவணைகளை உருவாக்கி பயன்படுத்துதல்
5.	 நிகழ்த்துதலில் படத்தைச் செருகி வடிவமைத்தல்
6.	 ஸ்லைடு மாஸ்டருடன் வேலை செய்தல்.
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தேவையான கருவிகள் மற்றும் உபகரணங்கள்:

எஸ்.எண் கருவிகள் / உபகரணங்களின் பெயர் வரம்பு/மதிப்பு அளவு

1 கணினி அல்லது மடிக்கணினி 15 செயலி / 4GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1

குறுக்கு வழி சாவிகள் :

வ. எண் செயல்பாடு சாவி சேர்மானம்

1 புதிய நிகழ்த்துதலை உருவாக்க. Ctrl + N

2 புதிய சில்லுவைச் சேர்க்க. Ctrl + M

3 தேர்ந்தெடுக்கப்பட்ட உரையை தடிமனாக மாற்ற. Ctrl + B

4 தேர்ந்தெடுக்கப்பட்ட உரைக்கான எழுத்துரு அளவை 

மாற்ற.

Alt + H, F, S

5 பெரிதாக்கு உரையாடல் பெட்டியைத் திறக்க. Alt + W, Q

6 தேர்ந்தெடுக்கப்பட்ட உரை, ப�ொருள் அல்லது சில்லுவை 

அல்லது வெட்ட

Ctrl + X

7 தேர்ந்தெடுக்கப்பட்ட உரை, ப�ொருள் அல்லது சில்லுவை 

அல்லது நகலெடுக்க.

Ctrl + C

8 வெட்டப்பட்ட அல்லது நகலெடுக்கப்பட்ட உரை, ப�ொருள் 

அல்லது சில்லுவை ஒட்டவும்.

Ctrl + V

9 முந்தைய செயலைச் தவிர்க்க. Ctrl + Z

10 நிகழ்த்துதலைச் சேமிக்க. Ctrl + S

11 உங்கள் சாதனத்திலிருந்து ஒரு படத்தைச் செருக. Alt + N, P, D

12 ஒரு வடிவத்தைச் செருக. Alt + N, S, H

13 ஒரு கருத்துருவை தேர்ந்தெடுக்க. Alt + G, H

14 சில்லு அமைப்பைத் தேர்ந்தெடுக்கவும். Alt + H, L

15 அடுத்த சில்லுவிற்குச் செல்ல. Page down

16 முந்தைய சில்லுவிற்குச் செல்ல. Page Up

17 Home தத்தலுக்குச் செல்ல. Alt + H

18 Insert தத்தலுக்குச் செல்ல Alt + N

19 சில்லு காட்சியைத் த�ொடங்க. F5

20 சில்லு காட்சியை முடிக்க. Esc

21 நிகழ்த்துதலை மூடு. Ctrl + Q
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செயல்முறை :

பிரிவு 1. ஒரு விளக்கக்காட்சியை உருவாக்குதல் :

படி 1: புதிய நிகழ்த்துதலை உருவாக்க, File > New அல்லது Ctrl+N விசைகளை அழுத்தவும்.

படி 2: “Select a template “ என்ற திரை திறக்கும் டெம்ப்ளேட்டை கிளிக் செய்வதன் மூலம் 
உங்கள் விருப்பப்படி டெம்ப்ளேட்டை தேர்வு செய்யவும். 

 நிகழ்த்துதலை உருவாக்கவும்

பிரிவு 2. சில்லுகளுடன் பணிபுரிதல்

படி 1-3: slide > slide layout > Title slide என்பதைக் கிளிக் செய்யவும்.

சில்லுகளுடன் வேலை செய்கிறது

உரையை சேர்த்தல்: உரை சட்டத்தில் ‘click to add text’ கிளிக் செய்து, உங்கள் உரையை 
தட்டச்சு செய்யவும்.
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விளக்க காட்சியை சேர்த்தல்: File > Save > அல்லது Ctrl +S ஐ அழுத்தவும் அல்லது நிலையான 
கருவிப்பட்டியில் உள்ள Save குறும்படத்தைக் கிளிக் செய்யவும்.

சில்லு பலகத்தில் இருந்து நீங்கள் நகலெடுக்க விரும்பும் சில்லுவைத் தேர்ந்தெடுக்க :

படி 1 : பட்டிப் பட்டையில் இருந்து slide > Duplicate slide என்பதைத் தேர்ந்தெடுக்கவும் 

படி 2 சில்லுவில் வலது கிளிக் செய்து Duplicate slide தேர்வைத் தேர்ந்தெடுக்கவும் .

படி 3 : பணியிடத்திலுள்ள சில்லுவில் வலது கிளிக் செய்து மெனுவிலிருந்து “Slide duplicate 
slide”  - ஐ தேர்ந்தெடுக்கவும்.

படி 4  : அல்லது விளக்ககாட்சி கருவிப்பட்டியில் உள்ள நகல் ஸ்லைடு ஐகானக் கிளிக் செய்யவும். 
மெனுப் பெட்டியிருந்து புதிய சில்லுவை “Slide  New slide” - தேர்ந்தெடுக்கவும். 

படி 5  : அல்லது சில்லுவை வலது கிளிக் செய்து content menu – விலிருந்து புதிய சில்லுவை 
உருவாக்கவும். 

படி 6  : பணி செய்ய இருக்குமிடத்திலுள்ள வெற்று இடத்தில் வலது கிளிக் செய்து content 
menu – வில் “Slide  New slide”  தேர்ந்தெடுக்கவும்

பிரிவு 3. நிகழ்த்துதலில் அட்டவணைகளை உருவாக்கி பயன்படுத்துதல்

Insert > Table யை கிளிக் செய்யவும் .

நெடுவரிசைகளின் எண்ணிக்கை மற்றும் வரிசைகளின் எண்ணிக்கையை உள்ளிடவும்.

சுட்டியைப் பயன்படுத்தி நெடுவரிசையின் அகலத்தையும் வரிசை உயரத்தையும் சரிசெய்யவும். 
வரிசை உயரத்தை சரி செய்வதற்கு மேலும், கீழுமாக இழுக்கலாம். பல்வேறு அட்டவணை 
வடிவமைப்பு விருப்பங்களை எழுத்தாக்கத்தை ப�ோலவே அட்டவணையில் பயன்படுத்தலாம். 

எல்லைகள் மற்றும் பின்னணி அட்டவணையில் சரியாக ஒதுக்கப்படலாம். இதைச் செய்ய 
அட்டவணை எல்லையில் வலது கிளிக் செய்தால், Table properties dialog box  திறக்கும். 
அதிலிருந்து எல்லைகளின் பின்புலத்தை மாற்றலாம்.

நிகழ்த்துதலில் அட்டவணைகளை உருவாக்கி பயன்படுத்துதல்
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படி 1:  பட்டிப் பட்டையில் உள்ள Insert > Image என்பதைக் கிளிக் செய்யவும்நிலையான 
கருவிப்பட்டியில் உள்ள Insert Image குறும்படத்தைக் கிளிக் செய்யவும்.

படி 2: சில்லுவில் படத்தை நகர்த்த, படத்தின் மீது கிளிக் செய்து, செருகும்புள்ளி கை வடிவத்திற்கு 
மாறுவதைக் கவனிக்கவும்.

படி 3: படத்தை கிளிக் செய்து விரும்பிய நிலைக்கு இழுக்கவும்.

படி 4: சுட்டி ப�ொத்தானை விட்டு விடவும்.

படங்களை மறு அளவிடுதல்

படி 1: படத்தைக் கிளிக் செய்வதன் மூலம் அதைத் தேர்ந்தெடுக்கவும்.

படி 2: படத்தின் அளவை மாற்ற படத்தை கிளிக் செய்து இழுக்கவும். புதிய அளவு திருப்தி அடையும் 
ப�ோது சுட்டி ப�ொத்தானை விடவும்.

படி 3: படத்தின் அளவை மாற்ற கிளிக் செய்து இழுக்கவும்.

படி 4: தேவையான அளவு கிடைத்தவுடன் சுட்டி ப�ொத்தானை விட்டு விடவும்.

வரைதல் கருவிகள்

படி 1: பட்டிப் பட்டையில் இருந்து View > Toolbox > drawing என்பதைக் கிளிக் செய்யவும்.

பிரிவு 5. ஸ்லைடு மாஸ்டருடன் வேலை செய்தல் :

படி 1: ஸ்லைடு மாஸ்டரை விரிவாக்க பெயருக்கு அடுத்துள்ள விரிவாக்க குறியை கிளிக் செய்யவும்.

படி 2: சிறுபடங்களை மறைக்க துணைப்பிரிவை சுருக்க குறியை கிளிக் செய்யவும்.

நிகழுத்துதலில் படத்தைச் செருகி வடிவமைத்தல்

மாற்றங்களைச் சேர்த்தல்
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படி 1: பக்கப்பட்டியில், slide Transition ட்ரான்ஸிஷன் பிரிவைத் திறக்க, slide Transition 
குறியைத் தேர்ந்தெடுக்கவும்.

படி 2: Slide Pane அல்லது Slide sorter view வில் மாற்றத்தைப் பயன்படுத்த சில்லுகளைத் 
தேர்ந்தெடுக்கவும்.

படி 3: Apply to selected slides பட்டியலில் இருந்து விருப்பத்தை தேர்வு செய்யவும்.

படி 4: Modify Transition பகுதிக்கு சென்று வேகம் மற்றும் ஒலியை தேர்ந்தெடுக்கவும்.

படி 5 :  ஒலி  தேர்ந்தெடுக்கப்பட்ட  உடன்  L o op unt i l  t he  next  s ound செயல்படும் .  
மற்றொரு ஒலி த�ொடங்கும் வரை ஒலியை மீண்டும் மீண்டும் இயக்க இந்த விருப்பத்தைத் 
தேர்ந்தெடுக்கவும்.

படி  6 :  த ா ன ா க  மு ன்னே   று வ தைத்    தே  ர ்ந்தெ   டு க்க  ,  அ டு த ்த  சி ல் லு வி ற் கு  த ா ன ா க  
முன்னேறும் முன், சில்லு எவ்வளவு நேரம் தெரியும்படி இருக்க வேண்டும் என்பதைக் குறிப்பிட 
வேண்டும்.

படி 7: அனைத்து சில்லுகளுக்கும் மாற்றத்தைப் பயன்படுத்த, Apply to all slides என்பதைக் 
கிளிக் செய்யவும்.

படி 8: தற்போதைய சில்லுவிலிருந்து slide show வைத் த�ொடங்க, மாற்றங்களைச் சரிபார்த்து, 
slide show என்பதைக் கிளிக் செய்யவும்.

சில்லு ஷ�ோவுடன் வேலை செய்தல்
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சில்லு மாஸ்டருடன் வேலை செய்தல்

முடிவுரை :

பல சில்லுகள், ஸ்லைடு மாஸ்டர், அட்டவணைகள் மற்றும் MS பவர் பாயின்ட் கருவிகளைப் 
பயன்படுத்தி உரை மற்றும் படத்தைச் செருகுதல் அகியவற்றின் மூலம் நிகழ்த்துதல் வெற்றிகரமாகச் 
பயன்படுத்தப்பட்டது.

காண�ொளி பரிந்துரைகள் :

வ. எண் தலைப்பு / ந�ோக்கம் இணைப்பு

1 Powerpoint டுட�ோரியல் https://youtu.be/gtGz4elezS8

2 MS பவர்பாயிண்ட் - அடிப்படை விளக்கக்காட்சி https://youtu.be/tcj2BhhCMN4

3 பவர்பாயிண்ட் முழு பயிற்சி https://youtu.be/S2KqmNq7eP8

எளிய மதிப்பீடுகள்:

மாணவர் 

செயல்பாடு

1. � மாணவர் 1+ கணக்குப்பதிவியலில் ஏதேனும் ஒரு அத்தியாயத்தை 

பவர் பாயிண்டாகத் தயாரிக்க வேண்டும்.

2. � மாணவர் 1+ வணிகவியலில் ஏதேனும் ஒரு அத்தியாயத்தை பவர் 

பாயின்டாக ஆக தயார் செய்ய வேண்டும்.

3. � மாணவர்கள் 1+ ப�ொருளியலில் ஏதேனும் ஒரு அத்தியாயத்தை 

பவர் பாயின்ட் ஆக தயார் செய்ய வேண்டும்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1.  விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் பாட நிபுணரை அழைக்கவும்.

2. � விருந்தினர் விரிவுரைக்கு கணினி த�ொழில்நுட்ப வல்லுநரை 

அழைக்கவும்.

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் அலுவலக உதவியாளரை 

அழைக்கவும்.

த�ொழில் சார்ந்த 

/ கள ஆய்வு 

பரிந்துரைகள்

1. � பள்ளிக்கு அருகிலுள்ள அலுவலகத்திற்கு ஒரு கள மேற்பார்வை செய்தல்.

2.  அருகிலுள்ள வங்கிகளைப் பார்வையிடவும்.

3.  அருகிலுள்ள தணிக்கை அலுவலகத்திற்கு ஒரு கள ஆய்வு.
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	10.17	� அக்கவுண்டன்சி ஜர்னல் உள்ளீடுகள் மற்றும் லெட்ஜர் கணக்குகளைத் 

தயாரித்தல் :

ந�ோக்கம் :

மாதிரி லெட்ஜர் மற்றும் ஜர்னல் வடிவமைப்பிற்கான உருவாக்குதல்.

தேவையான ப�ொருள்

வ.எண் கருவிகள் / உபகரணங்களின் பெயர் வரம்பு/மதிப்பு அளவு

1 கணினி அல்லது மடிக்கணினி 15 செயலி / 4 GB RAM 1

2 மைக்ரோசாஃப்ட் ஆபிஸ் MS ஆபிஸ் 2019 1

பாய்வுப்படம்

1.	 பவர் பாயின்ட்டை ப் பயன்படுத்தி நிகழ்த்துதலை உருவாக்கவும்.
2.	 புதிய சில்லுகளை உருவாக்குதல்
3.	 அட்டவணையை செருகுதல்
4.	 லேபிள்களையும் மற்றும் தரவுகளையும் உள்ளீடு செய்தல்.

பாதுகாப்பு நடவடிக்கைகள்

1.	 உங்கள் நிகழ்த்துதலை சீரான இடைவெளியில் சேமிக்கவும்.
2.	 பவர் பாயின்ட் ஆவணத்தை மூடுவதற்கு முன், ஆவணத்தையும் அதன் க�ோப்பு பாதையின் 

இருப்பிடத்தையும் சேமிக்க வேண்டும் என்பதை நினைவில் க�ொள்ளுங்கள்.

செயல்முறை

படி 1: உங்கள் கணினியில் நிகழ்த்துதலைத் திறக்கவும் .

படி 2: File > New > Blank Presentation கிளிக் செய்யவும். வெற்று நிகழ்த்துதலில் இருமுறை 
கிளிக் செய்யவும்.

புதிய நிகழ்த்துதலை உருவாக்கவும்
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படி 3: Design > Themes என்பதைக் கிளிக் செய்து, விருப்பங்களில் காட்டப்படும் தீம் ஒன்றைத் 
தேர்ந்தெடுக்கவும்.

நிகழ்த்துதலில் வடிவமைப்பைச் சேர்க்கவும்

படி 4: உங்கள் தலைப்பின் பெயரை உள்ளிட்டு உரைப்பெட்டியில் உங்கள் பெயரைத் தட்டச்சு 
செய்யவும். 

படி 5: முதல் சில்லுவில் கிளிக் செய்யவும்.

மேலும் ஸ்லைடுகளைச் சேர்த்து நிகழ்த்துதலில் தரவை உள்ளிடவும்

படி 6: ஜர்னல் பதிவுகளுக்கான தலைப்பை உள்ளிடவும் . Insert >Table >Insert Table என்பதைக் 
கிளிக் செய்துவரிசைகள் மற்றும் நெடுவரிசைகளின் எண்ணிக்கையை உள்ளிடவும்.

விளக்கக்காட்சியில் அட்டவணையைச் செருகவும்
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படி 7: அட்டவணையில் லேபிள்கள் மற்றும் தரவை உள்ளிடவும்.

அட்டவணையில் லேபிள்களைச் செருகவும்

படி 8: லெட்ஜர் கணக்குகளுக்கு படி 5 & 6 ஐப் பின்பற்றவும்.

நிகழ்த்துதலில் லெட்ஜர் கணக்கைத் தயாரிக்கவும்

படி 9:  Home> layout என்பதைக் கிளிக் செய்து,  நன்றி சில்லுக்கான உங்கள் Layout ஐ 
தேர்வுசெய்யவும் .

சில்லுகளின் முடிவு
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படி 10: Slide Show > from beginning கிளிக் செய்யவும் அல்லது நிகழ்த்துதலை முழுத் 
திரையில் பார்க்க F5 சாவியை அழுத்தவும் .

முடிவுரை:

இதனால் லெட்ஜர் மற்றும் ஜர்னல் நிகழ்த்துதல் பவர்பாயிண்ட்டில் உருவாக்கப்பட்டு சரிபார்க்கப்பட்டது.

காண�ொளி பரிந்துரைகள்:

வ. எண் தலைப்பு / ந�ோக்கம் இணைப்பு

1 Power Point Tutorial https://youtu.be/gtGz4elezS8

2 வகுப்பு 11 - கணக்கியல் - PPT விளக்கக்காட்சி 

- இதழ், ப�ொருள், குறிக்கோள்கள், வரம்புகள் 

20-8-7 - MCS

https://youtu.be/82WeltyaYog

மதிப்பீடுகள்:

1.	 நிகழ்த்துதல் பக்கத்தைத் திறப்பதற்கான முறையை எழுதுக.
2.	 உங்கள் நிகழ்த்துதலை முழுத்திரையில் பார்க்க எந்த குறுக்கு வழி சாவி பயன்படுத்தப்படுகிறது?
?	 லெட்ஜர் கணக்கிற்கு எத்தனை வரிசைகள் மற்றும் நெடுவரிசைகள் பயன்படுத்தப்படுகின்றன ?

தரவுத்தளம் மேலாண்மை அமைப்பு 

மாணவர் 

செயல்பாடு

1. � உங்கள் பள்ளிக்கான தரவு லெட்ஜர் நிகழ்த்துதலை உருவாக்கவும்.

2.  உங்கள் பள்ளிக்கான ஜர்னல் நிகழ்த்துதல் தரவை உருவாக்கவும்.

3. � ஒரு கற்பனைப் தரவு மூலம் ச�ோதனை சமநிலையின் (trial balance ) 

நிகழ்த்துதலை உருவாக்கவும்.

4.  நிகழ்த்துதலை உருவாக்கி உங்கள் நண்பர்களுக்கு வழங்கவும்.

விருந்தினர் 

விரிவுரை 

பரிந்துரைகள்

1.  விருந்தினர் விரிவுரைக்கு MS ஆபிஸ் பாட நிபுணரை அழைக்கவும்.

2. � விருந்தினர் விரிவுரைக்கு கணக்கு தணிக்கையாளரை 

அழைக்கவும் .

3. � MS ஆபிஸ் தளத்தில் பணிபுரியும் அலுவலக உதவியாளரை 

அழைக்கவும் .

த�ொழில் சார்ந்த 

/ கள ஆய்வு 

பரிந்துரைகள்

1. � பள்ளிக்கு அருகிலுள்ள தரவு பராமரிப்பு மையத்திற்கு ஒரு கள 

ஆய்வை மேற்பார்வையிடவும்.

2. � களப் பார்வைக்கு அருகிலுள்ள காப்பீட்டு அலுவலகத்தைப் 

பார்வையிடவும்.

3.  அருகிலுள்ள கணினி மையத்திற்கு கள ஆய்வு மேற்கொள்ளவும்.
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10.18 	அறிமுகம்:

த ர வு த ்தள   மேல   ா ண ் மை  அ மைப்பா     ன து 
தரவுத்தளத்தில் உள்ள தரவுகளை ஒழுங்கமைக்க 
(உருவாக்குதல், மீட்டளித்தல், மேம்படுத்துதல் 
மற்றும் நிர்வகித்தல்) உதவும் ஒரு மென்பொருள் 
கருவியாகும்.
	 தரவுத்தள  மேலாண்மை  அமைப்பு 
என்பது கணினிமயமாக்கப்பட்ட பதிவுகளை 
ப தி வு  ச ெ ய் யு ம்  அ மைப்பா     கு ம் .  இ து 
கணினிமயமாக்கப்பட்ட தரவு க�ோப்புகளை 
சேகரிப்பதற்கான க�ொள்கலன் ஆகும்.

10.18.1 	ப�ொருள்:

தரவுத்தளமானது ஒழுங்கமைக்கப்பட்ட முறையில் 
சேமிக்கப்ட்ட  தரவுகளின்  த�ொகுப்பாகும் , 
தரவுத்தளத்தில் சேமிக்கப்படும் தரவுகளை, 
பயனரின் தேவைகளுக்கு ஏற்ப சேர்க்கலாம், 
ம ா ற ்ற ல ா ம் ,  நீ க்கல   ா ம்  அ ல்ல  து 
காட்சிபடுத்தலாம். தரவுகளை உருவாக்கவும், 
புதுப்பிக்கவும் மற்றும் மீட்டெடுக்கவும் பயன்படும் 
மென்பொருள் தரவுத்தள மேலாண்மை அமைப்பு 
என அழைக்கப்படுகிறது. (DBMS).

10.18.2	 வரைவிலக்கணம்:

தரவுத்தள வரைவிலக்கணத்தின்படி, தரவுத்தளம் 
என்பது ஒரு கணினி அமைப்பில் மின்னணு 
முறையில் சேமிக்கப்படும் கட்டமைக்கப்பட்ட 
தகவல் அல்லது தரவுகளின் ஒழுங்கமைக்கப்பட்ட 
த�ொகுப்பாகும்.

10.18.3.	தரவுத்தள மேலாண்மை 

அமைப்பின் தனிச்சிறப்புகள்:

•	 த ர வு க ள ை  அ ணு க வு ம்  ம ற் று ம் 
திருத்துவதற்கும் கட்டுபடுத்துகிறது.

•	 காப்பு நகலை (Backups) உருவாக்குகிறது.
•	 பல  பயனர்களுக்கு  தரவுகளை  பகிர 

அனுமதிக்கிறது.
•	 பயனர்  இடைமுகங்களுக்கும்  (User 

i n t e r f a c e s )  ப ணி பு ரி ய  த ர வு க ள் 
வழங்கப்படுகிறது.

•	 உயர்மட்ட பாதுகாப்பை வழங்குகிறது.
•	 தரவுகள் நிரந்தர சேமிப்பில் இருக்கிறது.

10.18.4	 கருத்தாக்கம்:

தரவுத்தள  மேலாண்மை  அமைப்பு  என்பது 
தரவுத் தளத்தில் உள்ள தரவை வரையறுக்க, 
கையாள ,  மீட்டெடுக்க  மற்றும்  நிர்வகிக்க 
வ டி வ மைக்கப்ப      ட ்ட  ஒ ரு  மென்    ப ொ ரு ள் 
த�ொகுப்பாகும்.

	 ஒரு தரவுத்தள மேலாண்மை அமைப்பு 
ப�ொதுவாக  தரவுகளை  தானாகவும் ,  தரவு 
வடிவம், புலத்தின் பெயர், பதிவுகளின் அமைப்பு 
ம ற் று ம்  க�ோ   ப் பு க ளி ன்  அ மை  ப் பு க ள ை 
கையாளுகிறது.  தரவைச் சரிபார்ப்பதற்கும் 
மற்றும் கையாளுவதற்கும் DBMS விதிகளை 
வரையறுக்கிறது.

தரவுத்தளம் மேலாண்மை அமைப்பு

த�ொடர்புடைய தரவுத்தளத்தின் (Relational 
Database) கருத்தாக்கம் மற்றும் எடுத்துக்காட்டு:

த�ொடர்புடைய தரவுத்தள மாதிரி 1970 இல் 
E.F. க�ோடல் என்பவரால் முன்மொழியப்பட்டது. 
இது  தரவு  அடிப்படை  மாதிரியின்  மிகவும் 
ப�ொதுவான  வகை  ஆகும் .  தரவு  கூறுகள் 
வரிசைகள் (Rows) மற்றும் நெடுவரிசைகளால் 
(column) ஆன வெவ்வேறு அட்டவணைகளில் 
சேமிக்கப்படுகின்றன.
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எ.கா. : Oracle, MYSQL, IBM, etc.

புலம் 
(Field)

: ஒ ரு  பு ல ம்  எ ன்ப  து 
த ர வு த ்தளத்   தி ல்  உ ள்ள  
மிகச்சிறிய உருப்பொருள் 
ஆகும்.

க�ோப்பு 
(Record)

: பு ல ங ்க ளி ன்  த�ொ   கு ப்பே   
க�ோப்பு ஆகும்.

அட்டவணை 
(Table)

: க�ோப்புகளின்  த�ொகுப்பே 
அட்டவணை ஆகும்.

தரவுத்தளம் 
(Database)

: அட்டவணைகளின் த�ொகுப்பு 
தரவுத்தளம் ஆகும்.

முதன்மைத் திறவுக�ோல் (Primary Key):

ஒரு  முதன்மைத்  திறவுக�ோல்  என்பது  ஒரு 
அட்டவணையில்  உள்ள  ஒரு  நெடுவரிசை 
அல்லது நெடுவரிசையின் குழுவாகும். அது 
அந்த அட்டவணையில் உள்ள வரிசைகளை 
ஒரே மாதிரியாக அடையாளப்படுத்துகிறது.

பதிவு 

எண்.

மாணவர் 

பெயர்

பிறந்த 

தேதி
மதிப்பெண்கள்

முதன்மைத் திறவுக்கோல்

இணைப்பு முதன்மைத் திறவுக�ோல் 

(Composite Primary Key):

இரண்டு அல்லது அதற்கு மேற்பட்ட பண்புக் 
கூறுகளைக் க�ொண்ட முதன்மைத் திறவுக�ோலை, 
இணைப்பு  முதன்மைத்  திறவுக்கோல்  என 
அழைக்கப்படுகிறது. இது இரண்டு அல்லது அதற்கு 
மேற்பட்ட நெடுவரிசைகளின் சேர்க்கை ஆகும்.

பதிவு 

எண்.

மாணவர் 

பெயர்

பிறந்த 

தேதி
மதிப்பெண்கள்

இணைப்பு முதன்மைத் திறவுக்கோல்

வெளித் திறவுக்கோல் (Foreign Key):

வெளித்திறவுக்கோல்  என்பது  முதன்மைத் 
திறவுக�ோல் வழியாக இரண்டு அட்டவணைகளை 
ஒன்றாக இணைக்கப் பயன்படும் திறவுக்கோல் 
ஆகும்.

பதிவு 

எண்.

மாணவர் 

பெயர்

பிறந்த 

தேதி
மதிப்பெண்கள்

முதன்மைத் 

திறவுக�ோல்

பதிவு 

எண்
த�ொகுதி

மாணவர் 

/ வகுப்பு

Foreign Key (வெளித் திறவுக்கோல்)

10.18.5	 DBMS மென்பொருள்:

DBMS தரவுத்தள  மேலாண்மை  அமைப்பு 
மென்பொருளில் ஒன்று Libreoffice Base 
ஆகும்.

அறிமுகம்:

Libreof f ice  B ase  ஒரு  இலவச  மற்றும் 
வெளிப்படை மூலநிரல் தரவுத்தள மேலாண்மை 
அமைப்பு ஆகும். அதை www.libreoffice.org 
இ ணையதளத்      தி லி ரு ந் து  ப தி வி றக்க   ம் 
செய்யலாம். மேலும் லினக்ஸ் (Linux) மற்றும் 
விண்டோஸ் இயக்க முறைமைகள் (Operating 
Systems) ஆகிய இரண்டு இயங்கு தளத்திலும் 
பயன்படுத்தப்படுகிறது. தரவுத்தள மேலாண்மை 
அமைப்பை பயன்படுத்தி ஒழுங்கமைக்கப்பட்ட 
முறையில்  தரவு  சேமிக்கப்பட  வேண்டும் . 
மேலும் ,  சேமிக்கப்படும்  தரவு  ஒரு  உரை 
(Text), எண், (Number) தேதி (Date ) அல்லது 
வேறு எந்த வடிவத்திலும் இருக்கலாம்.

த ர வு த ்தள  த ் தை  ( D a t a  B a s e ) 
உருவாக்குவதற்கான படிகள்:

1.	 வி ண ்டோ   ஸ்  அ ல்ல  து  லி ன க் ஸி ல் 
பயன்பாட்டைத் த�ொடங்கும், நிலையாக 
செயல்முறையின்படி, Libreoffice Base 
யைத் த�ொடங்கவும்.

2.	  விண்டோஸில், start என்பதைக் கிளிக் 
செய்யவும். Libreoffice தேர்ந்தெடுக்கவும் 
அல்லது திரைமுகப்பில் (Desktop) உள்ள 
Libreoffice ஐ-கானை (Icon) இருமுறை 
கிளிக் செய்யவும் அல்லது கீழே உள்ள 
பலகத்தில் இருந்து தரவுத்தள விருப்பத்தை 
தேர்ந்தெடுக்கவும்.
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3.	 ஒரு  தரவுதள  வழிகாட்டி  திறக்கிறது. 
இது புதிய தரவு தளத்தை உருவாக்க 
அல்லது ஏற்கனவே உள்ளதை திறக்க 
அனுமதிக்கிறது.

4.	 பு தி ய  த ர வு தள   உ ரு வ ா க் கு  எ ன ்ற 
ப�ொத்தானை கிளிக் செய்யவும்.

5.	 Libreoffice.org – யில் தரவுதளத்தை 
ப தி வு  ச ெ ய்வதற்கா      ன  வி ரு ப்ப  த ் தை 
வழங்குகிறது.

6.	 “ தி ற ”  எ ன ்ற  வி ரு ப்ப  ம ா ன து 
தரவுதளத்தில் உள்ள தரவுகளை திருத்த 
பயனாளர்களுக்கு உதவுகிறது.

7.	 தரவுதள உருவாக்கும் செயல்முறையை 
நிறைவு  செய்ய  “முடிக்க”  -  என்ற 
ப�ொத்தானை கிளிக் செய்யவும்.

8.	 “ சேமிப்பு” - ( save as) என்ற உரையாடல் 
பெட்டி த�ோன்றும்.

9.	 தரவுதளத்தை சேமிக்க விரும்பும் இயக்கி 
(Drive) மற்றும் க�ோப்புறையை உலாவவும் 
(Browse).

10.	 க�ோப்பின்  பெயரை  “பெயர்  உரை 
பெட்டியில்” உள்ளிடவும்,

11.	 சேமி ப�ொத்தானை கிளிக் செய்யவும்.

தரவுத்தள மேலாண்மை அமைப்பு 
மென்பொருள்

	10.19.	� அட்டவணை வழிகாட்டியைப் 

பயன்படுத்தி அட்டவணையை 

உருவாக்குதல் (Create a Table 

using Table Wizard):

அட்டவணை வழிகாட்டியைப் பயன்படுத்தி 
அட்டவணையை உருவாக்குவதற்கான படிகள்:

ஒ ரு  த ர வு தள  த ் தை  உ ரு வ ா க் கி ய து ம் , 
தரவுதளத்தின்  ப�ொருட்களுடன்  (objects) 
வேலை செய்ய ஆரம்பிக்கலாம். இதன் முதல் 
ம ற்றும்  முக்கிய ம ானது  அட்டவணைய ை 
உருவாக்குவது.

	 L i b r e o f f i c e  B a s e  -  இ ல் ,  ஒ ரு 
அட்டவணையை  அட்டவணை  வழிகாட்டி 
அல்லது வடிவமைப்பு பார்வையைப் (Design 
view) பயன்படுத்தி உருவாக்கலாம்.

	 தரவுதள வழிகாட்டியில் தரவுதளத்தை 
உருவாக்கும் நேரத்தில் ஒரு அட்டவணையை 
உருவாக்க ,  “அட்டவணை  வழிகாட்டியைப் 
பயன்படுத்தி  அட்டவணையை  உருவாக்கு” 
எ ன ்ற  வி ரு ப்ப   ரே  டி ய�ோ    ப�ொ   த ்தானை    
தேர்ந்தெடுக்கவும் ,  பின்  முடிக்க  (Finish) 
ப�ொத்தனை கிளிக் செய்யவும்.

Base – இல் ஆயத்த அட்டவணைகள் இருக்கும்

1.	 ம ா தி ரி  அ ட ்ட வ ணை  ப்  ப ட் டி ய ல் 
பெட்டியை கிளிக் செய்து ஏதேனும் ஒரு 
அட்டவணையைத் தேர்ந்தெடுக்கவும்.

2.	 அடுத்து  என்ற  ப�ொத்தானை  கிளிக் 
செய்யவும் - படிநிலை 2.

3.	 அடுத்து  என்ற  ப�ொத்தானை  கிளிக் 
செய்யவும் - படிநிலை 3 .

4.	 அடுத்து என்ற ப�ொத்தனை கிளிக் செய்து – 
அட்டவணை வழிகாட்டியைப் பயன்படுத்தி 
அ ட ்ட வ ணைய   ை  உ ரு வ ா க் கு ம் 
செயல்முறையை முடிக்கவும்.

மு ன் னி ரு ப்பா   க ,  த ர வை   உ ட ன டி ய ா க ச் 
ச ெ ரு கு வ தற்கா    ன  வி ரு ப்ப  ம் 
தேர்ந்தெடுக்கப்பட்டிருக்கும்.

பினிஷ் ப�ொத்தானை கிளிக் செய்யவும்.

10.18.5	 DBMS மென்பொருள்:
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தரவு வகைகள் (Data Types):

தரவுதளத்தில் எந்த வகையான தரவைச் சேமிக்க 
ப�ோகிற�ோம் என்பதைக் கண்டறிய தரவு வகைகள் 
பயன்படுகின்றன.

தரவு வகைகள் ப�ொதுவாக ஐந்து வகைகளாக 
வகைப்படுத்தப்படுகின்றன. அவையாவன:

1.	 எண்ணியல் வகை (0 முதல் 9 வரை) 
(Numeric Type)

2.	 எண்ணெழுத்து வகை (a/A முதல் z/Z வரை 
மற்றும 0 முதல் 9 வரை) (Alphanumeric 
Type)

3.	 பைனரி  வகைகள்  (Binary Type) 
( பு கைப்பட     ம் ,  இ சைக்    க ோ ப் பு க ள் 
ப�ோன்றவற்றை சேமித்தல் )

4.	 தேதி நேரம் (DD/MM/YYYY)
5.	 மற்ற தரவு வகைகள்

முதன்மைத் திறவுக�ோலை அமைப்பதற்கான 
விருப்பம் (Option to Set Primary Key):

அட்டவணை உருவாக்கப்பட்டவுடன், முதன்மைத் 
திறவுக�ோலை அமைக்க பயனரைக் கேட்கும். 
பயனர் முதன்மைத் திறவுக�ோலை அமைக்க 
ப�ொருத்தமான விருப்பத்தைத் தேர்ந்தெடுக்கலாம் 
அல்லது தேர்ந்தெடுக்காமல் விட்டு விடலாம்.

10.19.1	� அட்டவணை தரவுக்காட்சி 

உரையாடல் பெட்டி (Table Data 

View Dialog Box):

அ ட ்ட வ ணை   த ர வு க்காட்    சி  உ ரைய   ா ட ல் 
பெட்டியானது, அட்டவணையின் தளவமைப்பை 
(Layout) பயனர் வரையறுக்கவும் மற்றும் 
ப�ொருத்தமான புலன்களில் (Fields) தரவுகளை 
செருகவும் உதவுகிறது.

	10.20	�அட்டணையின் செயல்பாடுகள் 

(Perform Operations on Table):

அட்டவணையில் தரவைச் செருகுதல் (Inserting 
Data in the Table):

த ர வை   அ ட ்ட வ ணை  யி ல்  ச ெ ரு கு வ த ற் கு , 
அட்டவணையை தேர்வு செய்து, இருமுறை 
கி ளி க்  ச ெ ய்ய  வு ம் ,  அ ட ்ட வ ணைய   ா ன து 
தரவுத்தாள் காட்சியில் திறக்கப்படும். இதில் 
தரவுகளை செருகலாம்.

அட்டவணையில் உள்ள பதிவுகளை திருத்துதல் 
(Edit Records in the table):

தரவை திருத்த திருத்து (Edit) ஐ கானை கிளிக் 
செய்யவும் அல்லது கலத்தில் (Cell) உள்ள 
தரவை இருமுறை கிளிக் செய்து அட்டவணையில் 
உள்ள தரவுகளை மாற்றி அமைக்கலாம்.

அட்டவணையில் உள்ள பதிவுகளை நீக்குதல் 
(Deleting Records from the table):

அட்டவணையில்  இருந்து  தரவை  அகற்ற , 
கீழ்க்கண்ட படிநிலைகளைப் பின்பற்றவும்.

1.	 தரவை தேர்ந்தெடுக்கவும்
2.	 தேர்ந்தெடுக்கப்பட்ட தரவில் (Data) வலது 

கிளிக் செய்யவும்.
3.	 நீ க் கு  ( D e l e t e )  வி ரு ப்ப  த ் தை 

தேர்ந்தெடுக்கவும்.

தரவை வரிசைப்படுத்ததுல் (Sorting Data):

வ ரி சைப்ப    டு த் து த ல்  எ ன்ப  து  த ர வி னை  
ஏறுவரிசையில் அல்லது இறங்குவரிசையில் 
ஒழுங்குபடுத்துவதாகும் .  நெடுவரிசையில் 
உ ள்ள   த ர வு க ள ை  தேர்   வு  ச ெ ய் து , 
வ ரி சைப்ப    டு த் து த ல்  ( S o r t  B u t t o n ) 
ப�ொத்தானைக் கிளிக் செய்யவும். அதன்படி 
தரவுகள் காட்சிபடுத்தப்படும்.

குறிப்பு இடைநிலை (Referential Integrity):

முதன்மை திறவுக�ோல் மற்றும் வெளிநாட்டு 
திறவுக�ோல் கட்டுபாடுகள் உதவியுடன், இரண்டு 
அல்லது அதற்கு மேற்பட்ட அட்டவணைகளை 
இணைப்பதற்கு  குறிப்பு  இடைநிலை  உதவி 
புரிகிறது.

அட்டவணைகளுக்கு இடையே உறவுகளை 
உருவாக்குதல் மற்றும் திருத்துதல்:

உறவு  என்பது  இரண்டு  அல்லது  அதற்கு 
மேற்பட்ட அட்டவணைகளின் இணைவு அல்லது 
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த�ொடர்பைக்  குறிக்கிறது .  பயனர்  இரண்டு 
அட்டவணைகளை த�ொடர்பு படுத்தும் ப�ோது, 
ஒரே  தரவை  தனித்தனி  அட்டவணையில் 
உள்ளிடப் பட வேண்டாம்.

அ ட ்ட வ ணை  யி ல்  மூ ன் று  வ கைய   ா ன 
உறவுமுறைகளை உருவாக்க முடியும்.

1.	 ஒன்றுடன் ஒன்று ( One to One)
2.	 ஒன்றுடன் பலவும் அல்லது பலவற்றிற்கு 

ஒன்றும் (One to Many)
3.	 பலவற்றுடன் பல (Many to Many)

ஒன்றுடன் ஒன்று (One to one relation):

இ ந்த   உ ற வு மு றை  யி ல்  இ ர ண் டு 
அட்டவணைகளிலும் முதன்மை திறவுக�ோல் 
நெடுவரிசை கட்டாயம் இருக்க வேண்டும்.

முதன்மை 

திறவுக்கோல்

பதிவு 

எண்

மாணவர் 

பெயர்

பிறந்த 

தேதி

மதிப்பெண்

பதிவு 

எண்

த�ொகுதி மாணவர் / வகுப்பு

ஒன்றுடன் பலவும் அல்லது பலவற்றிற்கு ஒன்றும் 
(One to Many or Many to one Relation):

த�ொடர்புடைய தரவுத் தளத்தில், ஒன்றுக்கு பல 
உறவு நிலையில் அட்டவணை ‘அ’ உள்ள ஒரு 
வ ரி சை  ,  அ ட ்ட வ ணை   ‘ ஆ ’  உ ட ன்  ப ல 
வரிசைகளுடன் இணைக்கப்பட்டருக்கலாம், 
ஆனால் அட்டவணை ‘ஆ ’ – ல் உள்ள ஒரு 
வரிசை,  அட்டவனை ‘அ ’ உள்ள ஒரே ஒரு 
வரிசையுடன் தான் இணைக்கப்ட்டிருக்கும்.

இந்த உறவில், ஏதாவது ஒரு அட்டவணையில், 
முதன்மைத் திறவுக�ோல் இருக்க வேண்டும்.

அட்டவணை அ அட்டவணை ஆ

பதிவு

பதிவு

பதிவு

பதிவு

பலவற்றுடன் பல (Many to Many relationship):
பலவற்றுடன் பல உறவுநிலையில், எந்தவ�ொரு 
அட்டவணையிலும் முதன்மைத் திறவுக�ோல் 
நெடுவரிசை இடம் பெறாது.
ப ல வ ற் று ட ன்  ப ல  உ ற வு நி ல ை யி ல் ,  ஒ ரு 
அட்டவணையில் உள்ள பல பதிவுகள், மற்றொரு 
அட்டவணையில்  உள்ள  பல  பதிவுகளுடன் 
த�ொடர்புடையதாக இருக்கும்.
எ.கா. : 
ப ல வ ற் று ட ன்  ப ல  உ ற வு  நி ல ை ய ா ன து , 
வாடிக்கையாளர்கள் மற்றும் தயாரிப்புகளுக்கும் 
இடையே உள்ளன.

வாடிக்கையாளர்கள் தயாரிப்புகள்

ஒரு  வாடிக்கையாளர்  பல  ப�ொருட்களை 
வ ா ங ்கல  ா ம்  ம ற் று ம்  ஒ ரு  ப�ொ   ரு ள்  ப ல 
வாடிக்கையாளரால் வாங்கப்படலாம்.

	10.21	� வினவலைப் பயன்படுத்தி தரவை 

மீட்டளித்தல் (Retrieve Data using 

Query):

பெயர் குறிப்பிடுவது ப�ோல, வினவல் என்பது 
தரவு த�ொகுப்பிலிருந்து, குறிப்பிட்ட தகவலை 
சேகரிப்பதாகும்.
ஒ ரு  வி ன வ ல்  எ ன்ப  து  DB M S  இ ன்  மி க 
முக்கியமான அம்சங்களில் ஒன்றாகும். ஒரு 
வினவலைப்  பயன்படுத்தி ,  தரவுத்தளத்தில் 
ஒ ன் று  அ ல்ல  து  அ த ற் கு  மேற்ப    ட ்ட 
அ ட ்ட வ ணை  க ளி ல்  இ ரு ந் து  த ர வை  
மீட்டெடுக்கலாம் மற்றும் காண்பிக்கலாம்.
ஒ ரு  வி ன வ ல்  மூ ன் று  வ ழி க ளி ல் 
உருவாக்கப்படலாம்.
1.	 வழி காட்டியைப் பயன்படுத்துதல் (Using 

a Wizard)
2.	 வடிவமைப்பு பார்வையில் (In Design view)
3.	 SQT பார்வையில் (In SQL view)

படிநிலைகள்:

1.	 தரவுத்தள வடிவமைப்பு விண்டோஸில், 
வி ன வ ல்க  ள்  ப�ொ   த ்தானை    க்  கி ளி க் 
செய்யவும்.
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2.	 டாஸ்க் பகுதியில், வினவல் விருப்பத்தை 
உ ரு வ ா க் கு வ த ற் கு  வ ழி க ா ட் டி ய ை 
(Wizard) கிளிக் செய்யவும்.

3.	 அட்டவணையில் இருந்து புலங்களைத் 
(Fields) தேர்ந்தெடுக்கவும்.

4.	 பட்டியல்  பெட்டியிலிருந்து , புலத்தின் 
பெயரைத் தேர்ந்தெடுக்கவும்.

5.	 அடுத்த  என்ற  ப�ொத்தானை ,  கிளிக் 
செய்யும்  ப�ொழுது, வரிசை படுத்தும் 
முறையை தேர்ந்தெடுப்பதற்கான திரை 
த�ோன்றும்.

6.	 அட்டவணையில் இருந்து எந்த பதிவுகள் 
வடிகட்டப்படும் என்பதன் அடிப்படையில் 
தேட   ல்  நி ல ை மை  க ள்  அ ல்ல  து 
அளவுக�ோல்களை அமைக்கவும்.

7.	 மேற்குறிப்பிட்ட நிபந்தனையை பூர்த்தி 
செய்யும் புலமானது, புலத்தின் பட்டியல் 
பெட்டியில் (Field Dropdown list) இருந்து 
தேர்ந்தெடுக்கப்படும்.

8.	 படிகள்  பலகத் தில்  (steps pane) 
க�ொடுக்கப்பட்டுள்ள படிநிலைகள் 4,5,6 
ஆகியவை எண் கணக்கீடுகளைச் சுருக்கிச் 
செய்தல்  மற்றும்  செயல்படுத்துதல் 
ப�ோன்ற பணிகளைக் கையாள்கின்றன.

9.	 மாற்றுப் பெயரைக் க�ொடுக்க, வினவலை 
இயக்கும்பொழுது ,  நெடுவரிசையின் 
தலைப்புப் பெயர் காட்டப்படும்.

10.	 வினவலின் முழு கண்ணோட்டத்தையும் 
காட்டுகிறது.

11.	 முடிவு ப�ொத்தானைக் (Finish Button) 
கிளிக் செய்யவும்.

வடிவமைப்பு பார்வையைப் (design view) 
பயன்படுத்தி வினவலை உருவாக்குதல்:

த ர வு த ்தளத்   தி ன் ,  ஒ ற ் றை  அ ல்ல  து  ப ல 
அட்டவணையில் இருந்து வினவலை உருவாக்க 
இது மிகவும் எளிய முறையாகும்.

1.	 தரவுத்தள  சாளரத்தில்  (Database 
window) உள்ள ப�ொருள்கள் பலகத்தில் 
(Objects pane) உள்ள வினவல்கள் 
ஐகானைக் கிளிக் செய்யவும்.

2.	 வடிவமைப்பு  பார்வையில்  பணிகள் 
பலகம் (Tasks Pane) உள்ள ‘வினவலை 
உருவாக்கு’ (Create a Query) என்ற 
ஐகானை கிளிக் செய்யவும். வினவல் 
வடிவமைப்பு சாளரம் த�ோன்றும்.

3.	 வி ன வ லி ல்  ப யன்ப   டு த ்தப்ப   டு ம் 
அட்டவணையைக் கிளிக் செய்து, சேர் 
ப�ொத்தானைக் (Add Button) கிளிக் 
செய்யவும்.

4.	 இ தே  ப �ோ  ல்  வி ன வ ல்  வ டி வ மை  ப் பு 
சாளரத்தின் (Query Design Window) 
அட்டவணைகள் பலகத்தில் (Tables Pane) 
அட்டவணையைச் சேர்க்கவும்.

5.	 ADD அட்டவணை அல்லது வினவல் 
உரையாடல் பெட்டியில் உள்ள Close 
button – ஐ கிளிக் செய்யவும்.

6.	 அடுத்த படிநிலை, புலங்களைத் (Fields) 
தேர்ந்தெடுப்பது.

7.	 கட்டத்தில் (Grid), மாற்று பெயர் என்ற 
தலைப்பில் ஒரு வரிசை உள்ளது. முன்பு 
குறிப்பிட்டப்படி, வெளியீட்டில் (Output) 
அர்த்தமுள்ள  பெயரைக்  காட்ட  இது 
பயன்படுத்தப்படலாம்.

8.	 இ யல்பா    க ,  வி ன வ லி ன் 
வி ள ை வ ா க க்  க ா ட ்ட ப்ப  டு ம்  த ர வு 
வரிசைப்படுத்தப்பட்டிருக்காது. கட்டத்தில் 
உள்ள “Sort Row” ஐ பயன்படுத்தி, 
புலத்தின் தரவுகளை ஏறுவரிசையில�ோ 
அ ல்ல  து  இ றங்  கு  வ ரி சை  யி ல�ோ   
வரிசைப்படுத்தலாம்.

9.	 வி ன வ ல்  வ டி வ மைக்கப்ப      ட ்ட து ம் , 
கருவிப்பெட்டியில்  (Toolbar) உள்ள 
வினவல் ப�ொத்தானை (Query Button) 
இயக்கவும்  அல்லது  “F5”  விசையை 
அழுத்தவும்.

10.	 வினவலைச் சேமிக்க, சேமி ப�ொத்தானைக் 
(Save Button) கிளிக் செய்யவும்.

11.	 இயல்பாக வினவல் பெயர் காட்டப்படும். 
தேவைப்ப      ட ்டா  ல்  வே  று  பெரை    
உள்ளிடவும். வினவலைச் சேமிக்க, OK 
Button – ஐ கிளிக் செய்யவும்.
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	10.22	SQL (Structured Query Language):

SQL என்பது  கட்டமைக்கப்பட்ட  வினவல் 
ம�ொழியைக் குறிக்கிறது. இது த�ொடர்புடைய 
தரவுத்தள மேலாண்மை அமைப்புகளில் (RDMS) 
தரவைச் சேமிக்கவும், நிர்வகிக்கவும் பயன்படுகிறது. 
இது த�ொடர்புடைய தரவுத்தள அமைப்புக்கான 
நிலையான  ம�ொழியாகும் .  த�ொடர்புடைய 
தரவுத்தளங்கள் மற்றும் அட்டவணைகளை, 
பயனர் உருவாக்க, மாற்றியமைக்க, புதுப்பிக்க 
மற்றும் நீக்க உதவுகிறது.
	 SQL தரவு வரையறை மற்றும் தரவு 
கைய   ா ளு த ல்  ம�ொ   ழி க ள்  இ ர ண ் டை யு ம் 
க�ொண்டுள்ளது. SQL இன் தரவு வரையறை 
பண்புகளைப் பயன்படுத்தி, ஒருவர் தரவுத்தள 
தி ட ்ட த ் தை  வ டி வ மைக்க    வு ம்  ம ற் று ம் 
மாற்றியமைக்கவும்  இயலும் ,  அதேசமயம் 
தரவு கையாளுதல் பண்புகள் SQL ஐ தரவுத் 
தளத்திலிருந்து தரவைச் சேமிக்கவும் மற்றும் 
மீட்டளிக்கவும் அனுமதிக்கின்றது.
	 ஒரு தரவுத்தளத்தை வரையறுக்க SQL 
பி ன்வ  ரு ம்  க ட ்ட ள ை க ளி ன்  த�ொ   கு ப ் பை ப் 
பயன்படுத்துகிறது.

a. உருவாக்கு (Create):

RDBMS லிருந்து  புதிய  தரவுத்தளங்கள் , 
அ ட ்ட வ ணை  க ள்  ம ற் று ம்  க ா ட் சி க ள ை 
உருவாக்குதல்.
த�ொடரியல் (Syntax):
மாணவர்களின் தரவுத்தள பதிவை உருவாக்குதல்
(Create database students record)
அட்டவணை கட்டுரையை உருவாக்குதல்
(Create table article )
மாணவர்களுக்கான காட்சியை உருவாக்குதல்
(Create view for students)

b. கைவிட (Drop):

RDBMS லிருந்து கட்டளைகள், அட்டவணைகள் 
மற்றும் தரவுத்தளங்களை கைவிடுகிறது.

த�ொடரியல் (Syntax):
தரவுத்தள மாணவர்களின் பதிவை கைவிடவும்;
(Drop Database students Records;)
அட்டவணையை கைவிடவும்;

(Drop Table Article;)
மாற்ற (Alter):
தரவுத்தளத்தை மாற்றியமைக்கிறது.
த�ொடரியல் (Syntax):
ப�ொருள் என்ற பதிவை சேர்த்து, அட்டவணையை 
மாற்றி அமைக்க.
Alter table article add subject varchar ;
Data type
ஒரு தேர்வு (A Select):
அறிக்கை ஒன்று அல்லது அதற்கு மேற்பட்ட 
தரவுத்தள அட்டவணைகள் அல்லது தரவுத்தள 
காட்சிகளிலிருந்து பூஜ்ஜியம் அல்லது அதற்கு 
மேற்பட்ட  வரிசைகளை  மீட்டெடுக்கிறது . 
பெரும்பாலான பயன்பாடுகளில், தேர்வு என்பது 
ப�ொ   து வ ா க ப்  ப யன்ப   டு த ்தப்ப   டு ம்  த ர வு 
கையாளுதல் ம�ொழி (DML) கட்டளையாகும்.
தேர்வு (The Select):
தேர்வு அறிக்கை (Select Statement) என்பது 
பல  விருப்ப  உட்பிரிவுகளைக்  (Opt ional 
Clauses) க�ொண்டுள்ளது.
எந்த  வரிசைகளை  மீட்டளிக்க  வேண்டும் 
என்பதை WHERE குறிப்பிடுகிறது.
எந்த வரிசைபாட்டில் தரவுகளை மீட்டளிக்க 
வேண்டும் என்பதை Orderby குறிப்பிடுகிறது.
செய்ய (To):
அ ட ்ட வ ணை  யி ல்  உ ள்ள   அ னைத்   து 
நெடுவரிசைகளையும் மீட்டளிக்கவும்.
த�ொடரியல் <Tablename> இலிருந்து Select; 
வினவல்களை இயக்க, தரவுத்தளப் பிரிவின் கீழ் 
இடது  புறத்தில்  கிடைக்கும்  வினவல்கள் 
விருப்பத்தைக் கிளிக் செய்யவும், SQL காட்சியில் 
வினவல்களை உருவாக்கு என்பதனைக் கிளிக் 
செய்யவும்.

தரவு வரிசையாக்கம்
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	 அ றி க ் கை க ள்  ம ற் று ம்  ப டி வ ங ்க ள் 
இரண்டும் தரவுத்தளத்தின் ப�ொருள்களாகக் 
கருதப்படுகின்றன மற்றும் அவை Libreoffice 
Base பயனர்  இடைமுகத்தின்  தரவுத்தளப் 
பலகத்தில் உள்ளன.

10.23.2	தரவில் உள்ள படிவங்கள்:

ஒரு படிவம் என்பது தரவுத் தளத்தின் ஒரு 
ப�ொருளாகும். இது பயனர் நட்பு இடைமுகத்தைக் 
(user friendly interface) க�ொண்டுள்ளது. 
அங்கு தரவை உள்ளிடலாம். மேலும் படிவங்கள் 
படிப்பதற்கு எளிதான மற்றும் கவனத்தைக் 
கவரக் கூடிய வடிவத்தில் காணலாம்.

10.23.3	�வழிக்காட்டியைப் பயன்படுத்தி 

படிவத்தை உருவாக்குதல்:

வழிகாட்டியைப்  பயன்படுத்தி  படிவத்தை 
உருவாக்குதல் எளிய வழி ஆகும்.

	10.23	�தரவுகளை த�ொகுத்தல் (Grouping 

of Data):

ஒரே  மாதிரியான  மதிப்புகளைக்  க�ொண்ட 
ப தி வே  டு க ள ை க்  க ா ட் டு வ த ற் கு , 
தேர்ந்தெடுக்கப்பட்ட  SQL கட்டளையுடன் 
“WHERE” பயன்படுத்தப்படுகிறது.

எ.கா. நீல நிற விருப்பமான மாணவர்களின் 
விவரங்களைப் பெறுவதற்கு

த�ொடரியல் பயன்பாடு : Select *forms Details 
where colour = “Blue”.

10.23.1	 �வழிகாட்டியைப் பயன்படுத்தி 

படிவங்கள் மற்றும் 

அறிக்கையினை உருவாக்குதல் 

(Create Forms and Reports 

Using Wizard):

Libreoff ice Base என்பது  தரவு  உள்ளீடு 
ந�ோக்கங்களுக்காக படிவம் மற்றும் அறிக்கைகள் 
அம்சத்தை வழங்குகிறது.

படிநிலைகள்:

படிநிலை 1 : LIbreoffice இல் உருவாக்கப்பட்ட தரவுத் தளத்தை திறந்து தரவுத்தளப் 

பலகத்தில் உள்ள படிவ ஐகானைக் கிளிக் செய்யவும்.

படிநிலை 2 : படிவத்தை உருவாக்க வேண்டிய அட்டவணைகள் அல்லது 

வினவல்களைத் தேர்ந்ததெடுக்கவும்.

படிநிலை 3 : அட்டவணையைத் தேர்ந்தெடுத்த பிறகு, அட்டவணையின் அனைத்து 

புலங்களும், கிடைக்கக் கூடிய புலங்கள் பட்டியல் பெட்டியில் (Field List Box) 

பட்டியலிடப்படும்.

படிநிலை 4 : படிவத்தில் உள்ள அனைத்து புலங்களும த�ோன்றுவதற்கு, >> 

ப�ொத்தானைப் பயன்படுத்தி, படிவப்பட்டியல் பெட்டியில் உள்ள 

புலங்களுக்கு அட்டவணை படிவத்தின் அனைத்து புலங்களையும் 

மாற்றவும், முன்னோக்கி நகர்த்த, அடுத்த ப�ொத்தானைக் கிளிக் செய்யவும்.

படிநிலை 5 : உருவாக்கப்படும் படிவத்திற்கு, ஸ்டைல்களைப் பயன்படுத்தவும்.

படிநிலை 6 : படிவத்தின் பெயரை க�ொடுப்பதற்கு, அடுத்த ப�ொத்தனைக் கிளிக் செய்யவும்.

படிநிலை 7 : பினிஷ் பட்டனைக் கிளிக் செய்யவும். (Finish)
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படிநிலைகள்:

படிநிலை 1 : தரவுத்தளப்பலகத்தில் இருந்து அறிக்கைகளைத் தேர்ந்தெடுக்கவும்.

படிநிலை 2 : கிளிக் செய்வதிலிருந்து பணிக் காட்சி (Task View ) த�ோன்றும், அதில் 

“ அறிக்கையை உருவாக்க வழிகாட்டியைப் பயன்படுத்து” என்ற 

விருப்பத்தினை தேர்ந்தெடுக்கவும்.

படிநிலை 3 : இந்த கட்டத்தில், அறிக்கையில் காட்டப்பட வேண்டிய 

அட்டவணைகளின் புலங்களைத் தேர்ந்தெடுக்கவும்.

எ.கா. ‘மாணவர் பதிவு‘ தரவுத் தளத்திலிலிருந்து அறிக்கைகளில் 

புலங்களைத் தேர்ந்தெடுக்கவும்.

படிநிலை 4 : அடுத்த ப�ொத்தானைக் கிளிக் செய்யவும், அறிக்கை ஒவ்வொரு 

புலத்திற்கும் லேபிள்களை உருவாக்கும்.

படிநிலை 5 : அறிக்கை ஒன்று அல்லது அதற்கு மேற்பட்ட புலங்கள் மூலம் 

முடிவுகளைத் த�ொகுக்கலாம். முடிவுகளைத் த�ொகுத்து ”student Info” 

என பெயரிட்டு அறிக்கையினை உருவாக்கலாம்.

படிநிலை 6 : இந்த படிநிலையில், அறிக்கையின் தளவமைப்பு (layout), தலைப்புகள் 

(Headers), மற்றும் அடிக்குறிப்புகள் (Footers) ஆகியவற்றை 

தேர்ந்தெடுக்கலாம்.

படிநிலை 7 : இந்த படிநிலையில், அறிக்கையின் ‘தலைப்பு’ மற்றும் வகை 

ஆகியவற்றைக் குறிப்பிடுகிற�ோம்.

படிநிலை 8 : ‘Create Report Now ’ விருப்பதை கிளிக் செய்யவும்.

படிநிலை 9 : பினிஷ் ப�ொத்தனைக் கிளிக் செய்யவும்.

படிவத்தை நிர்வகித்தல் (Managing a Form):

படிவத்தை நிர்வகிக்க, தரவுத்தளப் பலகத்தில் 

உள்ள படிவப்பொருளின் மீது கிளிக் செய்து 

ப டி வ ப்பல   க த் தி ல்  இ ரு ந் து  ப டி வ த ் தை த் 

தேர்ந்தெடுக்கவும்.

	 படிவத்தைத் திறக்க, திருத்த, உள்ளிட 

அல்லது  அகற்ற ,  தரவை  மாற்ற ,  லேபிள் 

பின்னணியை மாற்ற, பதிவைத் தேட மற்றும் 

படிவங்களில் தரவைச் செருகவும், நீக்கவும் 

படிவக் கருவிப்பெட்டியைப் (Forms Toolbar) 

பயன்படுத்தவும்.

10.23.4	 வழிகாட்டியைப் பயன்படுத்தி 

அறிக்கையை உருவாக்குவதற்கான 

படிநிலைகள்:

தரவுத்தளத்திலிருந்து தகவல்களை எளிதாக 
படிப்பதற்கு ,  பார்வைக்கு  அச்சிடக்  கூடிய 
வடிவத்தில் வழங்க அறிக்கை உதவுகிறது.
	 L i bre offi c e  B a s e  ஆ ன து  த ர வு த் 
தளத்திலிருந்து தரவைப் பயன்படுத்தி, அறிக்கையை 
உருவாக்குவதையும், தனிப்பயனாக்குவதையும் 
(Customize) எளிதாக்குகிறது.
வழிகாட்டியைப் பயன்படுத்தி அறிக்கைகளை 
உருவாக்குவது, விரைவாகவும் எளிதாகவும் 
அ றி க ் கைய  ை  உ ரு வ ா க் கு வ தற்கா    ன 
பரிந்துரைக்கப்பட்ட குறையாகும்.
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நினைவில் க�ொள்ள வேண்டியவை

•	 DBMS என்பது ஒரு மென்பொருள் கருவி.
•	 தரவுத்தளம் என்பது ஒரு ஒழுங்கமைக்கப்பட்ட முறையில் தரவுகளின் த�ொகுப்பாகும்.
•	 ஒ ரு  த ர வு த ்தள  ம ா ன து  ப�ொ   து வ ா க  த ர வு த ்தள   மேல   ா ண ் மை  அ மைப்பா     ல் 

கட்டுப்படுத்தப்படுகிறது.
•	 முதன்மை, இணைப்பு முதன்மை மற்றும் வெளித் திறவுக�ோல்களைப் பயன்படுத்தி தரவுத் 

தளத்தில் உள்ள தரவை குழுவாக்கலாம் அல்லது பிரிக்கலாம்.
•	 Libreoffice Base என்பது DBMS மென்பொருளில் ஒன்றாகும்.
•	 SQL என்பது தரவுத்தளத்தில் தரவைச் சேமிப்பதற்கும், மீட்டளிப்பதற்கும் மற்றும் 

நிர்வகிப்பதற்கும் ஒரு நிலையான ம�ொழியாகும்.

1.	த .த.மே.அ (DBMS) என்பதன் 

விரிவாக்கம் _____________

அ)	தர வுத்தள மேலாண்மை அமைப்பு

ஆ)	தர வுத்தள மேனிலை அமைப்பு

இ)	தர வுத்தள மேலாண்மை 

அமைப்பகம் 

ஈ)	தர வுத்தள சேவைகள்

2.	தர வுத் தளம் என்பது ___________

அ)	 ஒழுங்கமைக்கப்படாத தரவு

ஆ)	 ஒழுங்கமைக்கப்பட்ட தரவு

இ)	ப� ொருத்தமற்ற தரவு

ஈ)	 வினவல்கள்

3.	 த�ொடர்புடைய தரவுத்தள மாதிரி 

__________________ இல் 

முன்மொழியப்பட்டது.

அ)	 1980

ஆ)	 1975

இ)	 1970

ஈ)	 1972

I. சரியான விடையை தேர்ந்தெடுத்து எழுதுக

வினாக்கள்

•	 Data (தரவு): தரவு என்பது தனிப்பட்ட உண்மைகள், புள்ளிவிவரங்கள் அல்லது தகவல்களின் 

உருப்படிகள் ஆகும், இது பெரும்பாலும் எண்கள் ஆகும்.

•	 Database (தரவுத்தளம் ) :  தரவுத்தளம்  என்பது  ஒரு  கணினி  அமைப்பில்  ப�ொதுவாக 

மின்னணு முறையில் சேமிக்கப்படும் கட்டமைக்கப்பட்ட தகவல் அல்லது தரவுகளின் 

ஒழுங்கமைக்கப்பட்ட த�ொகுப்பாகும்.

•	 SQL (Structured Query Language): SQL என்பது கட்டமைக்கப்பட்ட வினவல் ம�ொழியைக் 

குறிக்கிறது. இது த�ொடர்புடைய தரவுத்தள மேலாண்மை அமைப்புகளில் (RDMS) தரவைச் 

சேமிக்கவும் நிர்வகிக்கவும் பயன்படுகிறது.

•	 DBMS (Database Management System): தரவுத்தள மேலாண்மை அமைப்பு (DBMS) என்பது 

ஒரு தரவுத்தளத்தில் தரவை ஒழுங்கமைக்க (உருவாக்க, மீட்டெடுக்க, புதுப்பிக்க மற்றும் 

நிர்வகிக்க) பயன்படும் ஒரு மென்பொருளாகும்.

கலைச் ச�ொற்கள்
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I I .  குறு வினாக்கள்

1.	 DBMS ஐ வரையறுக்கவும்.

2.	 முதன்மைத் திறவுக�ோல் என்றால் 

என்ன?

3.	தர வுத்தளத்தில் உள்ள தரவு 

வகைகளை வகைப்படுத்தவும்.

4.	 அட்டவணையில் உள்ள 

உறவுகளின் வகைகள் என்ன?

5.	 வினவல் (Queries) என்றால் என்ன?

விடைகள்: 1. �(அ),  2. (ஆ),  3. (இ),  4. (அ), 5. (இ),  6. (இ),  7. (ஆ), 8. (அ),  9. (இ),  10. (அ),

4.	 ______________ களின் 

த�ொகுப்பு ஒரு அட்டவணையை 

உருவாக்குகிறது.

அ.	 புலம்

ஆ.	 அட்டவணை

இ.	தர வுத்தளம்

ஈ.	 பதிவு

5.	 _____________ திறவுக்கோல் 

ஒரு அட்டவணையில் உள்ள 

வரிசைகளை தனித்துவமாக 

அடையாளப்படுத்துகிறது.

அ.	 இணைப்பு முதன்மை 

திறவுக�ோல்

ஆ.	வெ ளித் திறவுக�ோல் 

இ.	 முதன்மை திறவுக�ோல்

ஈ.	 இணை திறவுக�ோல்

6.	 பின்வருவனவற்றிலிருந்து DBMS 

மென்பொருள் எது?

அ.	 லினக்ஸ்

ஆ.	 விண்டோஸ்

இ.	 லிபர்ஆபிஸ் பேஸ் 

ஈ.	மேக்

7.	 ______________ அறிக்கையை 

விரைவாகவும், எளிதாகவும் 

உருவாக்க பரிந்துரைக்கப்படும் 

முறையாகும்.

அ.	 வடிவமைப்பு பார்வை

ஆ.	 வழிகாட்டி

இ.	 SQL பார்வை

ஈ.	 அட்டவணை பார்வை

8.	 ____________ தரவுத்தளத்தில் 

தரவை படிக்க எளிதான மற்றும் 

கவனத்தைக் கவரக்கூடிய வடிவில் 

வழங்க முடியும்.

அ.	 படிவங்கள்

ஆ.	 அறிக்கை

இ.	 அட்டவணை 

ஈ.	 வழிகாட்டி

9.	 ________________  

திறவுக�ோல் முதன்மைத் 

திறவுக�ோல் வழியாக இரண்டு 

அட்டவணைகளை ஒன்றாக 

இணைக்கப்பயன்படுகிறது.

அ.	 முதன்மை திறவுக�ோல்

ஆ.	 இணைத் திறவுக�ோல்

இ.	வெ ளித் திறவுக�ோல் 

ஈ.	 இணைப்பு முதன்மைத் 

திறவுக�ோல்

10.	 அட்டவணை உருவாக்குவதில் 

உள்ள உறவுகளின் வகைகள் 

_______________

அ)	 3

ஆ)	 4

இ)	 2

ஈ)	 5
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செயல்பாடு :

ஆசிரியர் செயல்பாடு:

LIbreoffice Base DBMS மென்பொருளைப் பதிவிறக்குவதற்கான செயல்முறையைப் பற்றி 

மாணவர்களுக்கு கற்பிக்கவும். DBMS (Functions) பற்றி மாணவர்களுக்கு கற்பிக்கவும்.

மாணவர் செயல்பாடு:

1.	 வழிகாட்டியைப் பயன்படுத்தி, படிவத்தை உருவாக்குவதற்கான படிப்படியான 

செயல்முறையைச் செய்யவும்.

எளிய மதிப்பீடுகள்:

1	 அட்டவணைத்தாள் மென்பொருளில் ஒரு பணித்தாளில் இருந்து வேறு இடத்திற்கு 

செல்ல _______________ பயன்படுத்தலாம்.

2	 _______________ என்பது ஒரு செயல் அல்லது செயல்களின் த�ொகுப்பாகும், 

அதை நீங்கள் பணித்தாளில் எத்தனை முறை வேண்டுமானாலும் இயக்கலாம்.

3	 _______________ ஒரு நுண்ணறை அல்லது பணித்தாளில் உள்ள 

நுண்ணறைகளின் பரப்பைக்குறிக்கிறது.

4	 ஏற்கனவே உள்ள அட்டவணைத்தாளை திறக்க _______________ குறுக்கு 

வழிச்சாவி பயன்படுத்தபடுகிறது.

5	 ஒரு புதிய அட்டவணைத்தாளை ச�ொருக _______________ குறுக்கு வழிச்சாவி 

பயன்படுகிறது.

III. சிறு வினாக்கள்

1.	 DBMS ன் தனிச்சிறப்புகள் யாவை?

2.	 த�ொடர்புடைய தரவுத்தளத்தின் 

கருத்தையும் (concept) மற்றும் 

அதன் கூறுகளையும் (Elements) 

வரையறுக்கவும்.

3.	 த�ொடர்புடைய தரவுத்தளத்தில் 

உள்ள பல்வேறு வகையான 

திறவுக�ோல்களைப் பற்றி 

விளக்கவும்.

IV. விரிவான விடையளி:

1.	 அட்டவணைகளுக்கு இடையே 

உறவுகளை உருவாக்குதல் 

(Creating) மற்றும் திருத்துதல் (editing) 

பற்றி விளக்குக.

2.	 அட்டவணையின் செயல்பாடுகளின் 

வகைகளை விளக்குக.

மேற்கோள் நூல்கள்:

1.	 www.psscive.ac.in
2.	 http://en.m.wikipedia.org
3.	 Other relevant websites.

விடைகள்: 1. �மீத்தொடுப்பு,  2. குறுநிரல்,  3. செல் குறிப்பு,  4. Ctrl+o, 5. Shift+f11
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